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1. Introduction
This is the home of the TouchDraw 2 for iOS documentation. The layout of the pages and information

displayed in this documentation is based on the User Interface (UI) structure. It is broken down into seven main

sections with pages describing each portion of the interface and available functionality:

Section Name Description

Preface The Preface section contains necessary legal and acknowledgement information

regarding TouchDraw 2 for iOS.

Getting Started The Getting Started section contains information for launching TouchDraw 2 and

beneficial web page links.

Document Picker The Document Picker section can be used to learn more about the picker user

interface and how to view, access, and manage documents in TouchDraw 2.

Drawing Editor The Drawing Editor section can be used to learn more about the editor interface and

about the available features when working with a drawing in TouchDraw 2.

Tips and

Techniques

The Tips and Techniques section can be used to learn about using the Function Key

Feature to perform specific actions within TouchDraw 2.

Miscellaneous The Miscellaneous section contains additional information outside of the main UI

structure of the application such as file importing and exporting formats.

Information shown in the Drawing Picker and Drawing Editor sections, in particular, is organized based on

the layout of the application interface.

For example, to find information about changing the text properties of a figure in the editor, go to the Editing

Drawings section, expand these pages, and then select Text. To find information about importing or exporting

a drawing document, go to the File Management section and select one of these pages.

Each of these documentation sections begins with pages describing the basic features of their user interface and

subsequent pages provide further details about a particular feature. Use the links on a page to navigate to

additional information about a particular subject or expand the pages to find a particular section.
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The search feature can be also be used to find an item. Simply type in a keyword and a list of pages will appear

for selection.
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2. Preface
Please see the following pages for more information:
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2.1. Legal Notice
This software product is copyrighted and all rights reserved by Elevenworks LLC. The distribution and sale of

this product are intended for the use of the original purchaser only and for the use on their authorized systems.

Copying, duplicating, selling, or otherwise distributing this product with the express written permission of

Elevenworks are violations of U.S. Copyright Law and are hereby expressly forbidden.

Every effort has been made to ensure that the information in this manual is accurate; however Elevenworks is

not responsible for errors.

Apple, the Apple logo, iPhone, iPod touch, and iTunes are trademarks of Apple Inc., registered in the U.S. and

other countries. iPad is a trademark of Apple Inc. App Store is a service mark of Apple Inc. Content purchased

from the iTunes Store is for personal lawful use only. Don’t steal music.

Microsoft, Microsoft Windows and Visio are trademarks of the Microsoft group of companies.

TouchDraw/TouchDraw 2 and the TouchDraw/TouchDraw 2 logo are trademarks of Elevenworks LLC.

Other company and product names mentioned herein are trademarks of their respective companies. Mention of

third-party products is for informational purposes only and constitutes neither an endorsement nor a

recommendation. Elevenworks assumes no responsibility with regard to the performance or use of these

products.
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2.2. Open Source
Portions of this software may utilize the following copyrighted material, the use of which is hereby

acknowledged.

Name License

Json.NET The MIT License (MIT)

Markdig BSD 2-Clause "Simplified" License

Sprache The MIT License (MIT)

Toast.iOS The MIT License (MIT)

BTProgressHUD Apache License

ExCSS The MIT License (MIT)

FontAwesome CC BY 4.0 License

Portions licensed under the Apache License, Version 2.0. You may obtain a copy of the License at:

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed

on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or

implied. See the License for the specific language governing permissions and limitations under the License.

https://www.newtonsoft.com/json
https://github.com/JamesNK/Newtonsoft.Json/blob/master/LICENSE
https://github.com/lunet-io/markdig
https://github.com/lunet-io/markdig
https://github.com/sprache/Sprache
https://github.com/sprache/Sprache/blob/develop/licence.txt
https://github.com/andrius-k/Toast
https://github.com/andrius-k/Toast/blob/master/LICENSE
https://github.com/FourPi/BTProgressHUD
https://github.com/FourPi/BTProgressHUD/blob/master/LICENSE.txt
https://github.com/TylerBrinks/ExCSS
https://github.com/TylerBrinks/ExCSS/blob/master/license.txt
https://fontawesome.com/search?o=r&m=free
https://fontawesome.com/license/free
http://www.apache.org/licenses/LICENSE-2.0
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2.3. Acknowledgements
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3. Getting Started
TouchDraw 2 supplies everything you need to create structured 2D vector graphics on the go with your device.

Create charts, graphs, floor plans, architecture drawings, illustrations or most anything else you can image.

Not only does TouchDraw 2 make it easy to quickly create your drawings, it also delivers a simple to use

environment where you will enjoy changing and manipulating each drawing.
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3.1. Launching TouchDraw
The following icon will appear on your device after purchasing TouchDraw 2 and synchronizing the device

with iTunes. Tap once on this icon to launch TouchDraw 2.

After launching TouchDraw 2, you will be presented with the Document Picker. This screen may be used to

create a new drawing document, open an existing drawing document, manage drawing documents in

TouchDraw 2, and to manage tags for your drawing documents.
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3.2. Uninstalling TouchDraw
We hope you will not want to remove TouchDraw 2 from your device; however, should you need to do so,

simply press and hold on the TouchDraw 2 icon until the following pop-up menu appears.

To remove TouchDraw 2 from your device, press on the Delete App option and then press on the Delete

Button in the confirmation message. Press Cancel to close this message without removing TouchDraw 2 from

your device.

Should you want to re-install TouchDraw 2, you can do so by re-syncing your device with iTunes or by
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re-downloading it using the App Store app.
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3.3. Moving from TouchDraw 1 to
TouchDraw 2
If you have used or are currently using TouchDraw 1 for iPad, then you may need to move your drawings to

TouchDraw 2.  There are multiple ways to accomplish the migration of your data:

• The backup approach: With this approach, you use the "Backup and Restore" functionality in
TouchDraw 1 to export your data to iCloud Drive or the local file system on the iPad itself.

• The Mac approach: With this approach, you use the iOS integration built-in to the Finder application on
you Mac to copy your data to iCloud Drive.
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3.3.1. Backup Approach

The easiest way to accomplish this is by using the backup feature in TouchDraw 1.  It can create a Zip file

containg all of your drawings and libraries, which can then be uzipped into the TouchDraw directory in your

iCloud Files or in your local iPad storage.

Step 1: Make sure you have run TouchDraw 2 at least once on your device. A TouchDraw folder will be

created on your iPad or on iCloud the first time the app is run.

Step 2: Open TouchDraw 1 on your iPad. Press on the Global Settings Button and tap on the Create Backup

File option. This option will create a backup file containing all of your TouchDraw 1 drawings and libraries.

Step 3: Tap on the Save to Files option.
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Step 4: Select the TouchDraw folder within iCloud, the TouchDraw folder in local file system or another

location of your choice and tap Save. This will save the Zip file with all of your drawings and libraries in that

location.
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Step 5: Next, open the Files app on your iPad.

Step 6: Press on the TouchDraw folder (or the alternate location you selected in Step 4) to access the created

backup file.
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Step 7: Perform an extended Press on the Zip file to open the Contextual Menu. Then tap on the Uncompress

option.
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Step 8: Once the Zip file has been unzipped, a new folder will be present within the TouchDraw folder on your

iPad. All drawings and libraries backed up from TouchDraw 1 will appear in this folder. The folder will have

the same name as the created backup Zip file (i.e. TouchDrawBackup...), as shown below:
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Note: The backup file will have numbers at the end that represent the Year/Month/Date that the file was

created.

Step 9: This folder will be visible when viewing drawing documents within TouchDraw 2 on your iPad, as

shown below:
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Opening Your Drawings

To open an imported drawing from TouchDraw 1, simply tap on the drawing within the Document Picker.
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Importing Custom Libraries

Libraries can be imported into TouchDraw 2 from the TouchDraw 1 backup file as well. Complete the

following steps to do so:

Step 1: To import any of your custom libraries into TouchDraw 2, tap on the library folder within the

Document Picker.
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Step 2: Tap on Import to import the selected library into TouchDraw 2. You may also tap on Cancel to close

this message without completing the import.

Step 3: If a library already exists in TouchDraw 2 with the same name, the following message will be

provided. Tap on New Name to append a number to the end of the file and prevent an overwrite or tap on

Overwrite to replace the current library with the imported one.
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Step 4: In this example, a new name was given to the library file. Tap Dismiss to close the message.
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3.3.2. Mac Approach

Moving your drawings from TouchDraw 1 to TouchDraw can also be accomplished with your iPad connected

to your Mac.

Step 1: Make sure you have run TouchDraw 2 at least once on your device. A TouchDraw folder will be

created on your iPad or within iCloud the first time the app is run.

Step 2: Connect your iPad to your Mac.

Note:  If prompted, answer 'Trust' if prompted to 'Trust This Computer'

Step 3: Open the Finder and select your iPad in the "Locations" section of the left hand sidebar.

Step 4: Select the "Files" tab within the Finder, scroll down to "TouchDraw" in the list of files and click the

expansion arrows to view the files located within TouchDraw.
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Step 5: Select the first file in the list (in the example show here, it's "American Football.t2l" and then press

"Command-A" to select all of the files within TouchDraw.)
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Step 6: Press "Commmand-N" to open a new Finder window, and select "iCloud Drive" within the "iCloud"

section of the left hand sidebar.
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Step 7: Drag the files you selected in Step 5 over to the "TouchDraw" folder within iCloud.  That will copy the

files (and any files in sub-folders) to iCloud for accessing within TouchDraw 2.

Opening Your Drawings

To open an imported drawing from TouchDraw 1, simply tap on the drawing within the Document Picker.
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Importing Custom Libraries

Libraries can be imported into TouchDraw 2 from the TouchDraw 1 backup file as well. Complete the

following steps to do so:

Step 1: To import any of your custom libraries into TouchDraw 2, tap on the library folder within the

Document Picker.
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Step 2: Tap on Import to import the selected library into TouchDraw 2. You may also tap on Cancel to close

this message without completing the import.

Step 3: If a library already exists in TouchDraw 2 with the same name, the following message will be

provided. Tap on New Name to append a number to the end of the file and prevent an overwrite or tap on

Overwrite to replace the current library with the imported one.
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Step 4: In this example, a new name was given to the library file. Tap Dismiss to close the message.
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3.4. Useful Links
Elevenworks Website

Useful links on the Elevenworks.com website.

Description Link

Elevenworks Main Website https://www.elevenworks.com/

TouchDraw Main Web Page https://www.elevenworks.com/touchdraw

TouchDraw 2 for iOS Documentation https://www.elevenworks.com/documentation

To get support and/or to provide feedback on TouchDraw 2, you can contact Elevenworks via our Contact Form

 or at the following email address: support@elevenworks.com.

https://www.elevenworks.com/
https://www.elevenworks.com/touchdraw
https://www.elevenworks.com/documentation
https://www.elevenworks.com/contact
mailto:support@elevenworks.com
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4. Document Picker
The Document Picker will open when the TouchDraw 2 application is first launched. This screen functions as

the user interface for managing drawing documents that have been stored on the iOS device, in iCloud, or

within a cloud storage provider app (DropBox, Box, Google Drive, etc.).

As shown below, the Document Picker is split into two views. The Document Menu resides on the left hand

side and the Document View resides on the right hand side of the screen.

It will appear as shown below when in Landscape Mode. When in Portrait Mode, the left panel will

automatically be hidden and can be accessed by pressing on Locations.

The Document View may contain folders and individual files depending on the selected document location

within the Document Menu. To scroll through the drawing documents within the Document View, simply use
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a downward or upward swipe gesture to move through the pages.

Note: Please refer to the Document Picker User Interface page to learn more about the Top Toolbar, Bottom

Toolbar, Document Menu, and Document View interface features of the Document Picker.
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4.1. Document Picker User Interface
The Document Picker is divided into four sections: Top Toolbar, Document Menu, Document View, and

the Bottom Toolbar. It can be used to create and manage drawing documents (or folders) within TouchDraw 2.

Click or Tap on the Document Picker section to learn more about its features.

Section Name Description

Top Toolbar The Top Toolbar provides access to preferences within the TouchDraw 2 application

and can be used to create a new drawing document or to select drawing documents for

File Management functions.

Document Menu The Document Menu is located on the left hand hand side of the Document Picker

(Landscape Mode) and can be used to access saved drawing documents or folders.
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Section Name Description

Document View The Document View is located on the right hand side of the Document Picker

(Landscape Mode) and shows all folders and drawing documents within a selected

parent directory within the Document Menu.

Bottom Toolbar The Bottom Toolbar provides access for browsing all folders and drawing documents

within a selected location and the most recent documents. When one or more drawing

documents are selected, it may also be used to access and perform File Management

functions.
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4.1.1. Top Toolbar

The Top Toolbar provides access to preferences and file management functions within TouchDraw 2. It

appears as shown below when in Landscape Mode:

An additional option will be present when viewing the Document Picker in Portrait Mode for viewing the

Document Menu and choosing a storage location.

Click or Tap on the Top Toolbar option name to learn more about its functionality.

Icon Button Name Description

Locations The Locations Button can be used to view the Document Menu

 and select a storage location when in Portrait Mode.

Global Settings

Menu

The Global Settings Button can be used to access additional

information about TouchDraw 2, to send feedback, and for

in-app purchases. It can also be used to alter Importers, User

Interface, and Default Template Settings.

Create Document

Button

The Create (+) Button can be used to create a new drawing

document within the selected storage location and/or directory

within the Document Menu.

Select The Select Button can be used to select one or more drawing
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Icon Button Name Description

documents within the Document View  and share, duplicate,

move, delete, or copy the selected drawing document(s).

Search The Search Field can be used to search for a specific drawing

document within the selected storage location.

Create Folder The Create Folder Button can be used create a new folder

within the currently selected storage location and/or selected

folder directory.

Name The Name Button can be used to sort files and folders by name

within the selected storage location.

Date The Date Button can be used to sort files and folders by date

within the selected storage location.

Size The Size Button can be used to sort files and folders by size

within the selected storage location.

Kind The Kind Button can be used to sort files and folders by kind

(type) within the selected storage location.

Tags The Tags Button can be used to sort files and folders by

assigned tags within the selected storage location.

Tile View The Tile View Button can be used to change the Document

View to a tile view.

List View The List View Button can be used to change the Document

View to a list view.

Column View The Column View Button can be used to change the

Document View to a column view.
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4.1.1.1. Global Settings Menu

The Global Settings Menu can be used to view more information about TouchDraw 2. It can also be used to

access features such as in-app purchases as well as importers, user interface, and default template preferences.

It is accessed by pressing on the Global Settings Button located in the upper left corner of the Top Toolbar.

The menu will appear as shown below:

Click or Tap on the Global Settings Menu option name to learn more about its functionality.

Option Name Description

About The About option can be used to version information for TouchDraw 2.

Send Feedback The Send Feedback option can be used to send feedback regarding TouchDraw 2.
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Option Name Description

Documentation The Documentation option can be used to access the TouchDraw 2 documentation.

In-App Purchases

Submenu

The In-App Purchases Submenu can be used to

Importers Submenu The Importers Submenu can be used to enable or disable global importer settings for

TouchDraw 2.

User Interface

Submenu

The User Interface Submenu can be used to enable or disable global user interface

settings for TouchDraw 2.

Editor Defaults

Submenu

The Editor Defaults Submenu can be used to set default behaviors for newly created

drawing sessions.

New Drawing

Defaults Submenu

The New Drawing Defaults Submenu can be used to set default settings for all new

drawing document in the Document Picker. These settings are used in Drawing Editor

for individual drawings and can now be set globally for all new drawing documents in

TouchDraw 2.

Default Template

Submenu

The Default Template Submenu can be used to configure the default template

selection for new drawing documents. When a specific template  (Letter, Legal, A1,

etc.) is chosen in this submenu, all new drawings will use the selected template.

4.1.1.1.1. In-App Purchases Submenu

The In-App Purchases Submenu can be used to manage in-app purchases for TouchDraw 2. These options

are accessed by pressing on the Global Settings Button in the Top Toolbar, as shown below:

Press on the In-App Purchases Submenu to view additional options.
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Click or Tap on the In-App Purchases option to bring up the purchases that you can make within the app:

Option Name Description

Free 7 Day Trial With the Free 7 Day Trial, you can try all of the features of TouchDraw 2 without

any commitment.  After the trial expires, you can continue to use the app to view

documents for free.

Unlock Editing The Unlock Editing option can be used to permanently unlock all of the features of
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Option Name Description

TouchDraw 2 through a one-time purchase (no subscription).

Restore Purchases The Restore Purchases option can be used restore your purchases if you re-installed

TouchDraw or have installed in on a new device.

4.1.1.1.2. Importers Submenu

The Importers Submenu can be used to access importers settings in TouchDraw 2. This menu is accessed by

pressing on the Global Settings Button in the Top Toolbar, as shown below.

Next, press on the Importers Submenu.
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Click or Tap on the Importers Menu option names to learn more about their functionality.

Option Name Description

Import

Connections

The Import Connections option can be used to enable and disable import

connections for Visio.

4.1.1.1.3. User Interface Settings

The User Interface options can be used to access global user interface settings for TouchDraw 2. These

options are accessed by pressing on the Global Settings Button in the Top Toolbar, as shown below.

Press on the User Interface Submenu to view additional options.
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Click or Tap on the User Interface Menu option names to learn more about their functionality.

Option Name Description

Theme The Theme Submenu can be used to choose a theme for the Document Picker (light

or dark).

Hide Menu

Animations

The Hide Menu Animations option can be used to hide menu animations for

TouchDraw 2. It will appear blue when enabled and gray when disabled.

4.1.1.1.4. Editor Defaults Submenu

The Editor Defaults Submenu can be used to set default behaviors for newly created drawing sessions.

This menu is accessed by pressing on the Global Settings Button in the Top Toolbar, as shown below.

Next, press on the Editor Defaults Submenu.
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Click or Tap on the Editor Defaults Menu option names to learn more about their functionality.

Option Name Description

Fit to Page The Fit to Page option can be used disable (default) or enable the Fit to Page option

for newly created editor sessions.

4.1.1.1.5. New Drawing Defaults Submenu

The New Drawing Defaults Submenu can be used to set default settings for all new drawing document in the

Document Picker. These settings are used in Drawing Editor for individual drawings and can now be set

globally for all new drawing documents in TouchDraw 2.

These options are accessed by pressing on the Global Settings Button in the Top Toolbar, as shown below.
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Press on the New Drawing Defaults Submenu to view additional options.
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Click or Tap on the New Drawing Defaults Menu option names to learn more about their functionality.

Option Name Description

Show Grid The Show Grid menu item can be used to hide or display the background grid on the

main application window to show a blank or grid canvas. A blue slider indicates that

the option is enabled and a gray slider indicates the option is disabled.

Snap to Grid The Snap to Grid menu item aligns objects to the grid for more precise drawing
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Option Name Description

modifications

Snap to Lines The Snap to Lines menu item aligns objects with the nearest lines.

Snap to

Points/Pixels

The Snap to Points/Pixels menu item aligns objects to whole pixel numbers for

simplified object modification and increased accuracy.

Snap to Shapes The Snap to Shapes option snaps a figure to a selected shape vertex or center point.

To see this option in action, disable the Snap to Grid option, make certain Snap to

Shapes is enabled, and then draw a star or rectangle. Once the shape is completed,

select the Line Tool and try to draw a line from one of the vertexes of the shape or its

center point. The drawn line will snap to one of these locations.

Show Page Bounds The Show Page Bounds menu item places page boundary lines on the drawing

canvas when enabled. This option is disabled by default within TouchDraw 2 and

must be selected from the menu to be enabled. Select this menu option again to

disable it and remove the boundary lines.

Selection as Group The Selection As Group option is the default setting for TouchDraw 2. When

enabled, multiple shapes selected at once will be treated as a group and can be resized,

rotated, etc. as a group.

Select Individually

(Classic)

The Select Individually (Classic) option enables the same behavior experienced

when select shapes in TouchDraw 1. All of the handles for all of the the selected

shapes will be displayed in the Drawing Canvas.
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4.1.2. Document Menu

The Document Menu is located on the left hand hand side of the Document Picker and can be used to access

saved drawing documents stored on your iOS device, in iCloud, or in an installed cloud storage provider app

(Dropbox, Box, Google Drive, etc.).

Tap on an option within the Document Menu to view the folders and drawing documents for selection within

the Document View. In the example below, On My iPad has been chosen.

Click or Tap on a Document Menu item to learn more about its functionality.

Name Description

Locations Local device and cloud storage locations may be added and managed from the
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Name Description

Document Menu for access to drawing documents.

Favorites Folders within a selected storage location may be added to the Favorites List in the

Document Menu for faster access to drawings.

Tags Tags can be used to sort drawing documents within the Document View for a selected

storage location and folder.
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4.1.3. Document View

The Document View is located on the right hand side of the Document Picker and shows a preview of drawing

documents and folders for a selected parent directory within the Document Menu.

Tap on a drawing document to make a selection and open it within the Drawing Editor.



Page 61

TouchDraw 2 for iOS

Options are provided at the top of the Document View for creating folders, sorting files and folders, and

changing the file/folder view.

These options are hidden by default and can be viewed by pressing and dragging downward on the Document

View.

Use the Bottom Toolbar to view recent drawing documents or to browse through all available folders and

drawing documents for a selection in the Document Menu.
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4.1.3.1. Document View Contextual Menu

The Contextual Menu may be opened within the Document View by performing an extended press on a

drawing document or folder. Please note that the displayed options will vary depending on the selection.

This menu may be used to access the same file management options found within the Bottom Toolbar and a

few additional options.
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Click or Tap on a Contextual Menu option to learn more about its features.

Option Name Description

Copy The Copy option can be used to create a copy the drawing document (or folder) to a

selected storage location within the Document Menu.

Duplicate The Duplicate option can be used to duplicate the drawing document (or folder)

within the chosen storage location.

Move The Move option can be used move a drawing document (or folder) to another storage

location within the Document Menu.

Delete The Delete option can be used to delete a drawing document (or folder) from the

selected storage location within the Document Menu.

Info The Info option can be used to view additional information about the selected

drawing document (or folder). This includes the drawing document size, kind,

creation date, last modified date, storage location, and assigned tags.

Tags The Tags option can be used to assign, remove, or add new tags for a drawing

document (or folder).

Rename The Rename option can be used to rename a drawing document (or folder).

Share The Share option can be used to access options for sharing a drawing document (or
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Option Name Description

folder).

Favorites The Favorites option can be used to add or remove a folder from the Favorites Section

 in the Document Menu.
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4.1.4. Bottom Toolbar

The Bottom Toolbar can be used to browse recent or all drawing documents. It defaults to the Browse

selection. It is located at the bottom of the Document Picker screen and appears as shown below:

When one or more drawing documents are selected within the Document View, additional file management

options will be provided in this toolbar.

Click or Tap on a Bottom Toolbar Button to learn more about its functionality.

Button Name Description

Browse The Browse option can be used to view all drawing documents and folders for a

selected parent directory.

Recent The Recent option can be used to view the most recent files in TouchDraw 2.

Share The Share option can be used to share one or more selected drawing documents (or

folders).

Duplicate The Duplicate option can be used to duplicate an existing drawing document (or

folder) within the chosen parent directory.

Move The Move option can be used move one or more selected drawing documents (or

folders) to another parent directory.

Delete The Delete option can be used to delete one or more selected drawing documents (or

folders).

Copy The Copy option can be used to copy one or more selected drawing documents (or

folders) to another parent directory or folder.
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4.2. Managing Locations
Locations shown in the Document Menu depend on what applications have been installed on the device. By

default, the following locations will be automatically available and enabled:

• iCloud

• On My iPad (or other device)

• Recently Deleted

If you have installed a 3rd party cloud storage application such as Dropbox, Box, or Google Drive. To enable a

application, it must be authenticated on the device.

When enabled, you will be able to browse files/folders, perform file management functions, and open drawing

documents from a selected location.
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To learn more, please see the following pages:

• Authenticating Cloud Storage Service Apps

• Enabling and Disabling Storage Locations

• Re-Ordering Locations in the Document Menu
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4.2.1. Authenticating Cloud Storage Service
Apps

Cloud Storage Service Apps will appear as a storage location option within the Document Menu automatically

once installed on the iOS device.

Each app must be authenticated before you will be able to view and select drawing documents within the

Document Picker.

If you have already signed into the app, then the authentication is complete. You will instantly be able to view,

select, and open drawing documents in TouchDraw 2 for a selected app.

To authenticate an app, press on the app within the Document Menu and then enter your login credentials.

Note: Authenticated cloud storage provider apps can be enabled or disabled within the Drawing Menu. See

Enabling and Disabling Storage Locations to learn more.
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4.2.2. Enabling and Disabling Storage
Locations

Storage locations may be enabled or disabled as needed within the Document Menu. The order of storage

locations may also be changed when this menu is in Edit Mode.

Note: Cloud storage services must be authenticated before you will be able to view and select drawing

documents within the Document Picker. Unauthenticated cloud storage service apps will appear grayed out

until the authentication process has been completed.

To enable or disable a storage location within the Document Menu, complete the following steps:

Step 1: Press on the More Options (...) Button located at the top right of the Document Menu.
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Step 2: Tap on the Edit option to enter Edit Mode.

Step 3: Next, tap on the Toggle Slider for the desired storage location. In this example, Dropbox will be

enabled as a storage location.
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Step 4: The slider will appear blue when enabled. It will appear gray for disabled storage locations. Disabled

locations do not appear in the Document Menu when in Normal Mode.

Step 5: Tap Done to exit Edit Mode.
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Step 6: An enabled storage location will appear in the Document Menu, as shown below:

Note: The position of storage locations within the Document Menu may be changed by touching and dragging

on the Re-Ordering Handle and dragging upward or downward in the Locations List.
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4.2.3. Re-Ordering Locations in the Document
Menu

To re-order storage locations within the Document Menu, complete the following steps:

Step 1: Press on the More Options (...) Button located at the top right of the Document Menu.

Step 2: Tap on the Edit option to enter Edit Mode.

Step 3: The position of storage locations within the Document Menu may be changed by touching and

dragging on the Re-Ordering Handle and dragging upward or downward in the Locations List.
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Step 4: Tap Done to exit Edit Mode.
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4.3. Managing Favorites
Folders in a selected parent directory (local device, iCloud, etc.) may be added to the Favorites List within the

Document Menu.

To learn more about managing items in your Favorites List, please see the following pages:

• Adding a Folder to the Favorites List

• Removing a Folder from the Favorites List

• Re-Ordering the Favorites List

Note: Please note that not all 3rd party cloud storage providers will support the ability to add a folder to the

Favorites List. For example, this functionality is not available for Dropbox folders.
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4.3.1. Adding a Folder to the Favorites List

Folders can be added as a favorite from the Document View for a selected Storage Location.To add a folder as

a favorite, complete the following steps:

Step 1: Select a Storage Location in the Document Menu. For this example, On My iPad has been selected.

Step 2: Perform an Extended Press on the desired folder.
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Step 3: Tap on the Favorite option within the Contextual Menu to mark the folder as a favorite.

Note: Please note that not all 3rd party cloud storage providers will support the ability to add a folder to the

Favorites List. For example, this functionality is not available for Dropbox folders.

Step 4: The folder will appear in the Favorites List of the Document Menu, as shown below:
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4.3.2. Removing a Folder from Favorites List

Folders added to the Favorites List of the Document Menu can be removed in one of two ways within

TouchDraw 2.

More than one folder may be removed from favorites through the Document Menu and single folders may be

removed from favorites within the Document View.

Document Menu (Edit Mode) - One or Multiple Folders

Step 1: Press on the More Options (...) Button in the upper right corner of the Document Menu.

Step 2: Tap on the Edit option.

Step 3: Next, press on the Delete Item Button (red circle with white line) located to the left of the desired

folder.
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Step 4: Finally, press on the Delete Button to remove the folder.

Step 5: Press Done in the upper right corner of the Document Menu to save the change.

Document View - Single Folder
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Step 1: Perform an Extended Press on the folder to bring up the Contextual Menu.

Step 2: Tap on the Unfavorite option within the menu.

Step 3: The folder will no longer appear within the Favorites List within the Document Menu.



Page 83

TouchDraw 2 for iOS



Page 84

TouchDraw 2 for iOS

4.3.3. Re-Ordering the Favorites List

Items in the Favorites List may be re-ordered when more than one item has been added in the Document Menu.

Complete the following steps to change re-order the Favorites List in TouchDraw 2:

Step 1: Press on the More Options (...) Button in the upper right corner of the Document Menu.

Step 2: Press on the Re-Arrange Button located on the right of the favorite folder and then drag upward or

downward to change the position of the folder in the list.

Step 3: In this example, the TouchDraw folder is being moved down in the Favorites List.
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Step 4: Press Done in the upper right corner of the Document Menu to save the change.
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4.4. Managing Tags
Several default tags are provided within the Document Menu and can be assigned to one or more drawing

documents for sorting within the Document View. These tags can be found at the bottom of the Document

Menu as shown below.

Default Tags within the Document Menu can be assigned and used to filter drawing documents within the

Document View. Tags may be re-arranged, added, removed, and modified as needed within the Document

Picker.

For more information about managing and using tags in the Document Picker, please see the following pages:

• Re-Ordering Tags in the Document Menu

• Renaming Tags in the Document Menu

• Deleting a Tag from the Document Menu

• Assigning Existing Tags to Drawing Documents (or Folders)

• Assigning a New Tag to a Drawing Document (or Folder)

• Removing a Tag from a Drawing Document (or Folder)
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4.4.1. Re-Ordering Tags in the Document Menu

To change the order of tags, the Document Menu will need to be put into Edit Mode. Tags may be dragged

upward or downward when the menu is in this mode.

Complete the following steps to change the order of tags within the Document Menu.

Step 1: Press on the More Options (...) Button located in the upper right corner of the Document Menu to

enter Edit Mode.

Step 2: Next, tap the Edit option within the menu.

Step 3:Touch and Drag upward or downward on the Re-Ordering Handle located to the right of the tag

name to change the position of the tag in the list.
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Step 4: Tap Done in the upper right corner of the Document Menu to save the change.
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4.4.2. Renaming Tags in the Document Menu

To rename a tag, the Document Menu will need to be put into Edit Mode. Complete the following steps to

rename one or more tags within the Document Menu.

Step 1: Press on the More Options (...) Button located in the upper right corner of the Document Menu to

enter Edit Mode.

Step 2: Next, tap the Edit option within the menu.

Step 3: Tap on the Tag Name.



Page 90

TouchDraw 2 for iOS

Step 4: Enter a new name using the keyboard. You will need to remove the current name before typing a new

one. For this example, Test Tag will be entered. Tap done on the keyboard to finish the change.
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Step 5: Tap Done in the upper right of the Document Menu to exit Edit Mode.

Note: If the entered name has already been used for a tag, then the following message will be provided. A

name can only be used for one tag.



Page 92

TouchDraw 2 for iOS

4.4.3. Removing a Tag from the Document
Menu

To remove a tag from TouchDraw 2, the Document Menu will need to be put into Edit Mode. Complete the

following steps to remove a tag from the Document Menu.

Step 1: Press on the More Options (...) Button located in the upper right corner of the Document Menu to

enter Edit Mode.

Step 2: Next, tap the Edit option within the menu.

Step 3: Press on the Delete Item Button (red circle with white line) located to the left of the tag name.
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Step 4: In this example, the Orange tag will be removed. Press on the Delete Button to remove the tag**.**

Step 5: Tap Done in the upper right corner of the Document Menu to save the change.
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4.4.4. Assigning Existing Tags to Drawing
Documents (or Folders)

Tags in the Document Menu can be used to filter drawing documents based on the assigned tag. TouchDraw 2

contains default tags that can be modified and/or used to filter drawings and folders in the Document Picker.

An existing tag can be assigned to a drawing document through the Document View, by completing the

following steps:

Step 1: Perform an extended press over the drawing document (or folder) to open the Contextual Menu.

Step 2: Tap on the Tags option in the menu.
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Step 3: Tap on an available tag to assign it to the document. Assigned tags will have a checkmark next to their

name.
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Step 4: The drawing document will have a dot matching the color of the assigned tag.

Note: More than one tag may be assigned to a drawing document or folder by performing the steps above.
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4.4.5. Assigning a New Tag to a Drawing
Document (or Folder)

Tags in the Document Menu can be used to filter drawing documents based on the assigned tag. TouchDraw 2

contains default tags that can be modified and/or used to filter drawings and folders in the Document Picker.

A new tag can be assigned to a drawing document (or folder) through the Document View, by completing the

following steps:

Step 1: Perform an extended press over a drawing document (or folder) within the Document View.

Step 2: Tap on the Tags option in the Contextual Menu.
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Step 3: Tap the Add New Tag option.

Step 4: Enter a Name for the new tag and select a Color (if desired). It will default to white.
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Step 5: Tap Done in the upper right corner.

Note: Once the tag has been created, you will be able to assign it to the drawing document (or folder).
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4.4.6. Removing a Tag from a Drawing
Document (or Folder)

To remove a tag from a drawing document (or folder) An existing tag can be assigned to a drawing document

through the Document View, by completing the following steps:

Step 1: Perform an extended press over the drawing document (or folder) to open the Contextual Menu.

Step 2: Tap on the Tags option in the menu.
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Step 3: Assigned tags will have a checkmark. To remove a tag, tap on the tag in the menu and the checkmark

will be removed.
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Step 4: The dot for the tag will no longer appear next to the drawing document or folder name.
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4.5. File Management
TouchDraw 2 provides numerous File Management options to make working with new, saved, or imported

drawing documents easier. The following pages explain how to perform basic file operations.

• Creating a New Folder

• Creating a New Drawing Document

• Opening a Drawing Document

• Renaming a Drawing Document (or Folder)

• Moving a Drawing Document

• Copying a Drawing Document

• Duplicating a Drawing Document (or Folder)

• Deleting a Drawing Document (or Folder)

• Importing a Drawing Document

• Sharing a Drawing Document

Note: Drawings and custom libraries can also easily be moved from TouchDraw 1 to TouchDraw 2. Please see

this page to learn more: Moving from TouchDraw 1 to TouchDraw 2.
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4.5.1. Creating a New Folder

Drawing documents may be stored locally on an iOS device, within iCloud, or through a third party cloud

storage service app.

A drawing document can be saved to the parent directory or a new folder that has been created within the

Document Picker.

To create a new folder, complete the following steps:

Step 1: Press on the Create Folder Icon located in the upper left corner of the Document View.

Step 2: Enter a name in the New Folder.
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Step 3: Press Done on the keyboard or in the upper right corner to finish.
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Step 4: The new folder will appear in the Document View. Once added, you can copy or move other drawing

documents or folders to the new folder.
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Note: You can also perform an extended press in a blank area of the Document View and tap on New Folder

to create a new folder.
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4.5.2. Creating a New Drawing Document

A drawing document can be created in one of two ways within the Document Picker:

Method 1: Press the Create (+) Button within the Top Toolbar.

Method 2: Press Create New Document within the Document View.

Choose a Template to use for the new drawing document. Letter is chosen by default. You can use the

drop-down menu to select from additional template options.

Tap Choose in the upper right corner to finish creating the new drawing document.
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The new drawing will be opened in the Drawing Editor, as shown below:

Note: New drawings are given the name "Untitled #". The drawing document may be renamed at any time.
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4.5.3. Opening a Drawing Document

A drawing document may be opened from the local device, from iCloud, or an installed third party cloud

storage service application (Dropbox, Box, Google Drive, etc.).

These options are provided for opening files in TouchDraw 2 and are accessible from the Document Menu. To

open a drawing document, complete the following steps:

Step 1: Perform a press to select one of these options and view drawing documents saved in the selected

storage location.

Step 2: Press on a drawing document within the Document View to open and view it within the Drawing

Editor.
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Note: When a drawing document is opened that is not in the native TouchDraw 2 format, it will automatically

be converted and a TouchDraw 2 drawing will be created from it.
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4.5.4. Renaming a Drawing Document (or
Folder)

A drawing document (or folder) can be renamed in the Document Picker. To rename a drawing document or

folder, complete these steps:

Step 1: Perform an extended press on the drawing document (or folder) within the Document View. Then

select the Rename option within the Contextual Menu.
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Step 2: Enter a new name for the drawing document. Press done in the upper right corner or on the keyboard

once finished.
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Step 3: The drawing document will appear in the Document View with the new name, as shown below.

Note: If the entered name is already taken or invalid, a pop-up message will appear after pressing on Done.

Tap OK to close this message.
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4.5.5. Moving a Drawing Document (or Folder)

A drawing document can be moved to a specific location in one of two ways:

Method 1: This method may be used to move one or more drawing documents and/or folders at the same time.

Step 1: Press the Select Button in the Top Toolbar.

Step 2: Next, tap on a drawing document(s) to select it. Selected drawing documents or folders will have a

checkmark within the Document View.

Step 3: Then press the Move Button in the Bottom Toolbar.

Step 4: Next, you will need to select the location where the selected file(s) will be moved. Tap on a parent

directory location. If no folders are present, then the selected file(s) will be moved to the parent directory.
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Step 5: The selection will expand when folders are present. Tap on a folder to move the document to a folder

within the selected parent directory when needed.
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Step 6: Press Move when finished to move the selected drawing document(s).

Method 2: This method may be used to quickly move a single drawing document or folder to another storage



Page 119

TouchDraw 2 for iOS

location.

Step 1: Perform an extended press on the drawing document within the Document View. Then select the Move

 option within the Contextual Menu.

Step 2: Next, you will need to select the location where the selected file(s) will be moved. Tap on a parent

directory location. If no folders are present, then the selected file(s) will be moved to the parent directory.
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Step 3: The selection will expand when folders are present. Tap on a folder to move the document to a folder

within the selected parent directory when needed.
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Step 4: Press Move when finished to move the selected drawing document(s).
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4.5.6. Copying a Drawing Document (Or Folder)

A copy of a drawing document (or folder) can be created within a parent directory in one of two ways:

Method 1: This method may be used to copy one or more drawing documents or folders at a time.

Step 1: Press the Select Button in the Top Toolbar.

Step 2: Next, tap on a drawing document(s) or a folder(s) to select it. Multiple selections can be made at one

time as well.

Step 3: Then press the More options... Button in the Bottom Toolbar.

Step 4: Tap on the Copy option.
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Step 5: A copy of the drawing document(s) or folder(s) will be created. Next, browse to the location where the

copy should be placed. In this example, the file will be placed within a folder in Dropbox.

Step 6: Perform an extended press in a blank area of the Document View. Tap on Paste to paste the copied

file into the selected parent directory and/or folder.
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The drawing document or folder will appear in the new location, as shown below:

Method 2: This method can be used to quickly copy and paste a single drawing document or folder into

another storage location.

Step 1: Perform an extended press on the desired drawing document or folder to bring up the Contextual

Menu. Then tap on the Copy option.
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Step 2: A copy of the drawing document (or folder) will be created. Next, browse to the location where the

copy should be placed. In this example, the file will be placed within a folder in Dropbox.
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Step 3: Perform an extended press in a blank area of the Document View. Tap on Paste to paste the copied

file into the selected parent directory and/or folder.

The drawing document or folder will appear in the new location, as shown below:
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4.5.7. Duplicating a Drawing Document (Or
Folder)

Drawing documents and folders can be duplicated within the Document Picker to inherit the same properties

and preferences of the original without having to manually recreate them.

Once a drawing document or folder has been duplicated, the newly created file may be renamed and edited

separately from the original.

A drawing document or folder may be duplicated in one of the following ways:

Method 1: This method may be used to duplicate one or more drawing documents or folders at a time.

Step 1: Press the Select Button in the Top Toolbar.

Step 2: Next, tap on a drawing document (or folder) to select it. More than one drawing document (or folder)

can be selected as well.

Step 3: Press the Duplicate Button within the Bottom Toolbar.
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Step 4: A number will be placed at the end of the drawing document name to indicate that it is a duplicate.

Method 2: This method can be used to quickly duplicate a single drawing document or folder in the current

location.

Step 1: Perform an extended press on the drawing document within the Document View. Then select the

Duplicate option within the Contextual Menu.
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Step 2: A number will be placed at the end of the drawing document name to indicate that it is a duplicate.
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Note: A duplicated document is saved in the same folder directory as the original, but can be moved to another

location by choosing Move or Copy in the Bottom Toolbar when selected.
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4.5.8. Deleting a Drawing Document (or Folder)

A drawing document (or folder) can be deleted from the local device storage, iCloud, or a third party cloud

storage application through the Document View within the Document Picker.

A drawing document (or folder) may be deleted in one of the following ways:

Method 1: This method may be used to delete one or more drawing documents or folders at a time.

Step 1: Press the Select Button in the Top Toolbar.

Step 2: Next, tap on the drawing document of folder to select it. Multiple items can be selected at one time

using this method.

Step 3: Press the Delete Button within the Bottom Toolbar.
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Step 4: The drawing document (or folder) will be removed from the selected location.

Method 2: This method can be used to quickly delete a single drawing document or folder.

Step 1: Perform an extended press on the drawing document (or folder) within the Document View. Then

select the Delete option within the Contextual Menu.
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Step 2: The drawing document (or folder) will be removed from the selected location.
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4.5.9. Importing a Drawing Document (or
Folder)

In addition to be being able to open native TouchDraw 2 documents, TouchDraw 2 also has support for

opening other file types. The list of supported file types are:

• TouchDraw Native (.t2d)

• Scalable Vector Graphics (.svg)

• Visio XML Drawing (*.vdx)

• Portable Network Graphic (.png)

• JPEG (.jpg, .jpeg)

• BMP (.bmp)

• TIFF (.tif, .tiff)

• Enhanced Metafile (.emf)

• Windows Metafile (.wmf)

Note: When a drawing document is opened that is not in the native TouchDraw 2 format, it will automatically

be converted and a TouchDraw 2 drawing document will be created from it.

Files may be accessed and imported into TouchDraw 2 using one of two methods:

• Directly within the TouchDraw 2 Application

• Import from 3rd Party Applications (Mail, Gmail, Dropbox, etc.).

TouchDraw 2 Application

Drawing documents can be opened directly from a parent directory outside of the local device storage and can

be copied or moved from other parent directories to local storage.
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To learn more, please see the following pages:

• Opening a Drawing Document

• Moving a Drawing Document (Or Folder)

• Copying a Drawing Document (Or Folder)

Import from 3rd Party Application

If a drawing in another application is accessible, use the built-in Open in.../ Copy to TouchDraw 2 capability

to send the drawing to TouchDraw 2 from the other application.

For example, if a TouchDraw 2 drawing is received via an email message, tap on the drawing document to

open the preview pane and then press to view more options.
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Touch and Drag to the right in the pop-up window. Then press on the More (...)Button.

Finally, tap on the Copy to TouchDraw 2 option in the menu. The file will be converted to the TouchDraw 2

format and opened within the Drawing Editor.
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Note: The steps will vary per application when importing a drawing from a third party application.
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4.5.10. Sharing a Drawing Document (Or
Folder)

TouchDraw 2 supports several different methods of sharing (exporting) drawing documents or folders.

All sharing options are reachable by selecting a drawing document or folder within the Document Picker.

A drawing document or folder may be shared/exported in one of two ways:

Method 1: This method can be used to share/export one or more drawing documents or folders at one time.

Step 1: Press the Select Button in the Top Toolbar.

Step 2: Tap on a drawing document (or folder) to select it within the Document View.

Step 3: Press the Share Button in the Bottom Toolbar.
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Step 4: Next, press on an option within the pop-up window. Drawing documents (or folders) can be shared via

messages, mail, cloud storage services (Dropbox, Box, Google Drive, etc.), and using other options.

Note: Options shown here will depend on what has been installed and is available on your iOS device.

Method 2: This method can be used to quickly share a single drawing document or folder.

Step 1: Perform an extended press on the drawing document (or folder) within the Document View. Then

select the Share option within the Contextual Menu.
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Step 2: Next, press on an option within the pop-up window. Drawing documents (or folder) can be shared via

messages, mail, cloud storage services (Dropbox, Box, Google Drive, etc.), and using other options.
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Note: Options shown here will depend on what has been installed and is available on your iOS device.
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5. Drawing Editor
The options for Editing Drawings in TouchDraw 2 are designed to make working with figures, lines, paths,

and handles easier.

The following pages explain how to create, manage, and edit figures within a drawing through the Drawing

Editor.
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5.1. User Interface
The Drawing Editor will be displayed when a new drawing is created or an existing drawing is opened within

TouchDraw 2.

The screen will may also be viewed in landscape mode and will appear as shown below:
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This screen functions as the user interface for creating and managing drawings in TouchDraw 2. The Drawing

Tools are located on the left portion of the application window and the Drawing Canvas is located on the right.

A Toolbar can be found on the top portion of the screen.

The Drawing Toolbar is designed to adjust based on the screen size of the device. When your iOS device has a

smaller screen, some of the options will collapse into selectable menus within the toolbar.

The Drawing Toolbar will appear similar to what is shown below when the screen of an iOS device is a small

phone, etc.
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5.1.1. Menus

TouchDraw 2 contains 5 menus to access actions, options and settings related to the application, file

management and drawing manipulation. Simply press on a menu and choose the desired option.

Click or Tap on the corresponding Menu name to learn more about its options.

Menu Name Description

File The File menu contains file management options for saving drawings, inserting

images, exporting drawings, and printing drawings.

Edit The Edit menu contains common editing, duplication, and text manipulation choices.

Arrange The Arrange menu contains options for grouping, locking, moving, aligning, and

distributing objects within a drawing.

Modify The Modify menu contains options for modifying shapes, lines, and paths within a

drawing.

View The View menu contains options for changing what is viewed in the main application

window.
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5.1.1.1. File Menu

Use the File Menu to access actions related to the file management such as inserting images into a drawing,

exporting a drawing, or printing a drawing.

Click or Tap on the name of the menu item to find out more details about what action occurs when it is selected.

Save The Save menu item saves the current drawing. This menu option will only be
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Menu Item Description

available if a change has been made to the drawing.

Save As... The Save As... menu item saves the current drawing as a new drawing in a selected

parent directory or folder within the chosen parent directory.

Insert from Photos The Insert from Photos menu item can be used to import an image stored in photos.

Insert from Camera The Insert from Camera menu item can be used to import an image from the camera.

Insert From... The Insert From... menu item can be used to import images stored in iCloud into the

current drawing.

Export The ExportSubmenu can be used to access options for exporting a drawing from

TouchDraw 2.

Print The PrintSubmenu menu be used to print single or multiple pages of a drawing

straight to a computer or to save a drawing as a PDF.

The Print Submenu can be used to print single or multiple pages of a drawing straight to a computer or to save

a drawing as a PDF.
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Click or Tap on the name of the submenu item to find out more details about what action occurs when it is

selected or enabled.

Menu Item Description

Print... The Print... option can be used to print single or multiple pages of a drawing straight

to a computer or to save a drawing as a PDF.

Fit to Page The Fit to Page option can be used to scale down a drawing spanning mulitple pages

into one singular page.

Adaptive

Orientation

The Adaptive Orientation option controls which page orientation will be used when

the Fit to Page option is enabled. If the option is off, the page orientation will match

the orientation selected for the drawing.   If the option is on, the orientation will adapt
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Menu Item Description

to best fill the specified paper size.

Show Crop Marks The Show Crop Marks option will display the crop marks within the printed drawing

when enabled.

Show Margins The Show Margins option will display the margins within the printed drawing when

enabled.

Full Bleed The Full Bleed option can be used to ensure the printed drawing is Full Bleed rather

than cropped at the margins.

5.1.1.1.1. Export Submenu

The Export Submenu provides options exporting a TouchDraw 2 drawing from the Drawing Editor.

To access this menu, press on the File Menu and then press on the Export Submenu.

The Export Submenu will appear as shown below:
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Note: Options displayed within this submenu will vary depending on what file type has been chosen.

Export File Types

TouchDraw 2 drawings may be exported as six different file types. When using the Export Submenu, tap on a

file type to make a selection.

The selected file type will have a checkmark and all options for the currently selected type will be displayed.
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Click or Tap on a drawing export option to learn more about its features.

Option Name Description

TouchDraw Export a drawing in the TouchDraw 2 (Native) file type.

Bitmap Image Export a drawing as a Bitmap Image (BMP) file type.

PDF Export a drawing as a Portable Document Format (PDF) file type.

SVG Export a drawing as a Scalable Vector Graphics (SVG) file type

Visio Export a drawing as a Visio (VSD) file type.

5.1.1.1.1.1. TouchDraw

A drawing may be exported in the native TouchDraw format by selecting the TouchDraw option within the

Export Submenu.
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Click or Tap on an export option to learn more about its features.

Option Name Description

Current Layer The Current Layer option exports the currently selected layer within the TouchDraw

2 Drawing.

Current Selection The Current Selection option exports the current selection within the TouchDraw 2

Drawing.

All Layers The All Layers option exports all layers within the TouchDraw 2 drawing.

Visible Content The Visible Content option exports what is currently visible within the TouchDraw 2

drawing.

5.1.1.1.1.2. Bitmap Image
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A drawing may be exported as a Bitmap Image by selecting the Bitmap Image option within the Export

Submenu.
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Click or Tap on an export option to learn more about its features.

Option Name Description

Current Selection The Current Selection option exports the current selection within the TouchDraw 2

Drawing.

Current Layer The Current Layer option exports the currently selected layer within the TouchDraw

2 Drawing.
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Option Name Description

Current Selection The Current Selection option exports the current selection within the TouchDraw 2

Drawing.

All Layers The All Layers option exports all layers within the TouchDraw 2 drawing.

Visible Content The Visible Content option exports what is currently visible within the TouchDraw 2

drawing.

PNG The PNG option exports the Bitmap Image file in the Portable Network Graphics

(PNG) format.

JPEG The JPEG option exports the Bitmap Image file in the JPEG format.

Width The Width option may be used to manually alter the width of the image size.

Height The Height option may be used to manually alter the height of the image size.

Constrain

Proportions

The Constrain Proportions option may be used to ensure the proportions of the

exported drawing remain the same. For example, if the original drawing is 100 width

by 50 height and the width configuration option is changed to 200, then the height will

be adjusted to 100. It will be scaled by the same proportions in both directions. If this

option is disabled, then the file can be exported with less standard sizing such as 400w

x 25h.

Scale The Scale option sets the dimension of the exported image to a specific percentage

relative to the drawings actual size.

Transparent

Background

The Transparent Background option makes the background transparent to only

show the images to be exported.

Half Pixel Shift The Half Pixel Shift option shifts pixels half a pixel-width toward the right.

5.1.1.1.1.3. PDF

A drawing may be exported as a PDF file by selecting the PDF option within the Export Submenu.



Page 158

TouchDraw 2 for iOS

Click or Tap on an export option to learn more about its features.

Option Name Description

Current Layer The Current Layer option exports the currently selected layer within the TouchDraw

2 Drawing.

Current Selection The Current Selection option exports the current selection within the TouchDraw 2

Drawing.



Page 159

TouchDraw 2 for iOS

Option Name Description

All Layers The All Layers option exports all layers within the TouchDraw 2 drawing.

Visible Content The Visible Content option exports what is currently visible within the TouchDraw 2

drawing.

Include Grid The Include Grid option tells TouchDraw 2 to include (or not include) the grid in the

generated file.

Include Margin The Include Margin option tells TouchDraw 2 to include (or not include) margins in

the generated file.

5.1.1.1.1.4. SVG

A drawing may be exported as a SVG file by selecting the SVG option within the Export Submenu.
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Click or Tap on an export option to learn more about its features.

Option Name Description

Current Layer The Current Layer option exports the currently selected layer within the TouchDraw

2 Drawing.

Current Selection The Current Selection option exports the current selection within the TouchDraw 2

Drawing.
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Option Name Description

All Layers The All Layers option exports all layers within the TouchDraw 2 drawing.

Visible Content The Visible Content option exports what is currently visible within the TouchDraw 2

drawing.

Include Grid The Include Grid option tells TouchDraw 2 to include (or not include) the grid in the

generated file.

Include Margin The Include Margin option tells TouchDraw 2 to include (or not include) margins in

the generated file.

Pretty Print The Pretty Print option formats the exported SVG into a form that is human

readable. Rather than one big line, it uses spaces, returns, and tabs to make the

structure understandable.

Inkscape Attributes The Inkscape Attributes option informs TouchDraw 2 to include Inkscape specific

attributes when exporting a drawing as an SVG File.

5.1.1.1.1.5. Visio

A drawing may be exported as a Visio file by selecting the Visio option within the Export Submenu.
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Click or Tap on an export option to learn more about its features.

Option Name Description

Current Layer The Current Layer option exports the currently selected layer within the TouchDraw

2 Drawing.

Current Selection The Current Selection option exports the current selection within the TouchDraw 2

Drawing.
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Option Name Description

All Layers The All Layers option exports all layers within the TouchDraw 2 drawing.

Visible Content The Visible Content option exports what is currently visible within the TouchDraw 2

drawing.

VSDX The VSDX option can be used to select the VSDX file format for the exported

TouchDraw 2 drawing.

VDX The VDX option can be used to select the VDX file format for the exported

TouchDraw 2 drawing.
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5.1.1.2. Edit Menu

Use the Edit Menu to access actions related to the clipboard, undo and miscellaneous text editing. When this

menu is selected, the options shown below will appear.

Click or Tap on the name of the menu item to find out more details about what action occurs when it is selected.

Undo The Undo menu item removes drawing changes in the order they were applied
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Menu Item Description

starting with the most recent.

Redo The Redo menu item reapplies drawing changes in the order they were removed

starting with the most recent.

Cut The Cut menu item removes the currently selected item from the active drawing and

places it in the clipboard.

Copy The Copy menu item places a copy of the currently selected item into the clipboard.

Paste The Paste menu item adds the most current item residing in the clipboard to the active

drawing.

Paste Special The Paste Special submenu contains special options related to pasting the contents of

the clipboard into the active drawing.

Duplicate The Duplicate menu item creates a copy of a selected item in the active drawing.

Duplicate in Place The Duplicate in Place menu item creates a copy of a selected item and places it in

the same location as the original.

Delete The Delete menu item permanently removes an item from the active drawing.

Select All The Select All menu item selects all items residing in the currently active drawing.

Deselect All The Deselect All option deselects all currently selected figures within the active

drawing.

Invert Selection The Invert Selection option deselects currently selected figures within the active

drawing and selects all figures that were previously not chosen.

5.1.1.2.1. Paste Special Submenu

The Paste Special... Submenu contains options for pasting the most current clipboard item into the active

drawing.

It is accessed by either touching and pressing on the Drawing Canvas for ~1 second or by pressing on the Paste

Special Submenu within the Edit Menu in the toolbar.
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Note: This menu choice only appears if a figure has been cut or copied and currently resides in the clipboard.

Click or Tap on the corresponding Paste Submenu item name to learn more about what the option does.

Option Name Description

Paste in Place The Paste in Place menu item copies the current clipboard item into the exact

location of the original.

Paste Multiple The Paste Multiple menu item can be used to paste multiple copies of a clipboard

item at specific offsets.

Paste Style The Paste Style menu item applies the formatting properties of one object to the

currently selected object.



Page 167

TouchDraw 2 for iOS

5.1.1.3. Arrange Menu

Use the Arrange Menu to access actions for arranging or aligning selected figures within a drawing. When

this menu is selected, the options shown below will appear.
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Click or Tap on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Group The Group menu item allows currently selected shapes on the Drawing Canvas to be

manipulated and treated as a single figure. This menu item is enabled when two or

more groupable figures are selected in the Drawing Canvas. Shapes residing on the

Drawing Canvas can be manipulated.
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Menu Item Description

Ungroup The Ungroup menu item removes the grouping attribute for selected shapes to allow

for individual manipulation. This menu item is enabled when one or more grouped

figures are selected in the Drawing Canvas.

Lock The Lock menu item prevents a selected figure(s) or group of figures from being

moved or resized. This menu item is enabled when one or more unlocked (and

lockable) figures are selected in the Drawing Canvas.

Unlock The Unlock menu item removes a previously instated lock on a figure(s) or group of

figures to allow for moving and resizing.This menu item is enabled when one or more

locked figures are selected in the Drawing Canvas.

Bring to Front The Bring to Front menu item moves a currently selected figure(s) to the front of all

figures residing in the same layer. This menu item is enabled when one ore more

figures are selected in the Drawing Canvas.

Bring Forward The Bring Forward menu item moves a currently selected figure(s) one step closer to

the top of the stack within the layer they reside in. This menu item is enabled when

one ore more figures are selected in the Drawing Canvas.

Send Backward The Send Backward menu item moves a currently selected figure(s) one step closer

to the bottom of a stack within their residing layer. This menu item is enabled when

one ore more figures are selected in the Drawing Canvas.

Send to Back The Send to Back menu item moves a currently selected figure(s) behind all other

figures residing within the same layer. This menu item is enabled when one ore more

figures are selected in the Drawing Canvas.

Align to Grid The Align To Grid option aligns figures with the grid. This menu item is enabled

when two or more unlocked figures are selected in the Drawing Canvas.

Align Top The Align Top option moves all currently selected figures to match the top (Y

position) of the first selected figure. This menu item is enabled when two or more

unlocked figures are selected in the Drawing Canvas.

Align Vertical

Center

The Align Vertical Center option moves all currently selected figures to match the

vertical center (Y position + 1/2 of the height of all figures) of the first selected

figure. This menu item is enabled when two or more unlocked figures are selected in

the Drawing Canvas.
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Menu Item Description

Align Bottom The Align Bottom option moves all currently selected figures to match the the bottom

(Y position + Height) of the first selected figure. This menu item is enabled when two

or more unlocked figures are selected in the Drawing Canvas.

Align Left The Align Left option moves all currently selected figures to match the left (X

position) of the first selected figure. This menu item is enabled when two or more

unlocked figures are selected in the Drawing Canvas.

Align Horizontal

Center

The Align Horizontal Center option moves all currently selected figures to match the

horizontal center (X position + 1/2 of the width) of the first selected figure. This

menu item is enabled when two or more unlocked figures are selected in the Drawing

Canvas.

Align Right The Align Right option moves all currently selected figures to match the right (X

position + Width) of the first selected figure. This menu item is enabled when two or

more unlocked figures are selected in the Drawing Canvas.

Distribute

Horizontally

The Distribute Horizontally option adjusts the positioning of selected figures to

create an even amount of horizontal space between each figure. This menu item is

enabled when three or more unlocked figures are selected in the Drawing Canvas.

Distribute

Vertically

The Distribute Vertically option adjusts the positioning of selected figures to create

an even amount of vertical space between each figure. This menu item is enabled

when three or more unlocked figures are selected in the Drawing Canvas.

Pack Horizontally The Pack Horizontally menu item takes a set of selected shapes and "packs" them

into the smallest space possible horizontally.

Pack Vertically The Pack Vertically menu item takes a set of selected shapes and "packs" them into

the smallest space possible vertically.
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5.1.1.4. Modify Menu

The Modify Menu is used to transform or move the selected figures within a drawing. When this menu is

selected, the options shown below will appear.
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Click or Tap on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Dimensions The Dimensions Submenu contains options for changing the arrow locations on

dimension lines within a drawing.

Flip The Flip submenu contains options to flip the selected figures within a drawing.

Resize The Resize submenu can be used to resize selected figures based on the largest or

smallest size, width, or height.

Rotate The Rotate submenu contains options to rotate the selected figures within a drawing.

Move By... The Move By option changes the location of a figure based on input coordinates.

Scale By... The Scale By option alters figure size based on input coordinates to create a smaller
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Menu Item Description

or larger figure spanning over a specific area.

Scale Attached... The Scale Attached... option can be used to scale an image, such as a floor plan, to

match the grid and trace or perform other actions within the drawing "at scale".

Open Path The Open Path menu item is enabled when one or more closed paths are selected.

This option removes a line segment or simply separates the last end/start points into

two separate handles to transform a closed path into an open path.

Close Path The Close Path menu item is enabled when one or more open paths are selected. This

option adds a line segment between the last end point and the start point of a selected

path or connects the start and end points of a curve segment to create a closed path.

Split All Segments The Split All Segments menu item is enabled when one or more paths are selected.

This option splits a selected path into segments at each end point handle to create

multiple individual path figures.

Join Lines/Paths The Join Lines/Paths menu item is enabled when two or more lines and/or open

paths are selected. This option joins the end point handles of segments to create a

single path figure.

Trim Lines/Paths The Trim Lines/Paths menu item is enabled when two or more shapes are selected

and at least one of those shapes is a line or open path. This option trims the ends of

intersecting lines, paths, or connections when the intersection is near the end of the

line/path.

Reverse

Lines/Paths

The Reverse Lines/Paths menu item flips or reverses the direction of the decorations

(arrowhead, diamond, square, etc.) within selected lines and/or paths.

Make Compound

Path

The Make Compound Path menu item is enabled when two or more paths are

selected. This option combines two or more selected paths into one compound path to

provide attribute sharing capabilities.

Split Compound

Path

The Split Compound Path menu item is enabled when one ore more compound paths

are selected. This option separates a compound path into individual paths.

Add Shapes The Add Shapes menu item is enabled when two shapes and/or closed paths are

selected. This option combines two selected shapes into one figure.

Subtract Shapes The Subtract Shapes menu item is enabled when two shapes and/or closed paths are

selected. This option removes the intersecting portions of the second selected shape
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Menu Item Description

from the first figure selected in the drawing canvas.

Intersect Shapes The Intersect Shapes menu item is enabled when two shapes and/or closed paths are

selected. This option removes all non-intersecting portions of selected figures from

the drawing canvas.

Exclude Shapes The Exclude Shapes menu item is enabled when two shapes and/or closed paths are

selected. This option removes the intersecting portions of selected figures from the

drawing canvas.

Convert Shape to

Path

The Convert Shape to Path is enabled when one or more shapes or lines are selected.

This option converts the bordering lines of a selected shape into a closed path by

adding the necessary handles.

Convert Text to

Path

The Convert Text to Path is enabled when one or more text figures are selected. This

option converts a text figure created with the Text tool into a path.

5.1.1.4.1. Flip Submenu

The Flip Submenu can be used to flip a selected figure(s) within a drawing. To access these options, press on

the Modify Menu and then press on Flip.
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Click or Tap on an option to learn more about what it does.

Option Name Description

Flip Horizontally The Flip Horizontally option will flip the currently selected figures on the X axis.

Flip Vertically The Flip Vertically option will flip the currently selected figures on the Y axis

5.1.1.4.2. Resize Submenu

The Resize Submenu can be used to resize selected figures based on the largest or smallest size, width, or

height. At least two figures must be selected within the drawing for these options to appear within the Modify

Menu.

TouchDraw 2 will resize all figures to match either the size, width, or height of the smallest or largest figure

among the selections in the drawing.
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Click or Tap on a Resize option to learn more about what it does.

Option Name Description

Resize to Largest

Size

The Resize to Largest Size option can be used to resize all selected figures within the

drawing to match the largest sized figure.
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Option Name Description

Resize to Smallest

Size

The Resize to Smallest Size option can be used to resize all selected figures within

the drawing to match the smallest sized figure.

Resize to Largest

Width

The Resize to Largest Width option can be used to resize all selected figures within

the drawing to match the largest width within the selections.

Resize to Smallest

Width

The Resize to Smallest Width option can be used to resize all selected figures within

the drawing to match the smallest width within the selections.

Resize to Largest

Height

The Resize to Largest Height option can be used to resize all selected figures within

the drawing to match the largest height within the selections.

Resize to Smallest

Height

The Resize to Smallest Height option can be used to resize all selected figures within

the drawing to match the smallest height within the selections.

5.1.1.4.3. Rotate Submenu

The Rotate Submenu can be used to access actions for rotating the selected figures within a drawing. To

access these options, press on the Modify Menu and then press on Rotate.
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Click or Tap on an option to learn more about what it does.

Option Name Description

Rotate 90° Right The Rotate 90º Right option will rotate the currently selected figures by 90º in a

clockwise direction.

Rotate 90° Left The Rotate 90º Left option will rotate the currently selected figures by 90º in a

counter clockwise direction.

Rotate 180° The Rotate 180º option will rotate the currently selected figures by 180º in a counter

clockwise direction.

Reset Center of

Rotation

The Reset Center Rotation menu item is enabled when the "Center of Rotation"

option in the Handles Submenu popup menu is selected and has been altered on a

shape. This option changes the "Center of Rotation" for a shape back to its original

centered location.
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5.1.1.5. View Menu

Use the View Menu to access actions for changing settings of the currently visible Drawing Canvas. When this

menu is selected, the options shown below will appear.

Click or Tap on the name of the menu item to find out more details about what action occurs when it is selected.

Zoom In The Zoom In menu item increases the magnification level of the Drawing Canvas to
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Menu Item Description

allow for working on the drawing in more detail.

Zoom Out The Zoom Out menu item decreases the magnification level of the Drawing Canvas

make a larger portion of the drawing viewable in the window at once.

Zoom To Submenu The Zoom To Submenu options can be used to dynamically resize the magnification

level and the location of the drawing within the Drawing Canvas to make the

complete drawing visible in the window based on the drawing contents, page, or

current selection.

Selection as Group The Selection As Group option is the default setting for TouchDraw 2. When

enabled, multiple shapes selected at once will be treated as a group and can be resized,

rotated, etc. as a group.

Select Individually

(Classic)

The Select Individually (Classic) option enables the same behavior experienced

when select shapes in TouchDraw 1. All of the handles for all of the the selected

shapes will be displayed in the Drawing Canvas.

Show Rulers The Show Rulers menu item can be used to hide or show the left and top rulers on the

main application window. A blue slider indicates that the option is enabled and a gray

slider indicates the option is disabled.

Show Grid The Show Grid menu item can be used to hide or display the background grid on the

main application window to show a blank or grid canvas. A blue slider indicates that

the option is enabled and a gray slider indicates the option is disabled.

Show Page Bounds The Show Page Bounds menu item places page boundary lines on the drawing

canvas when enabled. This option is disabled by default within TouchDraw 2 and

must be selected from the menu to be enabled. Select this menu option again to

disable it and remove the boundary lines.

Crosshairs The Crosshairs option displays crosshairs on the Drawing Canvas when enabled.

Crosshairs are visible when adding, moving, and modifying items within the drawing.

Snapping Submenu The Snapping Submenu contains options related to the snapping behavior of the

active Drawing Canvas.

[Grid Level

Submenu]

The Grid Level Submenu can be used to chooose whether or not the grid is rendered

in the background (underneath the drawing) or in the foreground (above the drawing).

The default selection is Background.
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Menu Item Description

Easy Drag Mode The Easy Drag Mode option hides all handles to prevent a selected figure from being

altered as it is moved. The option can be applied to single figure by selecting the

object prior to choosing this setting or set when no figures are selected to apply the

setting to every item on the drawing canvas.

Handles Submenu The Handles Submenu contains options for configuring which handles are visible for

a selected figure.

Layers Submenu The Layers Submenu contains options for application setup and operational

characteristics of TouchDraw 2 for layers.

Show Overlays The Show Overlays option can be used to toggle Overlay Mode in TouchDraw 2.

This mode superimposed contextual tools over the drawing based on the context of

the current selection. When enabled, three types of overlay modes may be available:

nudge, line, and connector type.

Show Format Bar The Show Format Bar option may be used to hide or show the Format Bar, which is

located directly above the Drawing Canvas.

5.1.1.5.1. Zoom To Submenu

The Zoom To Submenu options can be used to dynamically resize the magnification level and the location of

the drawing within the Drawing Canvas to make the complete drawing visible in the window based on the

drawing contents, page, or current selection. You can also return the drawing back to fit its normal

magnification level in this submenu.
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Click or Tap on a Zoom To menu item to learn more about what it does.

Option Name Description

Zoom To Fit

Contents

The Zoom To Fit Contents option can be used to zoom in and fit the drawing figures

so that they are shown within the window.

Zoom To Fit Page The Zoom To Fit Page option can be used to fit the entire page within the window.

Zoom To Fit

Selection

The Zoom to Fit Selection option can be used zoom in on the drawing so that the

selected figures are shown within the window.

Zoom To Actual

Size

The Zoom to Actual Size option can be used to 100% drawing size based on the page

size (8 1/2 by 11, etc.).

Zoom To Origin The Zoom to Origin menu item returns a drawing back to it's normal magnification

level (100%) and resets the visible portion of the drawing canvas so that the

coordinates 0,0 are in the upper left hand corner.

5.1.1.5.2. Snapping Submenu

Use the Snapping Submenu to access the settings related to the snapping for the active Drawing Canvas.

When this submenu is selected within the View Menu, the options shown below will appear.
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Click or Tap on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Snap to Grid The Snap to Grid menu item aligns objects to the grid for more precise drawing

modifications.

Snap to Lines The Snap to Lines menu item aligns objects with the nearest lines.

Snap to

Points/Pixels

The Snap to Points/Pixels menu item aligns objects to whole pixel numbers for

simplified object modification and increased accuracy.

Snap to Shapes The Snap to Shapes option snaps a figure to a selected shape vertex or center point.

To see this option in action, disable the Snap to Grid option, make certain Snap to

Shapes is enabled, and then draw a star or rectangle. Once the shape is completed,

select the Line Tool and try to draw a line from one of the vertexes of the shape or its

center point. The drawn line will snap to one of these locations.

5.1.1.5.3. Grid Level Submenu

The Grid Level Submenu can be used to chooose whether or not the grid is rendered in the background

(underneath the drawing) or in the foreground (above the drawing). The default selection is Background.

To access these options, press on the Grid Level Submenu within the View Menu.
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Menu Item Description

Background The Background option can be used to render the grid in the background of the

drawing. When enabled, the grid will be rendered underneath the drawing. This is the

default selection.

Foreground The Foreground option can be used to render the grid in the foreground of the

drawing. When enabled, the grid will be rendered above the drawing.

 

Background

Below is an example of a drawing where the grid is rendered in the background.

 

Foreground
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Below is an example of a drawing where the grid is rendered in the foreground.

5.1.1.5.4. Handles Submenu

The Handle Submenu is used to configure which handles are visible for a selected figure. The menu is broken

up into two sections: Attribute Handles and Path Handles.

To access these settings, press on the View Menu and then press on Handles.
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Click or Tap on the name of the menu item to find out more details about what action occurs when it is selected.

Attribute Handles

Handle Name Description

Rotation The Rotation option toggles the visibility of the rotation handle on the Drawing

Canvas.

Gradient Locations The Gradient Locations option toggles the visibility of the gradient location handle

within a figure(s) on the Drawing Canvas.

Center of Rotation Enabling the the Center of Rotation option allows the point at which a figure or

shape is rotated around to be edited.

Path Handles

Handle Name Description

Bounds The Bounds option toggles the visibility of the boundaries of path handles.

Boundaries can be shown on handles for all figures, strokes, and paths or for

everything but paths.

Path Segments The Path Segments option toggles the visibility of segment handles for paths.

Path Control Points The Path Control Points option toggles the visibility of path control points between

always showing, only showing active points, or showing none at all.

5.1.1.5.5. Layers Submenu

The Layers Submenu contains options for application setup and operational characteristics of TouchDraw 2

for layers. It is accessed by pressing on the View Menu and then pressing on Layers.
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Note: Enabled options will have a blue background and toggle button, which is located to the right of the

option.
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Preference Name Description

Layer Isolation The Layer Isolation preference isolates modifications to the currently selected layer

and prevents other existing layers from being selected for editing. **This preference

is enabled by default.

Add Layer When

Locked

The Add Layer When Locked preference automatically creates another layer if a

figure is added to the Drawing Canvas when the current layer is locked.

Auto-Select Layer The Auto-Select Layer preference alters the currently active layer to the residing

layer of a selected figure unless the layer has been locked.

Ask For New

Layer Name

The Ask For New Layer Name preference opens a prompt window for naming a

layer any time a new layer is created.
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5.1.2. Toolbar

The Toolbar has eight buttons available for performing actions within the TouchDraw 2 application and

displays the title of the currently selected drawing.

The buttons on the right hand side of the toolbar supply access to most of the functions for modifying drawing

figure attributes and changing application settings.

Click or Tap on one of the Toolbar Button names to learn more about its functionality.

Button Icon Button Name Description

Back The Back Button may be used to return to the Document

Picker.

Undo The Undo Button reverts the last change that was made to a

drawing. This button is disabled (dimmed) when no changes

have been made and enabled as soon as something is altered in

the Drawing Canvas.

Redo The Redo Button cancels the last undone change made to the

Drawing Canvas. This button is disabled (dimmed) when

nothing has been undone and is enabled as soon as the Undo

command has been used or something is altered.

Delete The Delete Button removes currently selected figure(s) from

the Drawing Canvas.

Info The Info Button can be used to access options for changing the

attributes of a figure that is about to be drawn or any currently

selected figure.

Layers The Layers Button can be used to access options for creating

and managing layers within a currently open drawing.

Stencil Libraries The Stencil Libraries Button provides the capability to add,
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Button Icon Button Name Description

remove, and manage stencils for use in drawings. A stencil is a

pre-defined object that can be saved, name accordingly, and

dragged/dropped into drawings as needed. TouchDraw 2

provides a vast array of choices and you can create/store your

own objects as well.

Settings The Settings Button can be used to access general purpose

actions within TouchDraw 2.

Note: Menus may also appear in the toolbar when using a tablet. To find out more, see Menus.
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5.1.2.1. Info

The Info Button is used to change attributes for a figure that is about to be drawn or any currently selected

figure. A popover menu with multiple selection choices will appear when the button is pressed.

Pressing on the Info Button causes the Info Menu to open. This popover menu provides options for changing

the attributes of multiple types of created figures and will appear as shown below.

Click or Tap on the corresponding Info Menu item name to learn more about what the option does.

Icon Attribute Name Description

Geometry Tab The Geometry Tab contains options for altering attributes on a

selected figure or to make path related changes to a figure.

Stroke Tab The StrokeTab can be used to alter the attributes of a stroke

(line) for existing or new figures(s) within the Drawing Canvas.
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Icon Attribute Name Description

Fill Tab The Fill Tab can be used to alter the fill attributes (color,

opacity, etc.) of selected or new figure(s).

Text Tab The Text Tab can be used to alter the text attributes of any

figure capable of displaying text.

Shadow and

Opacity Tab

The Shadow and Opacity Tab contains options for altering

shadowing, opacity, and blending attributes of a figure(s).

Connections Tab The Connections Tab contains options for altering the type of

connector used for the Connection Tool.

Units and Rulers

Tab

The Units and Rulers Tab can be used to set the units of

measure for the current drawing. In addition to controlling the

layout and divisions of the ruler, the units are also used when

exporting the drawings to other formats such as PNG Images

and PDF files.

Page Setup Tab The Page Setup Tab contains options for altering printing

units, page width, page height, and print margin attributes.

5.1.2.1.1. Geometry Tab

The Geometry Tab contains options for gaining enhanced control of a selected figure or to make path related

changes to a figure. The tab will appear as shown below when selected in the Info Menu. Values displayed in

the Geometry Tab default to Inches or Degrees.
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Click or Tap on the corresponding Geometry Attribute name to learn more about what the option does.

Attribute Name Description

The Lock button, when enabled or locked, constrains the proportions of the shape as

the width or height is changed.

The Reference Point Selection Button can be used to set/specify the reference point

for the current selection (or future selections) in the Drawing Canvas. The selection

defaults to the Top Left, but may be changed to Top Center, Top Right, Center Left,

Center, Center Right, Bottom Left, Bottom Center or Bottom Right. When used, the X

and Y coordinates will change based on the selection to reflect the reference point

change.

X The X attribute can be used to set the X position of the currently selected figure to the

entered value. It functions as a nudge tool when multiple figures are selected by

moving all figures in a manner relative to the entered change.

Y The Y attribute can be used to set the Y position of the currently selected figure to the

entered value. It functions as a nudge tool when multiple figures are selected by

moving all figures in a manner relative to the entered change.

Width The Width attribute can be used to set the width of all currently selected figures to the
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Attribute Name Description

entered value. The width of all figures is set to this value when multiple items are

selected. To scale the width based on the relative size within the selected figures,

group all of the figures and then resize.

Height The Height attribute can be used to set the height of the currently selected figure to

the entered value. The height of all figures is set to this value when multiple items are

selected. To scale the width based on the relative size within the selected figures,

group all of the figures and then resize.

Rotation The Rotation attribute can be used to set the angle of the currently selected figure to

the chosen slider or keyboard entered value. In the instance of a multiple figure

selection, this option will set the angle of all selected figures to the entered value and

rotate them relative to their own centers. It is best to group all desired figures and then

rotate them as a group when wanting to make this change relative to the center of the

selection.

Line Length The Line Length attribute can be used to set the length of a selected line(s). A line

must be selected for this option to be enabled.

Line Angle The Line Angle attribute can be used to set the rotation angle of a selected line(s). A

line must be selected for this option to be enabled.

Radius The Radius attribute can be used to set the radius of the currently select circle to the

entered value. In the instance of multiple figure selection, this option will set the

radius of all selected figures to the entered value.

Corner Size The Corner Size attribute can be used to set the size of the corner for a rounded

rectangle. The units for the corner size are the units of measure of the drawing. For

example, if the units of measure for the drawing were inches and the size of the corner

is set to ".25", the corner size is 1/4 of an inch.

# of Points The # of Points attribute can be used to set the number of points for a star. In the

instance of multiple figure selection, this option will set the number of points of all

selected figures to the entered value.

# of Sides The # of Sides attribute can be used to set the number of sides for a polygon. In the

instance of a multiple figure selection, this option will set the number of sides of all

selected figures to the entered value.
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Note: The value displayed in the text field of each attribute setting represents the value of the first selected

figure.

5.1.2.1.2. Stroke Tab

The Stroke Tab contains options for setting the attributes of a line (stroke). The tab will appear as shown

below when selected in the Info Menu. Values displayed in the Stroke Tab default to Points.

Click or Tap on the corresponding Stroke Attribute name to learn more about what the option does.

Attribute Name Description

Stroke The Stroke attribute is an "On/Off" toggle button for setting the visibility of strokes

or lines of a figure(s). The border or line of a figure is not drawn when this option is

disabled.

Dash Pattern The Dash Pattern attribute can be used to set the style of the line being created.
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Attribute Name Description

Start The Start attribute can be used to set the style of the beginning portion of a created

line.

End The End attribute can be used to set the style of the ending portion of a created line.

Size The Size attribute can be used to set the width of a stroke in pixels.

Start Scale The Start Scale attribute can be used to scale the start of a line independently from

the stroke size.

End Scale The End Scale attribute can be used to scale the end of a line independently from the

stroke size.

Start Shear The Start Shear attribute can be used to shear or skew the arrowhead at the start of

lines.

End Shear The End Shear attribute can be used to shear or skew the arrowhead at the end of

lines.

Line Join The Line Join attribute can be used to set the join of a line to Mitered, Rounded, or

Beveled.

Line Cap The Line Cap attribute can be used to set the cap of a line to Butt, Rounded, or

Square.

Location The Location attribute can be used to set the location where the line will join with

another object.

Miter Limit The Miter Limit attribute can be used to set the angle of connected line segments

where they join. The join will be more jagged or sharp depending on the entered or

selected value. Miter limits are relative to stroke size and become increasingly

noticeable for line segments with increased thickness.

Stroke Color The Stroke Color attribute can be used to specify the color of a stroke. Refer to the

Handling Colors section to learn more about color attribute changes.

5.1.2.1.3. Fill Tab

The Fill Tab contains options for setting the fill attributes of all objects with the exception of the Line and

Connection tools. The tab will appear as shown below when selected in the Info Menu.



Page 200

TouchDraw 2 for iOS

Click or Tap on the corresponding Fill Attribute name to learn more about what the option does.

Attribute Name Description

Fill The Fill attribute is an "On/Off" button for toggling the        visibility of the fill of a

figure(s). Shapes have no fill when this option        is disabled.

Fill Style

The Fill Style attributes are located in a drop down menu underneath          the Fill

button. This option sets the type of fill pattern used for a figure(s).

• Solid - Fills a figure with solid color.

• Linear Gradient - Transitions from the specified start color to            the
specified end color at a designated angle.

• Radial Gradient - A radial gradient transitions from the specified            start
color to the specified end color by starting from the center of the            figure
and then moving outward in a circular manner.

Color The Color attribute is used to choose the fill color for a figure(s).        See the

Handling Colors section        for additional details.

5.1.2.1.4. Text Tab

The Text Tab contains options for setting the text attributes of a figure(s). The tab will appear as shown below

when selected in the Info Menu. Values displayed in the Text Tab default to Points.
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Click or Tap on the corresponding Text Attribute name to learn more about what the option does.

Attribute Name Description

Font Family The Font Family attribute is used to choose a set of fonts with the same typeface, but

varying qualities such as size and weight.

Font Size The Font Size attribute sets the height of characters in a selected font family.

Font Style The Font Style attribute sets the style or angle of text within a figure(s).

Text Margin The Text Margin attribute sets the margins for text within a figure(s). The

measurement spans from the text box edge to the actual text.

Horizontal

Alignment

The HorizontalAlignment attribute sets the horizontal text alignment modes for text

within a figure(s).

Vertical Alignment The Vertical Alignment attribute sets the vertical text alignment modes for text

within a figure(s).

Text Color The Text Color attribute sets the color of text appearing in a figure(s).

Attached The Attached option is disabled by default. When enabled, the location and

orientation of attached text can be altered for a line or path.

Text Location The Text Location option can be used to change the location of text that is attached to
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Attribute Name Description

a line or path.

Text Orientation The Text Orientation option can be used to change the orientation of  text that is

attached to a line or path. Text orientation can be Absolute or Relative.

 

Note: Refer to the Handling Text section of this documentation to learn more about attribute changes or editing

text for figures.

5.1.2.1.5. Shadow and Opacity Tab

The Shadow and Opacity Tab contains options for altering shadowing, opacity, and blending attributes of a

figure(s). The tab will appear as shown below when selected in the Info Menu. Values displayed in the

Shadow and Opacity Tab default to Points.
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Click or Tap on the corresponding Shadow Attribute name to learn more about what the option does.

Attribute Name Description

Shadow The Shadow attribute is used to toggle the shadow visibility of a figure(s). A shadow

is not drawn if this option is disabled.

X Offset The X Offset attribute sets the offset of the shadow in the X axis.

Y Offset The Y Offset attribute sets the offset of the shadow in the Y axis.

Blur The Blur attribute sets the amount of blur applied to the shadow.

Shadow Color The Shadow Color attribute sets the shadow color for a figure(s). Refer to the

Handling Colors section of this documentation to learn more about color attribute

alterations.
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Attribute Name Description

Opacity The Opacity attribute can be used to alter the opaqueness (opposite of transparency)

of a selected color.

Blending Mode The Blending Mode attribute sets the style of blend applied to a figure(s).

5.1.2.1.6. Connections Tab

The Connections Tab contains options for altering the type of connection used between figures in your

drawing when using the Connection Tool.

To alter the type of connection line, tap on the Connections Tab and then tap on the a desired connection type

option. The selected type will be used automatically when using the Connection Tool in TouchDraw 2.

Icon Name Description

Line Connection

Tool

The Line Connection Tool draws a line connection that

connects two shapes in the shortest path.

East-West

Connection Tool

The East-West Connection Tool draws a connection line that

originates from the side (either west/left or east/right) of the

source figure and connects to the side (either west/left or

east/right) of the target figure.

North-South

Connection Tool

The North-South Connection Tool draws a connection line

that originates from the side (either north/top or south/bottom)

of the source figure and connects to the side (either north/top or

south/bottom) of the target figure.

Horizontal-Vertical The Horizontal-Vertical Connection Tool draws a connection
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Icon Name Description

Connection Tool line that originates horizontally from the right or left side of the

source figure and connects vertically to the side (top) of the

target figure.

Vertical-Horizontal

Connection Tool

The Vertical-Horizontal Connection Tool draws a connection

line that originates vertically from the side (either top or

bottom) of the source figure and connects to the side (either left

or right) of the target figure.

Path Connection

Tool

The Path Connection Tool creates a path connection that

connects two shapes. As with paths created with the Path Tool,

path connections can be manipulated to add additional line or

curve segments.

Hub Connection

Tool

The Hub Connection Tool creates a connection line that is

able to receive connections. This is typically used for creating

network diagrams.

5.1.2.1.7. Units and Rulers Tab

The Units and Rulers Tab contains options for altering the unit of measure, background, and additional

Drawing Canvas related settings.

These options are used to control the layout and divisions of the ruler. Unit settings are additionally used when

drawings are exported in alternative formats such as a PDF file.

The tab will appear as shown below when selected in the Info Menu.
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Click or Tap on the corresponding Units and Rulers Attribute name to learn more about what the option does.

Attribute Name Description

Drawing Units The Drawing Units attribute sets the form of unit measurement on the Drawing

Canvas (inches, pixels, etc.).

Grid Type The Grid Type attribute sets the grid type for the Drawing Canvas. It can be square

(default) or isometric.

Major Gridline The Major Gridline attribute sets the interval (in the current unit of measure) that a

major gridline will be drawn. For example, if the unit of measure is centimeters and

the major gridline is set to 2, it will draw the major gridline every two centimeters.

Subdivisions The Subdivisions attribute sets the number of subdivisions (minor gridlines) that are

drawn between the Major Gridlines. For example, if the unit of measure is centimeters

and the major gridline is set to 2, and the subdivisions is set to 4, it will draw a minor

gridline every 1/2 cm (5mm).

Scale The Scale attribute can be used to change the scale of the drawing to the size of the

printed drawing.

Limit Stroke

Scaling

The Limit Stroke Scaling attribute is used to configure TouchDraw 2 so that lines

having a thickness smaller than 1 (based on the current zoom level) are drawn at 1
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Attribute Name Description

pixel. This setting makes certain these lines are always visible.

Note: A change from one unit of measurement to another does not numerically change the size of figures. For

example, changing from inches to centimeters where the objects were previously 1 inch wide causes the objects

to become 1 centimeter wide. You can use the "Scale By..." option to scale the drawing after the conversion.

5.1.2.1.8. Page Setup Tab

The Page Setup Tab contains options for altering the print margins of a drawing. The tab will appear as shown

below when selected in the Info Menu. Values displayed in the Page Setup Tab default to Inches.
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Click or Tap on the corresponding Page Setup Attribute name to learn more about what the option does.

Attribute Name Description

Page Size The Page Size attribute sets the size of the entire page (i.e. letter, legal, A4, etc.). By

default the page size is set to letter.

Page Units The Page Units attribute sets the unit of measurement used to define the attributes on

this page.
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Attribute Name Description

Page Width The Page Width attribute sets the width of the page in printing units.

Page Height The Page Height attribute sets the height of the page in printing units.

Top Margin

Bottom Margin

Left Margin  Right

Margin

The Top Margin, Bottom Margin, Left Margin and Right Margin attributes can

be used to set the page margins in user specified printing units.

Orientation The Orientation attribute sets the Drawing Canvas to portrait or landscape mode. By

default the canvas is set to portrait.

Background Color The Background Color attribute sets the background color of the drawing. Refer to

the Handling Colors section in this documentation to learn more about color selection.

Transparent The Transparent attribute toggles whether or not the background of the drawing is

transparent. For example, if you want to export your drawing as a transparent PNG,

then you'd want this option selected.

Note: Refer to Printing a Drawing to learn more about setting the print options for drawings.
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5.1.2.2. Layers

Layers provide the capability to incorporate more than one level of objects into a drawing. Each added layer

builds on top of the previous added layer to create a multi-dimensional drawing. They are managed and

controlled through the Layers Menu.

Press on the Layers Button in the Top Toolbar to access this menu.

The Layers Menu will appear as shown below:

Click or Tap on the corresponding Layers Menu item name to learn more about what the option does.

Icon Option Name Description

Add The Add function adds a layer to the bottom of the layer list.

Delete The Delete function removes the top layer from the layer list.

Layers Settings

Menu

The Layer Settings Menu contains options for adding,

deleting, re-ordering, and merging layers.
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Icon Option Name Description

Visibility The Visibility option is an "On/Off" toggle for setting the

visibility of each created layer. It appears to the right of each

layer name in the list as an "eye" icon and indicates the

visibility of the layer. To hide (or show) a layer, simply Press

on the eye icon of the layer to be toggled. An eye icon with a

line through it indicates that a particular layer is not visible,

whereas an eye with no line indicates a layer is visible.

Lock The Lock option is an "On/Off" toggle for locking or unlocking

a layer. It is located to the right of the visibility icon and

indicates whether or not a layer is locked. To lock (or unlock) a

layer, simply Press on the lock icon of the layer to be toggled.

A closed lock icon indicates that a layer is locked and an open

lock icon indicates a layer is unlocked.

Note: Layers located at the top of the Layers Menu List are drawn above the layers residing below it.

5.1.2.2.1. Layers Settings Menu

The Layers Settings drop-down menu is used to perform specific actions on a created layer or set of layers. It

is located in the upper right hand corner of the Layers Menu.

To access the Layers Settings Menu, press on the Layers Button in the Top Toolbar.

Tap on the Layers Settings Menu to access additional options.
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The menu will appear as shown below:
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Click on the corresponding Layers Settings Menu name to learn more about what the option does.

Option Name Description

Add Layer The Add Layer option adds a layer above existing layers. A new layer appears at the

top of the layers list.

Duplicate Layer The Duplicate Layer option creates an exact copy of a selected layer and adds it to

the top of the layers list.



Page 214

TouchDraw 2 for iOS

Option Name Description

Move Layer Up The Move Layer Up option moves a selected layer up one level in the layers list.

Move Layer Down The Move Layer Down option moves a selected layer down one level in the layers

list.

Merge Layer Up The Merge Layer Up option merges the selected layer with the one residing above it

in the layers list.

Merge Layer Down The Merge LayerDown option merges the selected layer with the one residing below

it in the layers list.

Merge All Layers The Merge All Layers option merges all existing layers into a single layer.

Rename Layer The Rename Layer option can be used to change the current name of a selected layer

in the list.

Delete Layer The Delete Layer option permanently removes a selected layer from the layers list.

Show All Layers The Show All Layers option makes all layers within the currently open drawing

visible.

Hide All Layers The Hide All Layers option hides all layers within the currently open drawing.

Lock All Layers The Lock All Layers option locks all layers within the currently open drawing.

Unlock All Layers The Unlock All Layers option unlocks all layers within the currently open drawing.

Sort Layers

(Ascending)

The Sort Layers (Ascending) option sorts all layers within a drawing in ascending

order alphabetically by name.

Sort Layers

(Descending)

The Sort Layers (Descending) option sorts all layers within a drawing in descending

order alphabetically by name.

Note: The Move and Merge options are enabled when two or more layers exist in the drawing. Corresponding

up and down options for these categories require a layer to be available above or below the selected layer to

appear as a menu selection.

Note: For more information about managing layers, please see the Handling Layers section of the user guide.
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5.1.2.3. Stencil Libraries

Stencils are predefined or custom objects you can insert into a drawing as needed. Libraries are used to add

and manage Stencils stored within the application and for adding these objects to a drawing.

Both Stencils and Libraries are managed through the Stencils Menu, which can be accessed by performing a

Press on the Stencil Libraries Button in the Top Toolbar.

The Stencils Menu can be used to view each library and the stencils stored in it.

Click or Tap on the corresponding Stencil Menu item name to learn more about what the option does.
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Icon Option Name Description

Stencil Libraries

Settings Menu

The Stencil Libraries Settings Menu contains options for

adding, removing, and renaming libraries as well as options for

managing stencils within each library.

Library Selection

Menu

The Library Selection Menu can be used to choose a specific

library stored within the application.

Search The Search Feature can be used to find a specific stencil

within the selected library.

Stencil Selection

Area

The Stencil Selection Area shows all stencils within a selected

library and can be used to make drawing additions.

5.1.2.3.1. Stencil Libraries Settings Menu

The StencilLibraries Settings Menu is used to manage libraries and stencils in TouchDraw 2. It can be used

to create, alter, and remove libraries. It may also be used to add single stencils or a group of stencils to a library

and for managing stencils in TouchDraw 2.

It is located in the upper right corner of the Stencils Menu, as shown in the image below:
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Tap on this menu to access additional options:
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Tap on the corresponding Stencil Libraries Settings Menu item name to learn more about what the option does.

Option Name Description

Add Selection To

Library As Group

The Add Selection To Library As Group menu option inserts a group of stencils

into the selected library.

Add Selection To

Library

Individually

The Add Selection To Library Individually menu option inserts a new stencil into

the selected library.

New Library The New Library option creates a new stencil library in TouchDraw 2.
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Option Name Description

Rename Library The Rename Library menu option assigns a new name to a selected stencil library.

Delete Library The Delete Library menu option removes a stencil library from TouchDraw 2.

Import Library The Import Library menu option imports a stencil library into TouchDraw 2 from

another location.

Export Library The Export Library menu option exports a stencil library from TouchDraw 2 to a

chosen directory.

Rename Stencil The Rename Stencil menu option assigns a new name to a selected stencil.

Delete Stencil The Delete Stencil menu option removes a selected stencil from a stencil library.

Set Stencil Origin The Set Stencil Origin menu option can be used to set the anchor (origin) point used

to insert the shape. The stencil origin can be changed to the following: Top Left, Top

Center, Top Right, Center Left, Center, Center Right, Bottom Left, Bottom, or Bottom

Right. Example: By default, the stencil origin is the center of the shape meaning that

if the stencil is dropped at a specific position in the Drawing Canvas(5,5 for example)

, then the center point of the shape would be at 5,5. If the stencil origin is changed to

top left and the stencil is dropped into the drawing at 5,5, then the top left of the shape

would be at 5,5 rather than the center.

Export All

Libraries...

The Export All Libraries... menu option exports all libraries from TouchDraw to a

chosen directory.

Reinstall Default

Libraries

The Reinstall Default Libraries menu option re-installs the default/bundled stencil

libraries.

Note: For more information about managing libraries and stencils, please see the Handling Stencil  Libraries

section of the user guide.
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5.1.2.4. Settings

The Settings Menu can be used to view current version information, send feedback regarding the TouchDraw

2 application, and to access additional resources. It opens when the Settings Button is pressed in the Top

Toolbar.

The Settings Menu appears as shown below:

Click or Tap on the Feedback Menu item name to learn more about its functionality.

Option Name Description

About The About option provides application specific information about TouchDraw 2

including the version number.

Send Feedback The Send Feedback option opens a mail composer view for sending feedback as an
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Option Name Description

email, bug report, suggestion, etc... to the TouchDraw 2 development team without

leaving the application. To determine the current version of TouchDraw 2 on the iOS,

view the title of the feedback popover. It will contain the version number of

TouchDraw 2.

Documentation The Documentation option will launch Safari and open the TouchDraw 2

Documentation web page, where the latest version of this documentation can be

downloaded as well as other information.

Drawing Editor

Settings Submenu

The Drawing Editor Settings Submenu contains options to support usability

preferences such as what side the Drawing Toolbar will appear on within TouchDraw

2 and Drawing Editor performance.

User Interface

Settings Submenu

The User Interface Settings Submenu contains options to support the usability

preferences of the user interface within TouchDraw 2. This submenu includes options

for selecting a specific theme, auto correction, auto capitalization, etc.

Defaults Submenu The Defaults Submnu contains options for updating the default values used for new

Drawing Editor sessions based on the currently selected values for stroke, fill, text,

and shadow defaults.

Refresh Fonts The Refresh Fonts option can be used to forcibly refresh the fonts in TouchDraw 2

after installing new fonts on the device.

5.1.2.4.1. Drawing Editor Submenu

The Drawing Editor Submenu contains options to support usability preferences and handling Drawing Editor

performance.

To access these options, first press on the Settings Button in the Top Toolbar.

Then press on the Drawing Editor Submenu within the Settings Menu.
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The Drawing Editor Submenu will appear as shown below:
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Tap on an option to enable or disable it. Enabled options will have either a blue background or a checkmark.

Disabled options will have a gray background or no checkmark.

Option Name Description

Pencil Mode Pencil Mode informs TouchDraw 2 to ignore all "touch" input with the exception of

pan and zoom gestures. It is disabled by default, but can be enabled to prevent touch

input from altering the drawing while using an Apple Pencil. Three options are

provided:

- Off - Pencil Mode is disabled.

- On - Pencil Mode is enabled and always on. If the pencil is disconnected or out of

batteries, Pencil Mode will need to be disabled in order to draw something using a
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Option Name Description

finger.

- Adaptive - Pencil Mode is enabled; however, TouchDraw 2 accesses bluetooth to

check to see if the Apple Pencil is connected and available. If it is available, then it

uses Pencil Mode. If the pencil is not connected, then it treats it like Pencil Mode is

off.

Left Side The Left Side option places the vertical toolbar on the left side of them Drawing

Editor. This is the default position and the natural choice for right handed users. This

is the default setting.

Right Side The Right Side option places the vertical toolbar on the right side of the Drawing

Editor. This is the natural choice for left handed users.

Function Button The Function Button option can be used to lock the Function Key Feature. This

option can be helpful for maintaining the aspect ratio of multiple figures during

resizing without having to hold down the toolbar. It is also a useful option for

enabling the one handed operation of TouchDraw 2.

Curve Smoothing The Curve Smoothing option enables or disables the creation of a smooth curve

when the Pen Tool is used to create a figure.

Smart Fill The Smart Fill option tries to detect if individual lines or paths with touching

endpoints have been selected when selecting a fill color. If detected, it will

automatically convert those lines/paths to a path object and then fill that path object.

This option is enabled by default.

Orthogonal

Connectors

The Orthogonal Connectors option can be used to toggle orthogonal constraining of

connector lines.

Orthogonal

Dimensions

The Orthogonal Dimensions option can be used to toggle orthogonal constraining of

dimension lines.

Show Gradients The Show Gradients option toggles whether or not gradient fills (both linear and

radial) are rendered in the Drawing Editor. If gradients are hidden, that does not mean

they have been removed from your drawing. It simply means that they won't be drawn

in the editor to increase rendering speed.

Show Images The Show Images option toggles whether or not images are rendered in the Drawing

Editor. If images are hidden, that does not mean they have been removed from your

drawing. It simply means that they won't be drawn in the editor to increase rendering
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Option Name Description

speed.

Show Shadows The Show Shadows option toggles whether or not shadows are rendered in the

Drawing Editor. If shadows are hidden, that does not mean they have been removed

from your drawing. It simply means that they won't be drawn in the editor to increase

rendering speed.

Show Handle

Shadows

The Show Handle Shadows option shows handle shadows while images are being

rendered within the Drawing Editor. This does not mean that shadows have been

removed from the drawing. Instead, shadows are not drawn in the editor to provide

increased rendering speed.

Show Outlines The Show Outlines option only shows the outlines of shapes within the Drawing

Editor. All fills and shadows are disabled when this option is enabled.

During Move and

Resize Submenu

The During Move and Resize Submenu may be used to enable or disable options for

showing gradients, images, shadows, and text when moving or resizing within the

Drawing Editor.

During Pan and

Zoom Submenu

The During Pan and Zoom Submenu may be used to enable or disable options for

showing gradients, images, shadows, and text when panning and zooming within the

Drawing Editor.

Downsize Images The Downsize Images option tells TouchDraw 2 whether or not it should downsize

images when they are imported. If it is enabled, then it will use the value of the "Max

Size (px)" setting to limit the width or the height of the imported imaged. This option

is on by default in order to limit memory usage

Max Size (px) The Max Size (px) option sets the maximum pixel size (either width or height) of

imported images if the "Downsize Images" option is on.

Close Adjustment

Popovers

The Close Adjustment Popovers option may be enabled to automatically close

popovers within the Drawing Editor after a change is made (e.g, Move By popover,

Scale By popover).

Close Menu After

Alignment

The Close Menu After Alignment option, when enabled, will automatically close the

Arrange Menu after using one of the available alignment options to align selected

figures. When disabled, the Arrange Menu will remain open after aligning the selected

figures. This option is enabled by default.
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5.1.2.4.2. User Interface Submenu

The User Interface Submenu contains options to support the usability preferences of the user interface within

TouchDraw 2.

To access these options, first press on the Settings Button in the Top Toolbar.

Then press on the User Interface Submenu within the Settings Menu.

The User Interface Submenu will appear as shown below:
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Tap on an option to enable or disable it. Enabled options will have either a blue background. .

Option Name Description

Theme The Theme option can be used to select a theme for the Drawing Editor (Automatic,

Blue (light), Light, or Dark).

Confirm on Close The Confirm to Close option enables a confirmation dialog to prevent an accidental

exit from the Drawing Editor to the Document Picker. This is useful for many users

who inadvertently press the Back Button. The confirmation dialog will only present

itself if the drawing has been modified. TouchDraw 2 will return to the Document

Picker without confirmation if a drawing has been viewed only and no changes were

made.

Shake to Undo The Shake to Undo option will undo a change when the device is shaken. Each time

the device is shaken, the last change will be undone. Shake multiple times to undo

more than one change.

Auto Correction The Auto Correction option enables or disables automatic correction as text is

entered within a currently open drawing.
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Auto Capitalization The Auto Capitalization option can be used to make the first value entered into the

Text Editor either lower or uppercase. It automatically defaults to Off and must be

turned On for the first letter to be automatically capitalized when entering text into the

editor.

Hide Menu

Animations

The Hide Menu Animations option can be used to turn off the "fade in/fade out"

animations for all of the menus. This option is disabled by default; however, power

users interested in speed and usability over eye-candy may want to turn this option on.

The Defaults Submnu contains options for updating the default values used for new Drawing Editor sessions

based on the currently selected values for stroke, fill, text, and shadow defaults.

Option Name Description

Save Stroke

Defaults

The Save Stroke Defaults option can be used to set the default stroke values for new

Drawing Editor sessions to the currently selected default values within the Stroke Tab.

Save Fill Defaults The Save Fill Defaults option can be used to set the defaultfill values for new

Drawing Editor sessions to the currently selected default values within the Fill Tab.
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Option Name Description

Save Text Defaults The Save Text Defaults option can be used to set the default text values for new

Drawing Editor sessions to the currently selected default values within the Text Tab.

Save Shadow

Defaults

The Save Shadow Defaults option can be used to set the default shadow values for

new Drawing Editor sessions to the currently selected default values within the

Shadow and Opacity Tab.

 

Example: Save Stroke Defaults

In this example, we will show how to use the Save Stroke Defaults option within this menu.

For this example, these values have been changed within the Stroke Tab for the current Drawing Editor session.

• Stroke Size = 4 pt

• Stroke Dash Pattern = dashes
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Step 1: Press on the Settings Button within the Top Toolbar.
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Step 2: Press on the Defaults Submenu.

Step 3: Press on the Save Stroke Defaults option.
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Step 4: Press on OK to confirm.

Now, when a new drawing is created, these will be the new default Stroke settings.
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5.1.3. Format Bar

The Format Bar appears between the main toolbar and the Drawing Canvas. It can be used to perform text,

stroke, and fill color alterations on a selected object or an entire drawing.

When in Portrait Mode, the Text Attributes will be combined to save space and accessible from one button:

Click on the name of the menu item to find out more details about what action occurs when the menu item is

selected.

Name Description

Text Attributes The Text Attribute buttons are used to change font family, style, size, color, and

additional text properties for currently selected figures or an entire drawing.

Stroke Attributes The Stroke Attribute buttons are used to change style, size, and color stroke

properties for currently selected figures or an entire drawing.

Fill Attributes The Fill Attribute button alters the fill color of a selected figure, group of figures, or

an entire drawing.
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5.1.4. Contextual Menu

The Contextual Menu provides quick access to various editing functions made available through the

TouchDraw 2 application.

This menu may be opened by performing an extended press anywhere within the Drawing Canvas or on a

selected figure(s).
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Note: Choices may or may not be enabled depending on the selected figure where the extended press occurs.

Click or Tap on the name of the menu item to find out more details about what action occurs when it is selected.

Option Name Description

Cut The Cut menu item removes the currently selected item from the active drawing and

places it in the clipboard.

Copy The Copy menu item places a copy of the currently selected item into the clipboard.

Paste The Paste menu item adds the most current item residing in the clipboard to the active

drawing.

Paste Special

Submenu

The Paste Special Submenu contains special options related to pasting the contents

of the clipboard into the active drawing.

Reset Center of

Rotation

The Reset Center Rotation menu item is enabled when the "Center of Rotation"

option in the Handles Submenu popup menu is selected and has been altered on a

shape. This option changes the "Center of Rotation" for a shape back to its original

centered location.

Insert Handle The Insert Handle menu item inserts a handle into the currently selected path

segment.

Delete Handle The Delete Handle menu item deletes the currently selected handle from a path

segment.

Split Path at

Handle

The Split Path at Handle menu item divides a path into two separate sections at the

chosen handle and allows each section to be altered as an individual figure.

Delete Segment The Delete Segment menu item deletes the currently selected segment from a path.

Convert Shape to

Path

The Convert Shape to Path option allows a selected shape(s) on the Drawing Canvas

to be converted into a path figure.

Segment to Line The Segment To Line option can be used to convert a quadratic or cubic path

segment into a line segment.

Segment to Quad The Segment To Quad option can be used to convert a line or cubic path segment

into a quadratic segment.

Segment to Cubic The Segment To Cubic option can be used to convert a line or quadratic path
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Option Name Description

segment into a cubic segment.

Move to Layer

Submenu

The Move To Layer Submenu contains options for moving selected figure(s) to a

new or existing layer.

Set Origin The Set Origin menu option resets (moves) the top left of the drawing (0,0) to the

specified point on the Drawing Canvas. This will be the point where the extended

press has been performed to bring up the Contextual Menu.

Style as

Dimension Line

The Style as Dimension Line option adds arrowheads and a {Length} variable to a

selected line(s). At least one line must be selected in the drawing canvas for this

option to appear.
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5.1.5. Drawing Canvas

The Drawing Canvas is the area of the screen where the currently active drawing can be viewed and modified.

All added figures appear in this portion of the TouchDraw 2 application.

Note: TouchDraw 2 includes an Overlay Mode feature to provide finer control over a selected shape, figure, or

line when making alterations to figures.

Changing the Drawing Canvas Orientation

Besides being able to switch the entire application between landscape and portrait mode on the device, the

orientation for the Drawing Canvas itself may also be changed from portrait to landscape.

By default, the setting is configured for portrait mode, but can be changed by completing the following steps:
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Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Press on the Page Setup Tab and then tap on the desired option (portrait or landscape).
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Step 3: The following image shows the Drawing Canvas in landscape mode.

Note: The Drawing Toolbar has an intuitive design meaning that the available tools will be condensed into

expandable groups when the device has a smaller screen area.
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5.1.5.1. Overlays

Overlay Mode superimposes contextual tools over the drawing based on context of the current selection.

TouchDraw 2 currently supports three types of overlay modes: Nudge, Line, and Connection Type.

The Show Overlay toggle must be enabled in the Settings Menu to use this application feature. To turn on this

feature, complete the following steps:

Step 1: Press the View Menu in the Top Toolbar.

Step 2: Touch and drag downward to view options at the bottom of the menu. The Show Overlays option will

be disabled by default.

Step 3: Tap on the Show Overlays Toggle to enable this feature. It will appear blue when enabled.
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5.1.5.1.1. Nudge Overlay

When Overlay Mode is enabled and a shape (as opposed to a line) or multiple figures has been selected, a

Nudge Overlay will fade into the lower right hand corner of the Drawing Canvas.

The Nudge Overlay application feature provides finer control over the x location, y location, width and height

of a selected figure (or figures) without having to bring up additional menus to make these changes.

Tap on the "plus" or "minus" buttons next to a desired bounds selection to alter the position or size of a

selected figure(s).
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5.1.5.1.2. Line Overlay

When Overlay Mode is enabled and one or more lines have been selected, a Line Overlay will fade into the

lower right hand corner of the Drawing Canvas.

The Line Overlay application feature provides finer control over the x position and y position of both the

starting and ending points of a line. This feature also provides finer control over the angle and length of a

selected line(s).

Tap on the "plus" or "minus" buttons next to the desired position, length, or angle selection to alter its value.

5.1.5.1.3. Connection Type Overlay

When Overlay Mode is enabled and the Connection Tool is selected, a Connection Type Overlay will fade

into the lower right hand corner of the Drawing Canvas.
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The Connection Type Overlay application feature can be used to select the connector type before creating a

connection line in the Drawing Canvas. Select the Connection Tool and then tap on the desired Connector

Type in the overlay panel to change the current connection line type.

TouchDraw 2 will remember the current selection in the Connection Type Overlay and apply it to new

connection lines created with the Connection Tool.
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You must have the Show Overlays preference enabled for the Connection Type Overlay panel to appear in

TouchDraw 2. See Overlays to learn more.

Note: To learn more about using connection lines in TouchDraw 2 and the available Connector Types, please

refer to the Connection Tool section of the wiki documentation.
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5.1.6. Drawing Toolbar

The Drawing Toolbar, located on the left side of the screen, contains all available drawing tools for adding to

or manipulating the current drawing. The tools and their exact functionality are detailed in the following

sections; however there are some general concepts of the toolbar that need to be discussed first. All tools with

the exception of the Selection Tool can operate in two modes: "Normal" or "Sticky".

Normal Mode

In Normal Mode, which is activated by selecting the tool through a single tap, the tool is used to insert one

figure into the drawing. Upon completion of creating a figure, the Selection Tool will be reactivated and the

created figure is selected. A tool is in Normal Mode when it's background is highlighted with a blue gradient

as shown in the first figure below.

Sticky Mode

Sticky Mode, which is activated by selecting a tool by a double tap, makes it possible to add many figures into

the drawing without having to reselect the tool. Upon completion of creating a figure, the tool will remain

selected, and additional figures of the same type can be created/inserted immediately.

To cancel/end creating the selected figure type, simply select another tool. A tool is in Sticky Mode when it's

background is highlighted with a blue gradient and contains a lock symbol in the lower right hand corner as

shown in the figure below.
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Easy Drag Mode

The "empty" area between the tools and the edit menu at the bottom can also be used, in conjunction with a

vertical swipe, to toggle the Easy Drag Mode.

In this mode, TouchDraw 2 will hide the handles and instead highlight the selected figures. This mode makes it
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easier to move smaller figures without worrying about inadvertently resizing them. This is explained in more

detail in the Easy Drag Mode  section of the documentation.

Collapsed Drawing Tool Options

The drawing toolbar has an intuitive design where certain drawing tools are grouped into expandable menus for

smaller devices such as tablets or smartphones. For example, the Pan and Zoom Tool, Arc Tool, and Oval Tool

can have additional options as indicated by the arrow at the bottom right of each button in the toolbar.

Perform an Extended Press to access these features and then Tap on the provided choices to make a selection.

Available choices will appear as shown below:
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5.1.6.1. Drawing Toolbar Options

The Drawing Toolbar, located on the left side of the screen, contains all available drawing tools for adding to

or manipulating the current drawing.

The Drawing Toolbar has an intuitive design where similar drawing tools collapse into groups when there is

not enough room on the screen to display them all individually.

To access these tools when collapsed, you will need to perform an Extended Press on the displayed drawing

tool in the toolbar and then Tap on the desired tool in the expanded selection menu.
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Click or Tap on the corresponding Drawing Toolbar item name to learn more about its functionality.

Icon Option Name Description

Selection Tool The Selection Tool is the chosen tool default within the

application each time a drawing is created or opened. It can be

used to pan the Drawing Canvas, zoom in or out, and for figure

selection.

Pan and Zoom

Tool

The Pan and Zoom Tool can be used to move the visible

portion of the drawing with a Touch/Drag gesture combination

for performing panning or zooming actions on an entire

drawing rather than moving the objects residing on the Drawing

Canvas.

Zoom Rectangle

Tool

The Zoom Rectangle Tool can be used to draw a rectangle

over a portion of the Drawing Canvas to specify a precise

zooming location. It provides finer control than the Pinch and

Zoom gesture when zooming in on specific figures within the

Drawing Canvas.

Free Form Tool The Free Form Tool is a gesture-recognizing tool that can be

used to draw freehand lines, circles, ovals, etc. It detects what is



Page 254

TouchDraw 2 for iOS

Icon Option Name Description

being drawn and automatically turns into the appropriate shape.

For lines between shapes, the Free Form Tool  will convert the

line into a connection line.

Line Tool The Line Tool can be used to draw straight lines.

Linear Dimension

Tool

The Linear Dimension Tool can be used to draw a linear

dimension line.

Horizontal

Distance

Dimension Tool

The Horizontal Distance Dimension Tool can be used to draw

a horizontal dimension line.

Vertical Distance

Dimension Tool

The Vertical Distance Dimension Tool can be used to draw a

vertical dimension line.

Callout Tool The Callout Tool can be used to draw a callout to a location in

the drawing.

Connection Tool The Connection Tool can be used to draw lines for connecting

one figure to another and makes it easy to create connected

graphs such as flow charts.

Polyline Tool The Polyline Tool can be used to draw line segments only and

works similar to the Path Tool. Dragging your finger on the

Drawing Canvas will result in line endpoints. A Double Tap

ends the current polyline creation. A Triple Tap will end the

creation of the current polyline and close it to create a closed

polygon.

Pen Tool The Pen Tool uses a technique called curve fitting to create a

smooth curve from a drawn freehand path.

Path Tool The Path Tool is the most powerful and complex tool available

within TouchDraw 2. It can be used to create complex curves

and shapes with detailed control on every aspect of the shapes
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Icon Option Name Description

appearance.

Elliptical Arc The Elliptical Arc Tool is used to create a shape consisting of

half of an ellipse.

Circular Arc The Circular Arc Tool creates a perfect circular arc where the

position, length, and angle increases in proportional increments

as the size of the shape increases.

Oval Tool The Oval Tool can be used to create ovals or circles within a

drawing.

Circle Tool The Circle Tool can be used to create a perfect circle where the

radius increases in increments as the size of the shape increases.

Rectangle Tool The Rectangle Tool can be used to create rectangles or squares

within a drawing.

Rounded

Rectangle Tool

The Rounded Rectangle Tool can be used to create rounded

rectangles or rounded squares within a drawing.

Squircle Tool The Squircle Tool can be used to create squircles within a

drawing.

Polygon Tool The Polygon Tool can be used to create regular polygons

within a drawing.

Star Tool The Star Tool can be used to create stars within a drawing.

Text Tool The Text Tool can be used to create a text area within a

drawing.
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5.1.6.2. Selection Tool

The Selection Tool is the chosen tool default within the application each time a drawing is created or opened.

The following described functions can be performed when this tool is selected.

Selecting Figures

The simplest and most common method for selecting objects is to perform a tap within bounds of a figure (for

ovals, rectangles, rounded rectangles, polygons, filled paths, text and images) or on a line (for lines and paths).

Handles are displayed as a visual indicator of successful figure selection.

Figures can also be selected by outlining an area within the grid. Touch and drag within the Drawing Canvas in

an area where there are no figures to draw a selection rectangle over all objects within a desired area in the

Drawing Canvas. All figures residing in or intersecting the defined area are automatically selected when the

drag action is completed.
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Single Selection

Using the methods above, without the Function Key Feature enabled, results in what TouchDraw 2 considers to

be single selection. By single selection, we mean that only the figure or figures selected within the enactment

of one gesture will be selected.

Multiple Selection

To select multiple figures in an individual manner by tapping (or dragging) multiple times, use the Function
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Key Feature  to tell TouchDraw 2 to enable multiple selection mode. Each tap (or drag) will add the figure as

part of the overall selection when not already selected or deselect the figure if it is already selected. This

application option allows you to have fine grained control over the selected figures.

Zooming

To zoom in on a drawing, put two fingers within the drawing panel and either pinch them to zoom out, or

spread your fingers to zoom in. Feedback regarding the exact zoom level is given at the top of the Drawing

Canvas as these gestures are performed.

Moving (Panning)

To move around in a drawing, put two fingers within the drawing panel and drag them around (without

pinching or expanding them). The current position of the drawing will track with the position of your fingers.

The ruler will also track these movements to provide feedback regarding the current location within the

drawing.
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5.1.6.3. Pan and Zoom Tool

The Pan and Zoom Tool allows the visible portion of the drawing to be moved with a Touch/Drag gesture

combination for performing panning or zooming actions on an entire drawing rather than moving the objects

residing on the Drawing Canvas.

Zoom Rectangle Tool

An additional Pan and Zoom option is made available when an extended Press is performed over the tool

button.
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The Zoom Rectangle Tool can be used to draw a rectangle over a portion of the Drawing Canvas to specify a

precise zooming location.
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5.1.6.4. Zoom Rectangle Tool

The Zoom Rectangle Tool selection can be used to draw a rectangle over a portion of the Drawing Canvas to

specify a precise zooming location. It provides finer control than the Pinch and Zoom gesture when zooming in

on specific figures within the Drawing Canvas.

This option is accessible when an extended Press is performed over the Pan and Zoom Tool. Press on the

Zoom Rectangle Tool and it will appear in place of the standard Selection Tool in the Drawing Toolbar.
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Touch, Hold, and Drag the rectangle over a desired area and then release this action to complete the selection.

In this example, the blue square and red circle are selected with the Zoom Rectangle Tool.

The Drawing Canvas will automatically zoom in on the figures within the selected area.
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5.1.6.5. Free Form Tool

The Free Form Tool is a gesture-recognizing tool that can be used to draw freehand lines, circles, ovals, etc.

Once you have started drawing, the tool will automatically detect what is being drawn and turn it into that

shape.

Note: For lines between shapes, the Free Form Tool will convert the line into a connection line automatically.

To use the Free Form Tool, complete the following steps:

Step 1: Press on the Free Form Tool within the Drawing Toolbar.



Page 266

TouchDraw 2 for iOS

Step 2: Begin to draw a shape or line by performing a Touch/Drag gesture combination within the Drawing

Canvas. Do not release the gesture until your freehand shape or line has been completed.

Step 3: Release the Touch/Drag action once you have finished drawing the shape or line. The application will

then complete the shape or line accordingly.
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5.1.6.6. Line Tool

The Line Tool can be selected to draw straight lines. Use a Touch/Drag gesture combination to draw the line

from a set starting point to a desired end point and then release the used finger to complete the drawing action.

Note: If the Function Key Feature is enabled during line creation, the line is constrained to increments of 90°.

 

Table of Contents

• Altering the Line Length and Angle

• Style as Dimension Line

• Orthogonal Dimensions Setting for Dimension Lines

• Text Location and Orientation

 

Altering the Line Length and Angle

The length and angle of a line can be altered any time after a line has been created. To alter the length or angle

of a line.

Step 1: Select the line within the Drawing Canvas.
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Step 2: Press on the Info Button in the Top Toolbar.

Step 3: The Line Length and Line Angle options are located toward the bottom of the Geometry Tab. Use the

"plus" or "minus" buttons to change either value or tap on the text entry field to key in a value.
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Step 4: When entering a value into the Line Length or Line Angle options, a different unit of measure other

than the default of Inches or Degrees can be entered. Enter the desired value and unit of measurement. For this

example, 2 cm has been entered.

Then press the Return Button on the keyboard or tap in another area of TouchDraw 2 and the entered value

will automatically be converted to its equivalent value in Inches.
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Step 5: The selected line and line length within the Geometry Tab will appear as shown below. For this

example, the entry of 2 cm has been converted to its equivalent in inches (0.787 in) and appears much shorter

than the original line figure.
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For example, the Line Length value could be 10 centimeters (10 cm) or 50 millimeters (50 mm) and the Line

Angle could be 5 radians (5 rad). Once the desired value and unit of measurement have been entered,

TouchDraw 2 will automatically convert it to the equivalent value in Inches or Degrees.

Example 1: Entering 10 cm for the Line Length

Example 2: Entering 50 mm for the Line Length
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Example 3: Entering 5 rad for the Line Angle
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Style As Dimension Line

The Style As Dimension Line option within the Contextual Menu may be used to add dimensional aspects to

an existing line figure.

When this option is used, TouchDraw 2 automatically adds arrowheads and a {Length} variable to the

selected line(s). At least one line must be selected in the Drawing Canvas for this option to appear within the

Contextual Menu. Follow the steps shown below to use this option:

Step 1:Select the line figure you would like to alter.
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Step 2: Then press and hold on the Drawing Canvas for ~1 second or use the Contextual Menu Button in the

Top Toolbar.
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Step 3: Tap on Style As Dimension Line and the selected line figure(s) will appear similar to the example

shown below:
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Orthogonal Dimensions Setting for Dimension Lines

The Orthogonal Dimensions setting can be enabled to automatically constrain dimension lines to be

orthogonal.

Complete the steps below to enable this option (if disabled):

Step 1: Press on the Settings icon within the Top Toolbar.

Step 2: Tap on Default Settings.
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Step 3: Tap on the Orthgonal Dimensions option toggle slider to enable. It will be blue when enabled.
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Step 4: After this setting has been enabled, use the Function Key Feature in combination with a Touch/Drag

action to constrain the Dimension Line orthogonally.
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Text Location and Orientation

Text can be added to a Line. The location and orientation of attached text can be altered for Line Figures within

the Text Tab.
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5.1.6.7. Linear Dimension Tool

The Linear Dimension Tool can be selected to draw a linear dimension line. Use a Touch/Drag gesture

combination to draw the linear dimension line from a set starting point to a desired end point and then release

the used finger to complete the drawing action.

How to Alter Dimension Line Size, Angle, and Position

To alter the length or angle of a linear dimension line, touch and drag using one of the connection handles on

each end of the dimension line.

Do not lift your finger until the end of the dimension line is in the desired location. In the example below, the



Page 283

TouchDraw 2 for iOS

right connnection point has been moved down and to the left.

Touch and Drag on the blue bounds handle to change the position of the dimension line between the

connection handles.
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Touch and Drag on the dimension line to change its position within the Drawing Canvas.

How to Alter the Arrowhead Locations

The arrowhead locations within a linear dimension line can be located on the inside or outside.

When located on the inside, a dimension line will appear as shown below. This is the default selection.
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To change the arrowhead location to the outside for a selected dimension line, press on the Modify Menu and

then tap on the Dimensions Submenu.

Next, tap on the Arrowhead Outside option to change the arrowhead location to outside. A checkmark will be

present for the currently enabled arrowhead option.
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The linear dimension line will appear as shown below when arrowheads are on the outside.

How to Connect a Linear Dimension Line to Figures

For this example, the Linear Dimension Line will be connected to two points within a simple garage floor

plan image. The image and Linear Dimension Line have already been added to the drawing, as shown below.
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Note: A linear dimension line can also connected to two points on a figure or two separate figures at the time it

is drawn.

Perform a Touch/Drag action on a connection handle within the dimension line to connect it to a point within a

figure.

For more control over the position of each end of the dimension line, disable the Snap to Grid and/or the Snap

to Lines options. The Function Key Feature can also be used for more control when moving each connection

handle.
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Perform this action again for the second connection handle within the dimension line.
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Note: A Linear Dimension Line can also be drawn between two points on any figure or from one point on a

figure to a point on another figure.

Using the Scale Attached... Option

The Linear Dimension Tool can be paired with the Scale Attached... option within the Modify Menu to scale

an image, such as a floor plan, to match the grid and trace or perform other actions within the drawing "at

scale".

For this example, a simple garage floor plan image will be used to demonstrate the Scale Attached… option.

The Linear Dimension Line has been connected to each end of the garage opening, as shown below.
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Step 1:Tap on the Linear Dimension Line to select it within the drawing.
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Step 2: Press on Modify Menu and then press on the Scale Attached... option.
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Step 4: Change the linear dimension line length by tapping on the Length field and using the keyboard to enter

a new value.

The "-" and "+" buttons can also be used to increase or decrease the Length value by 1. Once finished, press on

return within the keyboard.
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Step 5: Next, use the toggle sliders to enable or disable the Scale Proportional and Scale Attributes options

before scaling the image or figure.

• Scale Proportional - Scale the image up to match the grid based on the entered dimension line length.

• Scale Attributes - Scale the attributes (stroke, text, etc) based on the entered dimension line length.

Step 6: Once finished, press on Scale within the pop-up window.
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Note: If the Scale Attributes option is disabled, then Attributes will not be scaled.
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5.1.6.8. Horizontal Distance Dimension Tool

The Horizontal Distance Dimension Tool can be used to draw a horizontal distance dimension line. The

dimension line can be drawn between any two points on the grid or be connected to selected connection points

on figures within a drawing.

This tool can be selected by performing an extended Press on the Linear Dimension Tool button. Tap on the

tool to select it.

Use a Touch/Drag gesture combination to draw the horizontal dimension line from a set starting point to a

desired end point and then release the used finger to complete the drawing action.
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How to Alter Dimension Line Size and Position

To alter the length of a dimension line, perform a Touch/Drag action on one of the dimension line's connection

handles.

Do not lift your finger until the end of the dimension line is in the desired location.

In the example below, the right connection handle has been moved to the left to make the dimension line

smaller.
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Touch and Drag on the blue bounds handle to change the position of the dimension line.

Touch and Drag on the dimension line to change its position within the Drawing Canvas.
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How to Alter the Arrowhead Locations

The arrowhead locations within a horizontal distance dimension line can be located on the inside or outside.

When located on the inside, a horizontal distance dimension line will appear as shown below. This is the

default selection.

To change the arrowhead location to the outside for a selected dimension line, press on the Modify Menu and

then tap on the Dimensions Submenu.
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Next, tap on the Arrowhead Outside option to change the arrowhead location to outside. A checkmark will be

present for the currently enabled arrowhead option.

The horizontal distance dimension line will appear as shown below when arrowheads are on the outside.

How to Connect a Horizontal Distance Dimension Line to Figures
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A Horizontal Dimension Line can be connected to specific locations within an image and used to scale the

image. It can also be connected to points within one or more figures.

A garage floor plan image has already been added to the drawing for this example.

Next, a Horizontal Distance Dimension Line will be drawn along the garage opening.
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Perform a Touch/Drag action on a connection handle within the dimension line to connect it to a point within a

figure.

For more control over the position of each end of the dimension line, disable the Snap to Grid and/or Snap to

Lines options. The Function Key Feature can also be used for finer control when moving each connection

handle.
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Perform this action again for the second connection handle within the dimension line.



Page 303

TouchDraw 2 for iOS

Note: A Horizontal Distance Dimension Line an also be drawn between two points on any figure or from one

point on a figure to a point on another figure.

Using the Scale Attached... Option

The Horizontal Distance Dimension Tool can be paired with the Scale Attached... option within the Modify

Menu to scale an image, such as a floor plan, to match the grid and trace or perform other actions within the

drawing "at scale".

For this example, a simple garage floor plan will be used to demonstrate the Scale Attached… option. The

Horizontal Distance Dimension Line has been connected to each end of the rectangle.
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Tap on the Horizontal Distance Dimension Line to select it within the drawing.
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Press on Modify Menu and then press on the Scale Attached... option
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Change the horizontal distance dimension line length by tapping on the Length field and using the keyboard to

enter a new value.

The "-" and "+" buttons can also be used to increase or decrease the Length value by 1. Once finished, press on

return within the keyboard.

Next, use the toggle sliders to enable or disable the Scale Proportional and Scale Attributes options before

scaling the image or figure.

• Scale Proportional - Scale the image up to match the grid based on the entered dimension line length.

• Scale Attributes - Scale the attributes (stroke, text, etc) based on the entered dimension line length.

Once finished, press on Scale within the pop-up window.
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Note: If Scale Attributes has been disabled, the Attributes will not scale, only the image or figure.
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5.1.6.9. Vertical Distance Dimension Tool

The Vertical Distance Dimension Tool can be used to draw a vertical distance dimension line. The dimension

line can be drawn between any two points on the grid or be connected to selected connection points on figures

within a drawing.

This tool can be selected by performing an extended Press on the Linear Dimension Tool button. Tap on the

tool to select it.

Use a Touch/Drag gesture combination to draw the horizontal dimension line from a set starting point to a

desired end point and then release the used finger to complete the drawing action.
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How to Alter Dimension Line Size and Position

The length of a vertical distance dimension line can be altered any time after it has been created.

To alter the length of a dimension line, perform a Touch/Drag action on one of the dimension line's connection

handles.
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Do not lift your finger until the end of the dimension line is in the desired location.

In the example below, the right connection handles has been moved to the down to make the dimension line

larger.

Touch and Drag on the blue bounds handle to change the position of the dimension line.
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Touch and Drag on the dimension line to change its position within the Drawing Canvas.
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How to Alter the Arrowhead Locations

The arrowhead locations within a vertical distance dimension line can be located on the inside or outside.

When located on the inside, a vertical distance dimension line will appear as shown below. This is the default

selection.
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To change the arrowhead location to the outside for a selected dimension line, press on the Modify Menu and

then tap on the Dimensions Submenu.

Next, tap on the Arrowhead Outside option to change the arrowhead location to outside. A checkmark will be

present for the currently enabled arrowhead option.
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The vertical distance dimension line will appear as shown below when arrowheads are on the outside.

How to Connect a Vertical Distance Dimension Line to Figures

A Vertical Distance Dimension Line can be connected to any two locations within an image or figure. It can

also be connected to two separate figures in a drawing.

An image of a garage floor plan has already been added to the drawing for this example.



Page 315

TouchDraw 2 for iOS

Next, a Vertical Distance Dimension Line will be drawn on the right side of the garage floor plan image.
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Perform a Touch/Drag action on a connection handle within the dimension line to connect it to a point within a

figure.

For more control over the position of each end of the dimension line, disable the Snap to Grid and/or the Snap

to Lines options. The Function Key Feature can be used for finer control when moving each connection handle.
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Perform this action again for the second connection handle within the dimension line.
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Note: A Vertical Distance Dimension Line can also be drawn between two points on any figure or from one

point on a figure to a point on another figure.

Using the Scale Attached... Option

The Vertical Distance Dimension Tool can be paired with the Scale Attached... option within the Modify

Menu to scale an image, such as a floor plan, to match the grid and trace or perform other actions within the

drawing "at scale".

For this example, a Garage portion of a floor plan will be used to demonstrate the Scale Attached… option.

The Vertical Distance Dimension Line has been connected to the right side of the garage.
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Tap on the Vertical Distance Dimension Line to select it within the drawing.
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Press on Modify Menu and then press on the Scale Attached... option
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Change the vertical distance dimension line length by tapping on the Length field and using the keyboard to

enter a new value.

The "-" and "+" buttons can also be used to increase or decrease the Length value by 1. Once finished, press on

return within the keyboard.

Next, use the toggle sliders to enable or disable the Scale Proportional and Scale Attributes options before

scaling.

• Scale Proportional - Scale the image up to match the grid based on the entered dimension line length.

• Scale Attributes - Scale the attributes (stroke, text, etc) based on the entered dimension line length.

Once finished, press on Scale within the pop-up window.
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Note: If Scale Attributes has been disabled, then Attributes (text, stroke, etc.) will not scale according to the

entered length value.
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5.1.6.10. Callout Tool

The Callout Tool can be used to add a callout to any location within a drawing. A callout figure contains one

connection handle, two bounds handles, and default text.

The connection handle can be used to connect the callout to a figure and the bounds handles can be used to

alter the appearance of the callout.

This tool can be selected by performing an extended Press on the Linear Dimension Tool button. Tap on the

tool to select it.

Use a Touch/Drag gesture combination to draw the callout from a set starting point to a desired end point and

then release the used finger to complete the drawing action. The arrow will be where the action is completed.
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Using the Bounds Handles

A callout has two Bounds Handles (blue), which can be used to alter it's position and size.
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In this example, the bounds handle connecting the two lines will be moved to the left.

Using the Connection Handle

The Connection Handle can be used to alter where the callout figure points to within the drawing.
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Perform a Touch/Drag action to change the connection handle's position within the Drawing Canvas.

The connection handle can also be dragged to a specific connection point on a figure.

How to Change Callout Text

Perform a Double Tap on the default "Callout" text to alter the text for the figure.
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After double tapping, the Text Editor will appear as shown below.

Use the keyboard to enter different text for the callout figure. Once finished, Tap in any location outside of the

supplied popover or Press on the Done Button to dismiss the editor.
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The figure will appear as shown below:
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5.1.6.11. Connection Tool

The Connection Tool can be used to draw lines for connecting one figure to another and makes it easy to

create connected graphs such as flow charts.
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Creating a Line Connection Between Two Figures

Complete the following steps to add a line connection between 2 figures:

Step 1: Begin by creating two figures and then select the Connection Tool. All figures including path shapes,

text blocks, and images can be connected with the exception of lines and open paths.
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Note: The Connection Tool defaults to a straight line; however, additional options are available for using this

tool in TouchDraw 2. To learn how to change the connection type, please see Changing Connector Types.

Step 2: Touch (but do not lift your finger) within the first shape to be connected. The figure will be

"highlighted" with a light blue border that contains each available connection point will when the selection has

been performed correctly. A connection can be made between any of the displayed points within the start and

target figures.
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Step 3: Drag your finger from a point within the start figure to a displayed point within the end figure where

the connection will terminate.

When your finger is within the "target" figure, it will be "highlighted" with a light blue border that contains

each available connection point. The light blue border indicates the ability to connect the second figure to the

source figure.

Step 4: The connection line will be created between a point on the start figure and the chosen point within the

target figure when the Touch/Drag gesture combination is released.
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Note: After a connection line is created, perform a Touch/Drag combination on a connection handle to change

its position within the start or end figure.

Step 5: Performing a Touch/Drag gesture combination on the second figure after the connection is established

results in the connection line position being adapted to keep the two figures connected.
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Note: Once a shape has been connected, the handle may be dragged while using the Function Key Feature or

holding the Shift Key down on your keyboard and then moving the connection handle to any arbitrary point

within a shape. The handle will stay connected to that point.

Text Location and Orientation

Text can be added and attached to a Connection Line. The location and orientation of attached text can be

altered for Connection Lines within the Text Tab.
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Orthogonal Connectors Setting for Connection Lines

The Orthogonal Connectors setting can be enabled to automatically constrain connection lines to be

orthogonal.

Complete the steps below to enable this option (if disabled):

Step 1: Press on the Settings icon within the Top Toolbar.

Step 2: Tap on Default Settings.
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Step 3: Tap on the Orthgonal Connectors option toggle slider to enable. It will be blue when enabled.
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Step 4: After this setting has been enabled, use the Function Key Feature in combination with a Touch/Drag

action to constrain the Connection Line orthogonally.
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Additional Information

To learn more about using different connector types and the connection tool, please see the following pages:

• Changing Connector Types

• Line Connection Tool

• East-West Connection Tool

• North-South Connection Tool

• Horizontal-Vertical Connection Tool

• Vertical-Horizontal Connection Tool

• Path Connection Tool

• Hub Connection Tool

5.1.6.11.1. Changing Connector Types
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The Connector Type of a selected connection line can be changed prior to or after creating a connection line in

TouchDraw 2.

Follow the steps below to change the Connector Type:

Step 1: Press on the Info Button at the in the Top Toolbar.

Step 2: Then press on the Connections Tab to view each connector type. The currently selected type will be

highlighted in gray. Tap on the connector type you would like to use to make a selection.

Note: The Connector Type can also be changed in the Connection Type Overlay before drawing the

connection line when Overlay Mode is enabled.

To change the connector type for an existing connection line, complete the following steps:

Step 1: Select the connection line within the Drawing Canvas.
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Step 2: Follow the steps above to access available connector types and make a selection. In this example, a

North-South connection line is selected.
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Step 3: The connection line will automatically change and adapt based on the selected type, as shown below.

5.1.6.11.2. Line Connection Tool

The Line Connection Tool draws a line connection from a source figure and connects in the shortest way to a

target figure. The start, line, and end points of a connection line can be altered by pressing on the Info Button

in the Toolbar and then pressing on the Stroke Tab.
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To create a connection with this tool, complete the following steps:

Step 1: Select the Line Connection Tool in the Drawing Toolbar.

If a different connection tool is currently selected, you will need to select the Line Connection Type within the

Connections Tab before drawing the connection line. To learn more, please see the Changing Connector Types

Page.

Step 2: Perform a Touch/Drag gesture combination at the desired starting point on the source figure and move

the handle to a desired end point on the target figure.
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Step 3: Release the Touch action to complete the connection line. Each selected figure will be highlighted in

blue when a valid connection has been made.

Step 4: The connection line is created between the two figures when the Touch/Drag gesture combination is

released.
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Performing a Touch/Drag gesture combination on the second figure after the connection is established results

in the connection line position being adapted to keep the two figures connected.
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5.1.6.11.3. East-West Connection Tool

The East-West Connection Tool draws a connection line that originates from the side (either west/left or

east/right) of the source figure and connects to the side (either west/left or east/right) of the target figure.

To select the East-West Connection Tool, press on the Info Button in the Top Toolbar and then press on the

Connections Tab. Next, tap on the East-West Connector Type to select it.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

connection path remains orthogonal with the source and target lines remaining horizontal.
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Perform a Touch/Drag gesture combination from the desired starting point on a figure to the desired end point

on another figure and then release the Touch action to complete the connection.

The selected figures will be highlighted in blue when a valid connection has been made. Refer to the images

below:



Page 346

TouchDraw 2 for iOS

The completed connection line will appear as shown below.
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Performing a Touch/Drag gesture combination on the second figure after the connection is established results

in the connection line position being adapted to keep the two figures connected. The appearance of a created

orthogonal or elbow connection line varies based on the location of each figure and the amount of space

between the two connected figures.

The connection line will automatically contain a ninety degree angled corner. To change the connection line to

a more rounded corner, make certain it is selected, open the Info Menu, and then alter the Corner Size value.
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Changing the Corner Size to 1/2 an inch (0.50 in) for a selected connection line causes the corners to become

curved, as shown below.
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5.1.6.11.4. North-South Connection Tool

The North-South Connection Tool draws a connection line that originates from the side (either north/top or

south/bottom) of the source figure and connects to the side (either north/top or south/bottom) of the target

figure.
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To select the North-South Connection Tool, press on the Info Button in the Top Toolbar and then press on the

Connections Tab. Next, tap on the North-South Connector Type to select it.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

connection path remains orthogonal with the source and target lines remaining vertical.

Perform a Touch/Drag gesture combination from the desired starting point on the source figure to the desired

end point on the target figure and then release the Touch action to complete the connection.

The selected figures will be highlighted in blue when a valid connection has been made. Refer to the images
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below:
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The completed connection line will appear as shown below.
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Performing a Touch/Drag gesture combination on the second figure after the connection is established results

in the connection line position being adapted to keep the two figures connected. The appearance of a created

orthogonal or elbow connection line varies based on the location of each figure and the amount of space

between the two connected figures.

The connection line will automatically contain a ninety degree angled corner. To change the connection line to

a more rounded corner, make certain it is selected, open the Info Menu, and then alter the Corner Size value.



Page 354

TouchDraw 2 for iOS

Changing the Corner Size to 1/2 an inch (0.50 in) for a selected connection line causes the corners to become

curved, as shown below.
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5.1.6.11.5. Horizontal-Vertical Connection Tool

The Horizontal-Vertical Connection Tool draws a connection line that originates horizontally from the right

or left side of the source figure and connects vertically to the side (top) of the target figure.
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To select the Horizontal-Vertical Connection Tool, press on the Info Button in the Top Toolbar and then press

on the Connections Tab. Next, tap on the Horizontal-Vertical Connector Type to select it.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

connection path remains orthogonal with the source lines remaining horizontal and target lines remaining

vertical.

Perform a Touch/Drag gesture combination from the desired starting point on the source figure to a desired

end point on the target figure and then release the Touch action to complete the connection. The selected

figures will be highlighted in blue when a valid connection has been made. Refer to the images below:
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The completed connection line will appear as below.
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Performing a Touch/Drag gesture combination on the second figure after the connection is established results

in the connection line position being adapted to keep the two figures connected. The appearance of a created

orthogonal or elbow connection line varies based on the location of each figure and the amount of space

between the two connected figures.

The connection line will automatically contain a ninety degree angled corner. To change the connection line to

a more rounded corner, make certain it is selected, open the Info Menu, and then alter the Corner Size value.
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Changing the Corner Size to 1/2 an inch (0.50 in) for a selected connection line causes the corners to become

curved, as shown below.
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5.1.6.11.6. Vertical-Horizontal Connection Tool

The Vertical-Horizontal Connection Tool draws a connection line that originates vertically from the side

(either top or bottom) of the source figure and connects to the side (either left or right) of the target figure.
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To select the Vertical-Horizontal Connection Tool, press on the Info Button in the Top Toolbar and then press

on the Connections Tab. Next, tap on the Vertical-Horizontal Connector Type to select it.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

connection path remains orthogonal with the source lines remaining vertical and target lines remaining

horizontal.

Perform a Touch/Drag gesture combination from the desired starting point on the source figure to a desired

end point on the target figure and then release the Touch action to complete the connection.
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The selected figures will be highlighted in blue when a valid connection has been made. Refer to the images

below:
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The completed connection will appear as shown below.
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Performing a Touch/Drag gesture combination on the second figure after the connection is established results

in the connection line position being adapted to keep the two figures connected. The appearance of a created

orthogonal or elbow connection line varies based on the location of each figure and the amount of space

between the two connected figures.

The connection line will automatically contain a ninety degree angled corner. To change the connection line to

a more rounded corner, make certain it is selected, open the Info Menu, and then alter the Corner Size value.
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Changing the Corner Size to 1/2 an inch (0.50 in) for a selected connection line causes the corners to become

curved, as shown below.
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5.1.6.11.7. Path Connection Tool

The Path Connection Tool creates a path connection that connects two shapes. As with paths created with the

Path Tool, path connections can be manipulated to add additional line or curve segments.
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To select the Path Connection Tool, press on the Info Button in the Top Toolbar and then press on the

Connections Tab. Next, tap on the Path Connector Type to select it.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

created path can be modified just as items generated with the Path Tool. See the Handling Paths section of this

documentation to learn more.

Perform a Touch/Drag gesture combination from the desired starting point on the source figure to a desired

end point on target figure and then release the Touch action to complete the connection. The selected figures

will be highlighted in blue when a valid connection has been made. Refer to the images below:
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The completed connection will appear as shown below.
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Performing a Touch/Drag gesture combination on the second figure after the connection is established results

in the connection line position being adapted to keep the two figures connected.

Altering the Route of Path Connection Lines

Once the Path Connection Line has been added to the desired target figure from the selected source figure, it

can be manipulated in the same manner as a Path Figure. In this example, the connection line currently goes

through the middle rectangle.

To route the Path Connection Line around another figure, handles must be added to the connection line or it
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must be converted to a quadratic or cubic segment. These options can be accessed by performing an extended

Press  on the connection line to open the Contextual Menu .

To route the Path Connection Line around another figure, handles must be added to the connection line or it

must be converted to a quadratic or cubic segment. These options can be accessed by performing an extended

Press on the connection line to open the Contextual Menu

Several options will appear within the Contextual Menu for modifying the connection line and routing it

around a specific figure. Handles and/or curved segments can be added to alter the route of the connection line.
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Note: Please note that if you select Delete Segment without adding any additional handles or segments, then

the connection line will be completely removed from the drawing.

Example 1: Inserting Handles

Inserting handles and then dragging them to desired points in the Drawing Canvas is one method for altering

the route of a Path Connection Line. Follow the steps below to learn how to do so.
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Step 1: Perform an extended Press on the connection line in a location to the left of the crossed figure and

then select Insert Handle from the menu.

Step 2: A new Path Handle (Orange) will appear within the Path Connection Line as shown below:
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Step 3: Perform an extended Press on the connection line in a location to the right of the crossed figure and

then select Insert Handle from the menu again to add another Path Handle (Orange).

Step 4: Then press and drag down or up on the left handle to change the direction/path of the connection line.

Step 5: Notice that the line still intersects the figure. Press and drag on the right handle to continue altering the

direction/path of the connection line. This will result in the straight segment residing below the figure and a

successfully routed Path Connection Line.
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Please note that the handles may be moved in any direction; however, for this example both are moved down to

route the connection line around the figure.

Example 2: Segment to Quad

A Path Connection Line can also be routed differently by converting the line to a quadratic segment. This

example will use the same original figures as shown previously and will display how to convert the current

connection line to a quadratic segment for path routing.

Step 1: Perform an extended Press on the connection line and then select Segment to Quad from the menu.
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Step 2: A Control Point Handle (Green) will appear in the middle of the connection line.
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Step 3: Press and drag the handle downward (or upward) to create a curved segment. The Control Point

Handle may be moved in any direction; however, for this example, it is moved downward below the figure.

Example 3: Segment to Cubic

A Path Connection Line can also be routed differently by converting the line to a cubic segment. This

example will use the same original figures as shown previously and will display how to convert the current

connection line to a quadratic segment for path routing.
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Step 1: Perform an extended Press on the connection line and then select Segment to Cubic from the menu.
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Step 2: Two Control Point Handles (Green) will appear within the connection line.
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Step 3: Press and drag in any direction on the left handle to change the position of the Path Connection Line.

In this example, both handles are dragged downward.

Step 4: Then do the same for the right handle to finish routing the connection line around a figure within a

drawing.

5.1.6.11.8. Hub Connection Tool
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The Hub Connection Tool creates a connection line that is able to receive connections and is typically used

for creating network diagrams. The connection line can originate from any side of the source figure and

connects to any side of the target figure or to another hub connection line.

To select the Hub Connection Tool, press on the Info Button in the Top Toolbar and then press on the

Connections Tab. Next, tap on the Hub Connector Type to select it.

This connection between the figures is created in the same manner as with the Line Connection Tool; however,

the connection path can be placed between two hub connection lines to create a networking or alternative type

of diagram.

Perform a Touch/Drag gesture combination from the desired starting point on the source figure to the desired

end point on the target figure or hub connection line and then release the Touch action to complete the

connection.

The selected figures or hub connection lines will be highlighted in blue when a valid connection has been

made. Refer to the images below to see a hub connection between figures:
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The completed connection line will appear as below.
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The following example shows a hub connection line joining two previously drawn hub connection lines.
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Note: Performing a Touch/Drag gesture combination on the second figure after the connection is established

results in the connection line position being adapted to keep the two figures connected.
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5.1.6.12. Polyline Tool

The Polyline Tool can be used to draw line segments only and functions similar to the Path Tool. Dragging

your finger on the Drawing Canvas will result in line endpoints.

To use the tool, first Press on the Polyline Tool Button in the Drawing Toolbar to select it and then use the

actions listed below to create a polyline or closed polygon.

The following actions are available when using the Polyline Tool:

Action Description

Touch/Drag A Touch/Drag combination can be used to create a line end point and corresponding

control point in one action. When using a Touch/Drag gesture combination, do no

release your finger until the line has been created. After the line has been created,

additional gestures may be used to continue adding to the polyline figure.

Single Tap A Single Tap adds a line end point to the figure. The line endpoint can be then be

dragged to any desired location on the Drawing Canvas.

Double Tap A Double Tap action anywhere on the Drawing Canvas completes the current

polyline connection and causes the Selection Tool to be automatically chosen as the

active drawing tool.
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Action Description

Triple Tap A Triple Tap will end the creation of the current polyline and close it to create a

closed polygon.

The following screenshots and description shows how to use the polyline tool:

Step 1: Select the Polyline Tool in the Drawing Toolbar.

Step 2: Perform a Single Tap on the Drawing Canvas at the location where the starting point should be

established for the polyline. A gray handle will appear in this specific location to signify the starting point of

the polyline.
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Step 3: Then Tap on the Drawing Canvas at the location where the second line end point should be for the

polyline. This action draws a line between these two set points. It also creates a second gray handle at the point

where the first segment ends and the second one begins.
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Step 4: Tap on the Drawing Canvas at the location where the third line end point should be for the polyline. As

before, the action will cause a line to be drawn from the last point to the newest point and add a gray handle to

the drawing.
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Step 5: Tap on the Drawing Canvas at the location where the fourth line end point should be. The same end

results are provided as previously discussed for this additional line segment.

Step 6: Tap on the Drawing Canvas at the location where the fifth line end point should be. The same end

results are provided as previously discussed for this additional line segment.
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Step 7: Then perform a Double or Triple Tap within the Drawing Canvas to finish the polyline. You may also

tap on the Selection Tool to finish the polyline.

Note: A Triple Tap on the start point of the figure results in a closed polygon as illustrated in the screenshot

below.
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5.1.6.13. Pen Tool

The Pen Tool uses a technique called curve fitting to create a smooth curve from a freehand path that is drawn

by using a Touch/Drag gesture combination to drag the tool to desired points on the Drawing Canvas.

To use the tool, simply select it, and then draw a freehand path by using a Touch/Drag gesture combination to

maneuver the pen. The Pen Tool converts the drawn path into a smooth curve once the drag gesture is released.

The following figure illustrates what a curve looks like when drawn by hand, and then what it looks like after

the Pen Tool has created the curve.
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Please note that if the Curve Smoothing option is disabled in the Drawing Editor Submenu, then the figure

created with the Pen Tool will appear similar to what is shown below:

Note: The Pen Tool can create shapes instead of paths by using the Function Key Feature in conjunction with

the pen tool. If the function key feature is enabled when finishing the drawing of a shape (path) by releasing

your finger, a closed shape will be created as opposed to an open path.
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5.1.6.14. Path Tool

The Path Tool is the most powerful and complex tool available within TouchDraw 2. It can be used to create

complex curves and shapes with detailed control on every aspect of the shapes appearance. Paths created with

this tool are made up of many segments and three different types of line segments are possible:

• Straight Lines

• Quadratic Curves (lines with 1 control point)

• Cubic Curves (lines with 2 control points)

It's also important to understand that, like the Pen Tool, the Path Tool can be used to create both paths and

shapes. The Path selection is different from the pen selection in that a continuous line is not drawn. The used

finger will need to be lifted to create each path segment of a line or shape and this is accomplished by using

one of two available gestures depending on whether or not the end result should be a path or shape.

Use a Single Tap to add each line end point or a Touch/Drag gesture combination to add a line end point and

a corresponding control point in one action.
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To Create a Path, double tap on the Drawing Canvas or choose another drawing tool when the path is

complete.
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To Create a Shape, tap on the first (start) handle (the orange handle with a white dot) to manually complete a

shape or perform a Triple Tap on the Drawing Canvas for the Path Tool to automatically draw a line from the

current position to the start position to close the path. The Triple Tap method eliminates the need to draw a

point to intersect with the starting point.
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Path Tool Actions

A control point is displayed in gray when it has not been used and is referred to as a "phantom" control point.

This characteristic provides a hint to the TouchDraw 2 application that it should function as a control point in

scenarios where the next drawn segment is a curve.

A few basic actions can be used to alter the type of created segment, curve positioning, and "phantom" control

point position as a path is being created. Refer to the table below to learn more about each available action.

Action Description

Touch/Drag A Touch/Drag combination can be use to create a curve segment and allows the

"phantom" control point to be dragged to a any Drawing Canvas position to generate a

desired curve segment.

Single Tap A Single Tap adds a line or curve segment depending on the actions taken during

initial path creation. For example, tapping on two points within the Drawing Canvas
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Action Description

after selecting the path tool causes a straight line segment; however, an initial

Touch/Drag  combination creates a curve segment. An additional curve segment

(based on the "phantom" control point position) is created when a Single Tap  action

is performed in this scenario.

Double Tap A Double Tap action anywhere on the Drawing Canvas completes the path and

causes the Selection Tool to be automatically chosen as the active drawing tool.

Triple Tap A Triple Tap on the start handle (the orange handle with a white dot) or anywhere

within the Drawing Canvas directs TouchDraw 2 to automatically draw a line from

the current position to the start position and closes the path. The Triple Tap method

eliminates the need to draw a point to intersect with the starting point.

Function Key

Feature/Tap

Enabling the Function Key Feature and using it in combination with a Tap when

adding the next path segment alerts TouchDraw 2 to ignore the "phantom" control

point and creates a straight line segment.

Option Key

Feature/Tap

Enabling the Option Key Feature and using it in combination with a Tap allows the

"phantom" control point position to be set to a desired location on the Drawing

Canvas after a Touch/Drag combination has been performed to create a curve

segment.

Option Key

Feature/Touch/Drag

Enabling the Option Key Feature and using it in combination with a Touch/Drag

gesture combination allows the "phantom" control point to be dragged to any point on

the Drawing Canvas and changes a corner point back to a smooth curve after the

initial Touch/Drag action has ben completed for creating the curve segment.

 

Text Location and Orientation

Text can be added and attached to a Path Figure. The location and orientation of attached text can be altered for

Path Figures within the Text Tab.



Page 399

TouchDraw 2 for iOS

5.1.6.14.1. Adding Straight Line Segments

To create a Straight Line Segment, perform a single tap (do not drag) at the starting point and then again at

the corresponding line end point. For example, the objective of drawing a parallelogram could be accomplished

with the Path Tool.

The following screenshots and description outlines the steps required for creating a parallelogram with this tool.

Step 1: Select the Path Tool in the Drawing Toolbar.
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Step 2: Tap on the Drawing Canvas at the location where the starting point should be established for the path.

An orange handle with a white dot will appear in this specific location to signify the starting point of the path.

Step 3: Tap on the Drawing Canvas at the location where the second corner of the parallelogram will be. This

action draws a line between these two set points. It also creates a second handle (orange with no dot) at the

point where the first segment ends and the second one begins.
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Step 4: Tap on the Drawing Canvas at the location where the third corner of the parallelogram should be. As

before, the action will cause a line to be drawn from the last point to the newest point and add an orange handle

to the drawing.
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Step 5: Tap on the Drawing Canvas at the location where the fourth corner should be. The same end results are

provided as previously discussed for this additional line segment.
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Step 6: Two different options are available for automatically drawing the last line to connect the first point to

the last (i.e. closing a path)

The first option involves performing a Tap on the start point (orange handle with white dot). The second option

involves performing a Triple Tap anywhere within the Drawing Canvas. The second choice closes the shape

and exits the path tool when Sticky Mode is not enabled.

Once a path has been created and selected, a few handles will be seen in addition to the path point handles

created in the steps above. The blue handles are "bounds handles" that allow for shape resizing with a dragging

action. The red handle is a "rotation" handle, which allows for shape rotation around it's center point.
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A Double Tap in the Drawing Canvas results in a path as illustrated in the screenshot below.

5.1.6.14.2. Adding Quadratic Curve Segments



Page 405

TouchDraw 2 for iOS

A Quadratic Curve is a line segment with two end points and a control point that determines the exact curve

to be drawn. The figure below illustrates an example of a quadratic curve.

Two core gestures are used when creating path segments. A Single Tap adds an end point and a Touch/Drag

gesture combination adds an end point with a corresponding control point. Since a Quadratic Curve contains

two end points and one control point, the above mentioned core gestures provide two ways to create this type

of path:

• Performing a Single Tap and then a Touch/Drag combination.

• Performing a Touch/Drag combination and then a Single Tap.

For example, the Path Tool can be used to draw a shape resembling the fireplace below by combining 3 line

segments and one quadratic curve segment.

The following instructions outline the process we would take to do this.

Step 1: Select the Path Tool in the Drawing Toolbar.
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Step 2: Touch (but do not release) on the Drawing Canvas at the location where the starting point for the path

should be established. Any of the corner points could be a starting point for creating this shape; however, the

upper left corner point is the starting location for this tutorial. Next, drag the segment to the established control

point location without releasing the Touch action.

TouchDraw 2 will draw a lashed line from the start point to the control point while the dragging action is

performed and then show a slightly transparent circle in the control point location upon completion.
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A control point is displayed in gray when it has not been used and is referred to as a "phantom" control point.

This characteristic provides a hint to the TouchDraw 2 application that it should function as a control point in

scenarios where the next drawn segment is a curve. The control point is ignored when a Straight Line Segment

is added.

Step 3: Next, tap on the Drawing Canvas location where the second corner of the path should be (the upper

right hand corner). This action creates a quadratic curve between the two end points, with the added control

point functioning as an indicator to TouchDraw 2 as to how to draw the curve.

The handles for curve control points are green. The color and look of the control points are an indicator of how

they relate to the selected shape. Refer to the Handles Reference page to learn about the types of handles.

Step 4: Next, tap on the drawing in the location where the third corner of the path should be. As in the previous

examples, it will have drawn a line from the last created point to the new point.
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Step 5: Next, tap on the drawing in a the location where the fourth corner should be. Again, the same results

are provided as before.
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Step 6: To close the shape, either Tap on the start point (the orange handle with a white dot in it) or Triple Tap

 anywhere within the Drawing Canvas. This action closes the shape and exits the path tool (assuming Sticky

Mode has not been enabled).
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In addition to the approach above, the same figure can be drawn performing these actions in a slightly different

order, as shown below:

Step 1: Tap in the upper left hand corner to create the first point of the curved portion of the fireplace.
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Step 2: Perform a Touch/Drag gesture combination at the location where the ending point of the curve

segment should be. Drag the "phantom" control point outward to the right and bottom until the desired curve

has been created.
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Performing an Option/Tap gesture combination on any location in the Drawing Canvas alters the position of

the "phantom" control point to the selected location. Refer to the Path Tool section to learn more about this

action.

Step 3: Add a line to the next corner in the shape by tapping where the next end point should be located.

Obviously, this is not the desired result. If a "phantom" control point exists and a Tap is performed on the

drawing, TouchDraw 2 will use this control point to create a quadratic curve segment.

In this case, the "phantom" control point should be ignored and discarded to draw a straight line segment from

the last end point to the new end point. Tap on the Undo Button located in the Top Toolbar to remove this

segment addition.
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To draw a straight line from the last end point to the new end point, enable the Function Key Feature and tap on

the next end point location in the Drawing Canvas. This action instructs TouchDraw 2 to ignore the "phantom"

control point and to draw a straight line.

Step 4: Tap on the next corner end point to create the bottom of the fireplace.
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Step 5: To close the shape, either Tap on the start point (the orange handle with a white dot in it) or Triple Tap

 anywhere within the Drawing Canvas. This action closes the shape and exits the path tool (assuming Sticky

Mode has not been enabled).
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5.1.6.14.3. Adding Cubic Curve Segments

A Cubic Curve is a line segment with two end points and two control points that determine the exact curve to

be drawn. The image below illustrates an example of a cubic curve.
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Two core gestures are available when creating path segments. A Single Tap will add just an end point and

Touch/Drag gesture combination will add an end point with a corresponding control point.

Since a cubic curve contains two end points and two control points, a cubic curve can only be added by

performing a Touch/Drag gesture combination at one point and then by performing a Touch/Drag gesture

combination at another point.

For example, complete the following steps to draw a path like the one displayed in the example above:

Step 1: Select the Path Tool in the Drawing Toolbar.

Step 2: Touch on a desired starting point on the Drawing Canvas and drag to another location to establish the

first control point. The orange handle with the white dot signifies the starting point of the path. The gray circle

or "phantom" control point will turn into a control point when a curve segment is drawn.
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Note: A control point is displayed in gray when it has not been used and is referred to as a "phantom" control

point. This characteristic provides a hint to the TouchDraw 2 application that it should function as a control

point in scenarios where the next drawn segment is a curve. The control point is ignored when a Straight Line

Segment is added.

Step 3: Next, touch on the point within the Drawing Canvas where the segment end point will be and then drag

the "phantom" control point outward toward the right and bottom of the Drawing Canvas to create the desired

curve. A real control point will be placed exactly opposite (relative to the endpoint) from the current location of

the "phantom" control point.
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Note: Performing an Option/Tap combination on any location within the Drawing Canvas alters the position

of the "phantom" control point to the selected location. Refer to the Path Tool section to learn more about this

action.

Step 4: Since a path is being created rather than a shape, a Double Tap must be performed on the Drawing

Canvas to inform TouchDraw 2 of the completed path.
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The next step is to create a shape like the one shown below.

Step 1: Select the Path Tool in the Drawing Toolbar.
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Step 2: Repeat the steps above to create curve on the bottom of the shape as shown below.
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Step 3: Next, draw the edge on the right hand side of the shape. If a control point exists and a Tap is completed

to add a single endpoint, TouchDraw 2 will use the "phantom" control point to create a curve.

Enable the Function Key Feature by touching and holding in the empty section of the Drawing Toolbar for ~1

second until it turns red while performing the Tap gesture on the end point location to inform TouchDraw 2

that a straight line should be added. The following screenshot illustrates what happens when the Function Key

Feature is not used:

The following screenshot illustrates what happens when the Function Key Feature is enabled as the Tap is

completed.
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Step  4: Next, Tap in the upper left hand corner where the next end point should be.
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Step 5: Finally, to close the path and to create a shape, either Tap on the start point (the orange handle with a

white dot) or Triple Tap in the Drawing Canvas.
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Step 6: To set the color, Press on the Fill Button located in the Drawing Toolbar and choose light blue. Refer

to the Handling Colors portion of the documentation to learn more about using colors.
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5.1.6.15. Elliptical arc Tool

The Elliptical Arc Tool is used to create a shape consisting of half of an ellipse. To use the tool, simply select

it in the Drawing Toolbar.

Then perform a Touch/Drag gesture combination at the point in the Drawing Canvas where one of the

bounding corners of the elliptical arc should be. Then drag in any direction and release the Touch action where

the other bounding corner should be.



Page 426

TouchDraw 2 for iOS

Note: In the example above, the Touch/Drag action began at 3,1 and then dragged up and to the right to 1,3 on

the Drawing Canvas.

For smaller devices, certain tools within the Drawing Toolbar collapse to form selectable menues. The

Elliptical arc Tool may be combined with the Circular arc Tool The menu can be expanded by performing an

Extended Press over the tool button.
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Note: For small phones such as the iPhone, the menus may be collapsed further, as shown below. This tool can

be found by performing an extended press on the Oval Tool Button.
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5.1.6.16. Circular Arc Tool

The Circular Arc Tool creates a perfect circular arc where the position, length, and angle increases in

proportional increments as the size of the shape increases. To use this tool, Press on the Circular Arc Tool

within the Drawing Toolbar.

A circular arc will appear similar to what is shown below:
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Touch on the point in the Drawing Canvas where the arc point of the circular arc should be and the Drag

outward without lifting the used finger until the circular arc consists of a desired length, angle, and size.

Release the Touch action to complete the circular arc. The x, y, length, and angle values will increase as the

size of the circular arc increases. Refer to the images below:
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The Circular arc Tool may not appear by itself within the Drawing Toolbar on smaller iOS devices. This is

because the toolbar has been designed to intuitively adjust based on screen size and collapse similar tools

together on smaller devices.

If tools have been placed in a selectable menu with the Drawing Toolbar, you will see a right facing arrow in

the bottom right corner of the tool button.

If the tool does not appear within the Drawing Toolbar, you will need to perform one of the following actions

based on screen size:
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1. Perform an Extended Press on the Elliptical arc Button within the Drawing Toolbar and then select the
Circular arc Tool.

2. Perform an Extended Press on the Oval Button within the Drawing Toolbar and then select the
Circular arc Tool.
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5.1.6.17. Oval Tool

The Oval Tool is used to create ovals or circles within a drawing. To use the tool, simply select it and then

perform a Touch/Drag gesture combination at the point in the Drawing Canvas where one of the bounding

corners of the oval or circle should be. Drag in any direction and release the Touch action where the other

bounding corner should be.

Using the Oval Tool in conjunction with the Function Key Feature allows for the creation of perfect circles by

constraining the width and the height of the created object to equal values.
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Note: An oval can also contain text. See the Handling Text section for additional details.
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5.1.6.18. Circle Tool

This Circle Tool creates a perfect circle where the radius increases in increments as the size of the shape

increases.

To use the tool, simply select it and then perform a Touch/Drag gesture combination at the point in the

Drawing Canvas where the center of the circle should be.

Touch on the point in the Drawing Canvas where the center of the circle should be and Drag outward without

lifting the used finger until the circle consists of a desired radius or size. Release the Touch action to complete

the circle. The radius and angle values will increase as the size of the circle increases. Refer to the images

below:
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Altering a Circle's Radius

The radius of a circle can be altered any time after it has been created. To change the radius of a circle,

complete these steps:

Step 1:Select the circle to be altered.
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Step 2: Press on the Info Button in the Top Toolbar to open the Info Menu.

Step 3: On the Geometry Tab, use the Radius Control to set the radius of a circle. Tap on the "plus" or

"minus" buttons to change the value or press on the text entry field to bring up a keypad for entering the value

by hand.
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Step 4: When typing in a Radius value, a different unit of measure (i.e. points, pixels, millimeters, centimeters,

inches, feet, meters, etc.) other than the default of Inches can be entered for the dimensional attribute. Enter the

desired value and unit of measurement. For this example, 5 cm has been entered.
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Then press the Return Button on the keyboard or tap in another area of TouchDraw 2 and the entered value

will automatically be converted to its equivalent value in Inches.
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Example 1: Entering 1 cm for the Radius

If 1 centimeter (1 cm) is entered for the Radius, then it will be converted to 0.394 inches.

Example 2: Entering 15 mm for the Radius

15 millimeters (15 mm) is entered for the Radius and is converted to 0.591 inches.
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Example 3: Entering 100 pixels for the Radius

If you enter 100 pixels (100 px), then the value would be 1.389 inches.
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5.1.6.19. Rectangle Tool

The Rectangle Tool can be used to create rectangles or squares within a drawing. To use the tool, simply select

it and then use a Touch/Drag gesture combination at the point in the Drawing Canvas where one of the

bounding corners of the rectangle or square should be. Then drag in any direction and release the Touch action

where the other bounding corner should reside on the Drawing Canvas.

Using the Rectangle Tool in conjunction with the Function Key Feature allows for the creation of perfect

squares by constraining the width and the height of the created object to equal values. In the example below, a

square that is 2 inches in height and width has been created:
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Note: A rectangle can also contain text. See the Handling Text section for additional details.
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5.1.6.20. Rounded Rectangle Tool

The Rounded Rectangle Tool can be used to create rounded rectangles or rounded squares within a drawing.

To use the tool, simply select it and use a Touch/Drag gesture combination at the point in the Drawing Canvas

where one of the bounding corners of the rounded rectangle or square should be. Then drag in any direction

and release the Touch action where the other bounding corner should reside on the Drawing Canvas.

Use the Rounded Rectangle Tool in conjunction with the Function Key Feature to create perfectly rounded

squares.

Having the Function Key Feature activated while creating a rounded rectangle constrains the width and the

height to equal values. In the example below, a rounded square that is 2 inches in height and width has been

created:
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Note: A rounded rectangle can also contain text. See Handling Text for further details.

The size of rounded corners can be specified prior to drawing the shape or altered any time after it has been

created. To set the corner size after creating a shape, complete the following steps:

Step 1:Select a rounded rectangle.
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Step 2: Press on the Info Button in the Top Toolbar to open the Info Menu.

Step 3: Use the Rounded Corners Control to set the size. Tap on the "plus" or "minus" buttons to change the

value or tap on the text entry field to bring up a keyboard for entering the value by hand.
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Step 4: In the example below, the corner size has been changed to 1 inch:
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When keying in a Corner Size value, another unit of measurement (i.e. pixels, points, millimeters, centimeters,

inches, feet, etc.) can be entered and will be converted into its equivalent measurement in Inches.

Enter the number value and the abbreviation for the desired unit of measurement. The number value will be

converted to Inches after pressing on the Return Button or selecting another item in TouchDraw 2.
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Example 1: A value of 100 centimeters (100 cm) is entered for the corner size and converted to 39.37 inches.

Example 2: A value of 10 millimeters (10 mm) is entered for the corner size and converted to 0.394 inches.
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Example 3: A value of 25 pixels (25 px) is entered for the corner size and converted to 0.347 inches.
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Note: This measurement can also be altered before creating a shape by pressing on the Info Button, selecting

the Geometry Tab, and then changing the Corner Size setting.
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5.1.6.21. Squircle Tool

The Squircle Tool can be used to create a squircle figure within a drawing. To use the tool, simply select it and

then use a Touch/Drag gesture combination at the point in the Drawing Canvas where one of the bounding

corners of the squircle should be. Then drag in any direction and release the Touch action where the other

bounding corner should reside on the Drawing Canvas.

Having the Function Key Feature activated while creating a squircle constrains the width and the height to

equal values. In the example below, a squircle that is 2 inches in height and width has been created:
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The corner size of a squircle can be specified prior to drawing the shape or altered any time after it has been

created. To set the corner size after creating a shape, complete the following steps:

Step 1:Select a squircle within the drawing.

Step 2: Press on the Info Button in the Top Toolbar to open the Info Menu.
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Step 3: Use the Corner Size attribute to set the size. Tap on the "plus" or "minus" buttons to change the value

or tap on the text entry field to bring up a keyboard for entering the value by hand.

Step 4: In the example below, the corner size has been changed to 0.75 inch:
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Note: A squircle can also contain text. See the Handling Text section for additional details.
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5.1.6.22. Polygon Tool

The Polygon Tool can be used to create regular polygons within a drawing. To use the tool, simply select it

and then use a Touch/Drag gesture combination at the point in the Drawing Canvas where the center of the

polygon will be. Then drag in any direction and release the Touch action where one of the outer points of the

polygon should reside on the Drawing Canvas.

The number of polygon sides can be specified prior to drawing the shape, during creation, or altered any time

after it has been created. To set the number of sides before or after creating a shape, complete the following

steps:

Step 1:Select the polygon to be altered.



Page 457

TouchDraw 2 for iOS

Step 2: Press on the Info Button in the Top Toolbar to open the Info Menu.

Step 3: Use the Polygons Control to set the number of sides. Tap on the "plus" or "minus" buttons to change

the value or tap on the text entry field to bring up a keyboard for entering the value by hand.
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Step 4: In the example below, the value has been changed to 8.
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Note: The number of sides can also be altered before creating the shape by pressing on the Info Button,

selecting the Geometry Tab, and then changing the Corner Size setting. A polygon can also contain text. See

Handling Text for further details.
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5.1.6.23. Star Tool

The Star Tool can be used to create stars within a drawing. Tap on the Star Tool to select it within the

Drawing Toolbar.

Touch on the point in the Drawing Canvas where the center of the star should be and Drag outward without

lifting the used finger until the star consists of a desired radius, angle, and size.

Release the Touch action to complete the star. The radius and angle values will increase as the size of the star

increases, as shown in the images below.
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The number of star points can be specified prior to drawing the shape or altered any time after it has been

created. To set the number of points, complete the following steps:

Step 1:Select the star to be altered.
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Step 2: Press on the Info Button located in the Top Toolbar to open the Info Menu.

Step 3: Use the Points Control to set the number of point for a star. Tap on the "plus" or "minus" buttons to

change the value or press on the text entry field to bring up a keypad for entering the value by hand.
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Step 4: In the example below, the value has been changed to 8.
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Note: The number of points can also be altered before creating the shape by pressing on the Info Button,

selecting the Geometry Tab, and then changing the # of Points setting. A star can also contain text. See

Handling Text for further details.



Page 465

TouchDraw 2 for iOS

5.1.6.24. Text Tool

The Text Tool can be used to create a text area within a drawing. To use this tool, simply select it and perform

a Touch/Drag gesture combination at the point in the Drawing Canvas where one of the bounding corners of

the text area should be. Then drag in any direction and release the Touch action where the other bounding

corner to should be located.

After a text area has been added, the image shown below containing the default text Double tap to edit text

will appear.

Double Tapping on the figure causes a text editor to appear for entry.
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Entered text is reflected in the drawing view to provide instant feedback as to how the completed text will look,

wrap, etc...

The text figure is different from all other types of figures because it only shows text. It cannot have a border

(stroke) or be filled; however, displayed text can include a shadow.
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Adding Text To Figures

To add text to the inside of a of rectangle with a border, a circle, or a rounded rectangle, complete the following

steps:

Step 1: Use one of the Drawing Tools to create a figure.
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Step 2: Double Tap on the desired figure and the editor shown above will open.

Step 3: Enter text and then tap on the figure area or press Done in the upper right hand corner to close the

editor.

Step 4: The text will appear as shown below once the editor has been closed.
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Info: For more information on how to change the font, text size, text color and alignment, see the Handling

Text section.

Note: To simplify things, the text tool also supports adding a text area by simply tapping (without dragging) in

the drawing area.

Text Location and Orientation

Text can be added to a Line or Path Figure. The location and orientation of attached text can be altered within

the Text Tab.
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5.1.6.25. Function Key Feature

The left toolbar also works as a Function Key and is similar to a control click (Windows) or an option click

(Macintosh). When this feature is used, it acts as an indicator to the tools that they should behave in a different

manner than they normally would. For example, the Function Key Feature can be used to enable multiple

selection within the Drawing Canvas or to constrain the proportions of a figure as it is resized with one of the

handles.

This functionality can be enabled by holding and pressing on the lower half of the Drawing Toolbar where no

tools are present. After approximately 1 second, the toolbar will turn red as an indication of the Function Key

Feature being enabled. It will remain enabled as long as the utilized finger/thumb remains held on the toolbar.

The standard light gray toolbar will reappear as a visual indicator of the function key being disabled when the

finger is released.
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Function Button

The Function Button may also be used to lock the Function Key Feature. It can be helpful for maintaining the

aspect ratio of multiple figures during resizing without having to hold down the toolbar. It is also a useful

option for enabling the one handed operation of TouchDraw 2.

Press on the Function Button located at the bottom of the Drawing Toolbar to lock the Function Key

Feature.

When enabled, the Drawing Toolbar will appear red and the Function Button will appear blue. It will remain

enabled until the Function Button is pressed again.
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How to Enable the Function Button

If the Function Button is not present on the Drawing Toolbar, then it is disabled within the Drawing Editor.

To enable this option, complete the steps below:

Step 1: Press on the Settings Button in the Top Toolbar.

Step 2: Press on the Drawing Editor Submenu.
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Step 3: Then tap on the Function Button On/Off Toggle Slider. It will appear with a blue background when

enabled.



Page 475

TouchDraw 2 for iOS

Note: The Function Button will appear in the bottom of the Drawing Toolbar when enabled.
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5.1.6.26. Option Key Feature

The left toolbar also works as a Option Key and is similar to a control click (Windows) or an option click

(Macintosh). When this feature is used, it acts as an indicator to the tools that they should behave in a different

manner than they normally would.

For example, the option key feature can be used to alter the "phantom" control point position within the

Drawing Canvas for a Path or to change a corner point back to a smooth curve after a curve segment has been

created with the Path Tool.

To enable this functionality, Double Tap and Hold on the lower half of the Drawing Toolbar where no tools

are present. After approximately 1 second, the toolbar will turn blue as an indication of the option key feature

being enabled. It will remain enabled as long as the utilized finger/thumb remains held on the toolbar.

The standard light gray toolbar will reappear as a visual indicator of the option key feature being disabled

when the finger is released.
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Option Key Feature/Tap

An Option/Tap combination allows the "phantom" control point position to be set to a desired location on the

Drawing Canvas after a Touch/Drag combination has been performed to create a curve segment. Double Tap

and Hold on the empty portion of the Drawing Toolbar to activate this gesture combination. The following

image shows the "phantom control point at the 3,5 position:
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An Option/Tap combination is completed at the 4,1 position causing the "phantom" control point to be moved

to this location on the Drawing Canvas. Refer to the image below:
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Option Key Feature/Touch/Drag

An Option/Touch/Drag gesture combination allows the "phantom" control point to be dragged to any point on

the Drawing Canvas and changes a corner point back to a smooth curve after the initial Touch/Drag action has

ben completed for creating the curve segment.

This gesture combination is made possible by performing a Double Tap and Hold on the empty portion of the

Drawing Toolbar as discussed above.



Page 480

TouchDraw 2 for iOS

5.1.6.27. Easy Drag Mode

By default, TouchDraw 2 selects multiple shapes as a group. Figures selected as a group can be dragged

together when performing a Touch/Drag combination on one of the figures. The classic selection mode allows

each figure to be selected individually and to have their own handles available when selected. Each are shown

below:
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TouchDraw 2 includes an Easy Drag Mode that makes it simpler to move and select figures without having to

worry about touching one of the handles (which could lead to an unwanted resize). This is also particularly

useful when trying to move a small object, without having to zoom way in.

The following figure shows how a group of selected figures will look when Easy Drag Mode is enabled:

This option can be enabled in one of the following ways:

Method 1: Press on the View Menu in the Top Toolbar.



Page 482

TouchDraw 2 for iOS

Then tap on the Easy Drag Mode toggle. The toggle will appear with a blue background when this option is

enabled.

Method 2: Perform an upward or downward vertical swipe in the blank area of the Drawing Toolbar.
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5.2. Editing Drawings
The options for Editing Drawings in TouchDraw 2 are designed to make working with figures, lines, paths,

and handles easier. The following pages explain how to perform drawing editing operations.

• Editing Basics

• Using the Clipboard

• Inserting Images into Drawings

• Handling Figures

• Arranging Figures

• Aligning Figures

• Snapping Figures

• Ordering Figures

• Distributing Figures

• Combining Shapes

• Handling Colors

• Handling Strokes

• Handling Text

• Handling Paths

• Handling Layers

• Handling Stencil Libraries

• Calculations
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5.2.1. Editing Basics

The options for Editing Drawings in TouchDraw 2 are designed to make working with figures, lines, paths,

and handles easier. The following pages explain how to perform drawing editing operations.

• Selecting a Figure

• Deleting a Figure

• Saving a Drawing

• Printing a Drawing
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5.2.1.1. Selecting a Figure

TouchDraw 2 contains five types of figures:

• Lines (including open paths)

• Shapes (including closed paths)

• Text

• Images

• Stencils and Groups (compound figures)

For the purposes of selecting a figure, there are really only two types: Lines and Shapes.

Images, text figures, and compound figures all behave like shapes for selection, so we won't discuss them

separately.

To select a line, tap on the line and its handle end points will appear.

We understand that it is difficult to be as accurate as you are with a mouse using a desktop computer when

using a tablet or smartphone, so TouchDraw 2 is designed to allow for some margin of error; however, you do

need to try to tap as close to the line as possible. You will receive feedback that you have selected the line

when the handles for the endpoints are displayed.

To select a shape, tap anywhere within the shape and it's handles will show up.
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Multiple Selections

By default, a previously selected shape will be deselected when another is selected; however, TouchDraw 2

does support multiple selections. TouchDraw 2 provides two selection modes for figures within a drawing. It

defaults to Selection as Group, which will appear as shown below when multiple figures are selected.

A second selection title Select Individually (Classic) is available within the View Menu. This option is

enabled when a checkmark is present in the menu. When enabled, this option has the same functionality as

when selecting figures within TouchDraw 1.
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This option provides "live" feedback as you drag shapes around on the Drawing Canvas (especially connected

shapes). It is also best for using overlays (or the Info Menu) to set shape attributes. A good example would be

making a collection of shapes all 1 inch wide and 1 inch tall using Overlays or the Geometry Tab. This will be

easier when the Select Individually (Classic) option is enabled.

The Function Key Feature can be activated to make multiple selections. Press and hold on the empty portion of

the Drawing Toolbar for ~1 second until it turns red and continue to hold a finger on the toolbar while using the

other hand to tap on additional figures. This feature can be used to add or remove figures from the multiple

selection.
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The Selection Rectangle may also be used to select multiple figures. Touch and drag the Selection Rectangle

from left to right or right to left over an area within the Drawing Canvas and then release the utilized finger

once the rectangle covers the desired area to complete the selection.

When the rectangle is dragged from left to right, it will select all figures within its bounds and every figure

intersecting it, as shown below.
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Dragging the Selection Rectangle from right to left from any point within the Drawing Canvas informs

TouchDraw 2 to select only the figures within the rectangle's bounds, as shown below.
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Using the Edit Menu

The Edit Menu contains options for selecting all figures within a currently open drawing and inverting or

clearing a current selection within the Drawing Canvas. Press on the File Menu in the Top Toolbar to access

these options.

Tap on the Select All option to select all figures within a drawing or press on the Expand Button (blue circle

with right facing arrow) to access additional selections.
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Use the Invert Selection option to invert the current selection or the Deselect All Selection option to deselect

all currently selected figures within the Drawing Canvas.
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5.2.1.2. Deleting a Figure

An object must be selected before it can be deleted. A selected object may be deleted from the Edit Menu or by

using the Delete Button within the Top Toolbar.

Press on the Edit Menu and then tap on the Delete option to remove the currently selected figure from the

drawing.
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A figure can also be deleted by pressing on the Delete Button in the Top Toolbar.

Please keep in mind that TouchDraw 2 has support for Undo and Redo. If a figure is deleted by accident, press

the Undo button in the Top Toolbar to redisplay the object.
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5.2.1.3. Saving a Drawing

A drawing will be saved automatically when it is created in TouchDraw 2. Changes to a drawing may be saved

at any time through the File Menu. TouchDraw 2 offers two methods for Saving a Drawing (Save and Save

As...).

Save

An existing file can be saved at any time by selecting the Save option under the File Menu. This option will

only be available if a change has been made to the drawing within the Drawing Editor.
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Save As

An existing file can be saved under another name by using the Save As... option under the File Menu.
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Tap on the current name to change the file name before saving. The file name does not have to be changed;

however, if a file with the same name exists in the selected save directory (or folder), a number will be added to

the end of the file name.
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Use the keyboard to remove the current name and enter a new name for the file. Tap Done once finished.

Next, select a parent directory (and folder) for saving the file. Tap on a parent directory to select it. If folders

exist within the selected directory, you can tap on a specific folder to save the file in the selected folder.
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Tap on Save in the upper right corner to finish saving the file with the entered file name in the selected file

directory and folder.
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Note: A new folder can be added to the selected parent directory and/or folder before saving by clicking on the

Add Folder icon.



Page 502

TouchDraw 2 for iOS

5.2.1.4. Printing a Drawing

TouchDraw 2 supports the capability of printing drawings to local printers. These options can be accessed from

the File Menu as shown below.

Tap on Print... within the menu to open the Printer Options view..

The Printer Options is used to select a printer, set the number of copies, and to set additional print

settings.Press on Select Printer to view a list of discovered printers.
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Tap on a printer to select it for printing. Use the Info icon to learn more about a printer displayed within the list.

Configure any needed printer options and then tap on Print to print the drawing on the selected printer.
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Description

Printer This option can be used to select a printer for printing and to view information about

available printers.

Copy This option can be used to configure the number of print copies for the drawing. Tap

on the Minus Button to decrease the copy count or the Plus Button to increase the

copy count.

Black & White This option can be used to print in black and white rather than color. It is disabled by

default. Tap on the slider to enable or disable this option. The slider will appear blue

when enabled.
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5.2.2. Using the Clipboard

The Clipboard holds the most recent change made to a figure within the Drawing Editor. Changes are stored

on the clipboard when an item is copied, cut or undone. They are reapplied by choosing the Paste or Redo

commands.

All Clipboard actions with the exception of Undo and Redo are accessible through the Contextual Menu.

Touch and press the Drawing Canvas for ~1 second to bring up the Contextual Menu. It will appear as shown

below:

Undo and Redo actions are accessible through the Top Toolbar, as shown below.
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5.2.2.1. Paste Style

The Paste Style option allows formatting to be copied from one shape and pasted (applied) to another.

The example below shows how to copy the style of one figure to another figure within a drawing:

Step 1:Select the source shape/figure with the formatting to be applied to another object.

Step 2: Open the Contextual Menu and Copy the shape to the clipboard.

Note: You can also tap on the figure to select it within the Drawing Canvas and then use the File Menu to

select the Copy option.

Step 3: Select the target shape.
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Step 4: Perform an extended press on the source figure to open the Contextual Menu. Then tap on the Paste

Special Submenu.

Note: You can also tap on the figure to select it within the Drawing Canvas and then use the File Menu to

access the Paste Special Submenu.

Step 5: Select the Paste Style option from Paste Special Submenu.
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Step 6: The formatting from the source figure is applied to the target figure.
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5.2.2.2. Copying a Figure

A figure or group of figures must be selected before copying can occur. After a selection has been made, touch

and press on the Drawing Canvas for ~1 second to bring up the Contextual Menu, as shown below.

Tap on the Copy option to copy the currently selected figure or group of figures into the clipboard.

Note: You may also select the figure or figures and then tap on the Edit Menu to copy them to the clipboard.
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5.2.2.3. Duplicating a Figure

A figure can be duplicated to make sharing the same attributes easy. At least one figure must be selected for

these options to appear in the Contextual Menu.

Options for duplicating a figure are accessed by pressing on the Edit Menu in the Top Toolbar.

Two options are provided for duplicating selecting figures, as shown below:

Tap on the Duplicate option to create a copy of a selected figure(s) and have it placed at an offset position in

the Drawing Canvas, as shown below.
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Tap on the Duplicate in Place option to create a copy of a selected figure(s) and have it placed in the same

exact location as the original. Hold and drag the top figure to a new position in the Drawing Canvas to see both

the original and the copy.
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5.2.2.4. Cut and Paste

Cutting and pasting works in the same manner as copy and delete. A figure or group of figures must be

selected to use one of these application functions. After a selection has been made, touch and press the

Drawing Canvas for ~1 second to bring up the Contextual Menu, as shown below:

Note: You may also access these options for one or more selected figures through the Edit Menu in the Top

Toolbar.

The Cut command removes the figure from the Drawing Canvas and adds it to the clipboard. The Paste button

directs TouchDraw 2 to paste the contents of the clipboard into the drawing. Pasting the clipboard contents

multiple times into the Drawing Canvas causes the figure(s) to be placed in slightly offset positions as shown

below.
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Paste Special Submenu

The Paste Special Submenu can be used to perform additional pasting actions. It can be accessed through the

Contextual Menu and the Edit Menu.
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Paste in Place

To paste a figure in the same exact location, open the Contextual Menu or the Edit Menu, press on the Paste

Special Submenu, and then tap on the Paste in Place option.

To see the pasted figure select the figure and drag in any direction. In the example below, the pasted figure is

dragged to the right.
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Paste Multiple

To paste multiple instance of a figure into the clipboard, open the Contextual Menu or the Edit Menu, press on

the Paste Special Submenu, and tap on the Paste Multiple menu option.

Tap on the Plus (+) and Minus (-) Buttons to change the current values. The X and Y values represent the

offset for the pasted figures. For example, if these values are left at 1 inch, then each pasted figure will be 1

inch off on both the X and Y axis.

The Number (#) represents the number of times the selected figure(s) will be pasted into the drawing. Once

these values have been set appropriately, press on the Paste Button to paste the figures into your drawing.
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In the example below, the figure has been pasted 4 times with both the X and Y values set at 1 inch.

Paste Style

To paste the style of a figure, open the Contextual Menu or the Edit Menu, press on the Paste Special

Submenu, and then tap on the Paste Style option. Refer to the Paste Style section of this documentation to

learn more.

Note: Press on the Back button in the upper left of the Paste Submenu to return to the Contextual Menu.
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5.2.2.5. Undo and Redo

The Undo command reverts the last change that was made to a drawing. This button is disabled (dimmed)

when no changes have been made and enabled as soon as something is altered in the Drawing Canvas.

The Redo command cancels the last undone change made to the Drawing Canvas. This button is disabled

(dimmed) when nothing has been undone and is enabled as soon as the Undo command has been used or

something is altered.

As the iPad has limited available memory (RAM), TouchDraw 2 limits the size of the undo stack to the last 20

operations, in order prevent iOS from shutting down TouchDraw for excessive memory usage.
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5.2.3. Inserting Images into Drawings

An image file can be inserted as part of a drawing. These image types are supported by the TouchDraw 2

application:

• Portable Network Graphic (.png)

• JPEG (.jpg, .jpeg)

• BMP (.bmp)

• TIFF (.tif, .tiff)

• GIF (.gif)

Images may be inserted from one of four locations:

• Device Photos

• Device Camera

• Local Storage

• 3rd Party Applications

Note: Click or tap on a link above to learn more about inserting images into a drawing.
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5.2.3.1. Inserting Images from Photos

Images stored in your device photos may be inserted into a drawing within the Drawing Editor. Follow the

steps below to insert an image from your device photos:

Step 1: Press on the File Menu.

Step 2: Press on the Insert from Photos option.

Step 3: Tap on a All Photos or another Folder to view saved photos.
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Step 4: Tap on a Photo to insert it into your drawing.

Step 5: The selected image will appear in the Drawing Canvas.
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5.2.3.2. Inserting Images from Camera

Images may be taken with your device camera and inserted into a drawing within the Drawing Editor. Follow

the steps below to insert an image from your device camera:

Step 1: Press on the File Menu.

Step 2: Then press on the Insert from Camera option.

Step 3: Take a photo with your device's camera.
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Step 4: Tap on Use Photo in the bottom right corner of the screen.

Step 5: The photo will appear in the drawing as shown below:
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5.2.3.3. Inserting Images from Local Storage

Images in your local device storage may be inserted into a drawing within the Drawing Editor. Follow the steps

below to insert an image from your device storage:

Step 1: Press on the File Menu.

Step 2: Then press on the Insert From... option.

Step 3: Navigate to the directory location of a desired image file. In this example, the image file is stored in a

folder titled Sample Folder. If the image is in a folder, you will need to tap on the folder to view its files. Once

the image file has been located, tap on it's file name.
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Step 4: The selected image will appear in the Drawing Canvas.

Note: Only files with the appropriate extension will be presented as a selectable item in the shown directory list.
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5.2.3.4. Inserting Images from Applications

Images stored in the cloud through 3rd party applications (Dropbox, Box, Google Drive, etc.) may be inserted

into a drawing within the Drawing Editor.

Follow the steps below to insert an image from a 3rd party application:

Step 1: Press on the File Menu.

Step 2: Then press on the Insert From... option.

Step 3: Tap on Locations in the upper right corner of the pop-up window.
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Step 4: Press on a 3rd party application (Dropbox, Google Drive, Box, etc.) to select the storage location.

Step 5: Tap on a folder to view its image files. Once located, tap on the file name to select it.
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Step 6: The selected image will appear in the Drawing Canvas.

Note: Only files with the appropriate extension will be presented as a selectable item in the shown directory list.
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5.2.4. Handling Figures

TouchDraw 2 supplies a variety of options for handling figures. An individual figure or group of figures can be:

• Moved

• Stretched

• Resized

• Rotated

• Flipped

• Scaled

• Shifted

Note: Click on a link above to learn more.
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5.2.4.1. Moving a Figure

A figure must be selected to be moved to another location on the Drawing Canvas. Perform a Drag gesture to

move an already selected figure or use a Touch/Drag combination within the figures bounds to accomplish the

move in one step.

To change the position of a group of selected figures, perform a Touch/Drag combination within bounds of

any selected object to move the entire selection to a desired location. A move is completed when the

Touch/Drag gesture is released.

See the Easy Drag Mode section to learn more about an easier way to move smaller objects around the drawing

view without worrying about inadvertently dragging one of their handles.
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5.2.4.2. Stretching a Figure

Most shapes have handles in the top center, bottom center, left middle and right middle that allow them to be

stretched for increased width or height. The screenshot below demonstrates these handles for a rounded

rectangle.

When the Selection as Group (Default) option is enabled and multiple figures are selected, all figures can be

stretched at the same time by touching and dragging on the same handles for the selection group, as shown

below:

If the Function Key Feature is enabled when the figure is stretched, it will maintain it's current aspect ratio.

Note: Multiple figures can be stretched in this same manner once they have been placed into a group.
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5.2.4.3. Resizing a Figure

In addition to the handles described in Stretching a Figure, shapes also have handles in the upper left, upper

right, lower left and lower right for resizing a selected figure. The screenshot shown below points out these

handles for a rounded rectangle:

To Resize a Figure, touch one of the above shown handles and then drag with the same finger. The width and

height of a figure will change dynamically as the handle is dragged.

When the Selection as Group (Default) option is enabled and multiple figures are selected, all figures can be

resized at the same time by touching and dragging on the same handles for the selection group, as shown below:

If the Function Key Feature is enabled when a figure is resized, it will maintain it's current aspect ratio.

Multiple figures can be resized at once by placing them into a group.
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The Resize Submenu within the Modify Menu can also be used to resize multiple figures based on largest or

smallest size, height, or width.

At least two figures must be selected for this submenu and its options to be available. The following images

show the before and after for two rectangle figures when the Resize to Largest Size option is used.
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5.2.4.4. Rotating a Figure

Every figure, with the exception of lines, can be rotated. A red handle will be shown to the right of a figure

when it is selected for rotation. This red handle can be dragged to change the rotation angle of a selected shape.

A semi-transparent gray line going from the rotation handle to the figure's center of rotation point (typically

represented by a gray circle in the middle) will also be displayed.

Perform a Touch/Drag gesture combination on the red handle to rotate the object in increments of 1° around

it's center of rotation point.
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Note: Activating the Function Key Feature while rotating a figure causes the action to occur in 15° increments.

A figure may be rotated at 90° increments to the right or left by using the Rotate 90° Right or Rotate 90° Left

options. To access these options, tap on the Modify Menu.

Then tap on the Rotate Submenu and make a selection.
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The example below shows what a figure looks like prior to and after being rotating 90 degrees to the left.

The Rotate 180° command may also be used to rotate a figure and is accessible through the same menu as

discussed above. Below is an example of what a figure looks like prior to and after being rotated 180 degrees.
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Note: The Center of Rotation can be changed to a different point within a shape or reset after it has been

altered. See Changing the Center of Rotation or Resetting the Center of Rotation for additional information.

5.2.4.4.1. Changing the Center of Rotation

A selected shape will show a gray semi-transparent circle connected to the rotation handle. This gray circle

indicates a selected shape's Center of Rotation and can be changed to any desired point within the shape's

bounds. By default, the option to change a shape's Center of Rotation is not enabled.
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To enable the Center of Rotation option within the Drawing Editor, complete the following steps:

Step 1: Press on the View Menu.

Step 2: Press on the Handles Submenu.

Step 3: Touch the On/Off toggle setting and Drag to the right to enable the Center of Rotation option. The

toggle will appear grayed out when disabled and blue when enabled.
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Step 5: Press on View to return to the main popup menu or tap anywhere in TouchDraw 2 to close the menu.

Step 6: A new handle will replace the original semi-transparent circle once this option has been enabled.

To alter the Center of Rotation, drag the newly visible handle to a desired location.



Page 543

TouchDraw 2 for iOS

The shape will rotate around the new point rather than its natural center once it has been set.

5.2.4.4.2. Resetting the Center of Rotation

A selected shape will show a gray semi-transparent circle connected to the rotation handle. This gray circle

indicates a selected shape's Center of Rotation and can be changed to any desired point within the shape's

bounds. This point can be set back to its natural center after it's location has been altered.

Follow the steps below to Reset the Center of Rotation:

Step 1:Select the desired shape.
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Step 2: Press on the Modify Menu in the Top Toolbar and then press on the Rotate Submenu.

Step 3: Tap on the Reset Center of Rotation option.

Step 4: The point will be adjusted back to its natural center.
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5.2.4.5. Flipping a Figure

A figure can be flipped either horizontally or vertically in the Drawing Canvas. These options can be found in

the Transform section of the Modify Menu, by completing the following steps:

Step 1: Tap on the Modify Menu to access these options.

Step 2: Then tap on the Flip Submenu.

Note: A figure must be selected to choose one of the above options.

Tap on the Flip Horizontally option to interchange a figure horizontally. The images below show a before and

after of this figure transition:
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Tap on the Flip Vertically option to interchange a figure vertically. The images below show a before and after

of this figure transition.



Page 548

TouchDraw 2 for iOS



Page 549

TouchDraw 2 for iOS

5.2.4.6. Scaling a Figure

The Scale By option can be used to alter figure size based on input coordinates to create a smaller or larger

figure spanning over a specific area and is located in the Transform Section of the Modify Menu.

To Scale a Figure or group of figures in the Drawing Editor, complete the following steps:

Step 1:Select a figure(s) to be altered.

Step 2: Press on the Modify Menu.

Step 3: Tap on the Scale By... option in the Modify Menu.

Step 4: Enter the desired X and Y coordinates into the Scale By popover window by using the incremental
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buttons located on the right and left side of each field or by pressing on the number field to bring up the

keyboard.

Step 5: Two options are provided at the bottom of this screen: Scale Size and Scale Attributes. Each option

informs the application to perform a different action during scaling. To enable or disable an option, tap on the

On/Off toggle slider located to the right of the option.

Step 6: Press on the Scale Button when finished.
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Step 7: The selected figure will be scaled according to the entered coordinates and selected options. It will

appear in scaled form with the Scale By popover window remaining available to make further changes.

Note:Scale By changes can be reverted by using the Undo Button in the Top Toolbar.
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5.2.4.6.1. Scale Size

The Scale Size option informs TouchDraw 2 to scale the size of the selected figure(s) based on the entered

Factor X and Factor Y values. The toggle slider will appear blue when this option is enabled.

This option must be enabled for the selected figure(s) to be scaled by the entered values.

If Factor Y is changed to 4 for the above figure, it will appear as shown below:
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If the Scale Size option is disabled (gray), the size will not be scaled. However, if the Scale Attributes option

remains enabled, then the attributes (stroke, text, etc.) will be scaled according to the entered values, as shown

below:
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Note: Please note that if both options have been disabled, then the selected figure(s) will not be scaled.

5.2.4.6.2. Scale Attributes

The Scale Attributes option informs TouchDraw 2 to scale the attributes (stroke, text, etc) of the selected

figure(s) based on the entered Factor X and Factor Y values. The toggle slider will appear blue when enabled.

If the Scale Size option has been enabled as well, then the selected figure's size and attributes will be scaled

according to entered values. If 4 is entered for Factor Y, then the height of the selected figure(s) will be scaled

by that value.
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The above figure would appear as shown below:

When the Scale Attributes option is disabled (gray), only the size of the selected figure(s) will be scaled by the

entered Factor values.



Page 556

TouchDraw 2 for iOS

In the example below, the size of the figure is scaled; however, the stroke and text attributes are not.

If Scale Attributes is the only enabled option, then only the attributes of the selected figure(s) will be scaled

according to the entered Factor values.
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Note: Please note that if both options have been disabled, then the selected figure(s) will not be scaled.
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5.2.4.7. Shifting a Figure

The Move By option can be used to shift a selected figure or group of figures by an entered set of coordinates.

This option changes the location of a figure based on input coordinates and is accessible through the Modify

Menu.

To Shift a Figure or group of figures within the Drawing Editor, complete the following steps:

Step 1:Select a figure or grouping of figures to be shifted. In this example, two figures will be shifted at the

same time.

Step 2: Press on the Modify Menu in the Top Toolbar.

Step 3: Tap on the Move By... option.
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Step 4: Enter the desired X and Y grid coordinates in the Move By popover window by using the incremental

buttons located on the right and left side of each field or by pressing on the number field to bring up the

keyboard.

Step 5: Press on the Move Button to finish the shift.
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The selected figure or group of figures will shift in accordance to the entered coordinates and the Move By

popover window remains open to allow for further changes.
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Note: Press on the View Menu in the Move By popover window to return to the Modify Menu or tap

anywhere within the Drawing Canvas to close the menu.
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5.2.5. Arranging Figures

TouchDraw 2 allows figures within the drawing view to be grouped or locked. Grouped figures are treated as a

single object where all attribute, movement, and sizing changes are applied to the group as a whole.

Locked figures cannot be moved or resized, but still allow for attribute changes such as the fill color or stroke

properties.

Figures can be ungrouped or unlocked any time object modification requirements change and then regrouped or

locked again as needed.



Page 563

TouchDraw 2 for iOS

5.2.5.1. Grouping Figures

Shapes residing on the Drawing Canvas can be manipulated and treated as a single figure with the Group

feature. More than one figure will need to be selected in order for this option to be enabled. Use the Function

Key Feature to select multiple figures.

To group a set of figures within the Drawing Editor, complete the following steps:

Step 1:Select the figures to be grouped.

Step 2: Press on the Arrange Menu.

Step 3: Tap on the Group option. The ungroup option will only appear in the Arrange Menu if a set of already

grouped figures has been selected.



Page 564

TouchDraw 2 for iOS

Step 4: Two selected figures will appear as shown below after they have been grouped. New bounds handles

will appear after the selected figures are grouped. These handles correspond to the group as a whole rather than

each individual figure.

A new rotation handle is provided for making an entire group rotation. The standard "blue" handles are

replaced by "blue handles with dots" to provide a visual indicator as to whether the entire group or a separate

figure has been selected.

Note: Paths are an exception to the multiple selection rule because a path or path shape can be added to a group

by itself. This allows for path interaction without having to worry about the occurrence of reshaping when

grabbing one of the available handles.

The screenshots below show a before and after for creating a group from multiple selected figures.

Multiple selected figures will appear as shown below once they have been grouped.
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5.2.5.2. Ungrouping Figures

A Group must be selected for the ungrouping option to be enabled. To ungroup a set of grouped figures,

complete the following steps:

Step 1:Select the set of figures to be ungrouped.

Step 2: Press on the Arrange Menu.

Step 3: Tap on the Ungroup option. The group option will only appear in the Arrange Menu if a set of

ungrouped figures has been selected.

Note: Both grouping buttons will appear in the Arrange Menu when an individual figure and group of figures

has been selected at the same time.
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Step 4: Two selected figures will appear as shown below after they have been ungrouped.

Note: Any transformations made to the group (such as rotating, resizing, etc...) will be retained by previously

grouped objects after the ungrouping action has been completed. Grouping provides a nice way to quickly

make bulk changes to multiple figures or all objects within a drawing.



Page 568

TouchDraw 2 for iOS

5.2.5.3. Locking Figures

A Locked Figure is one that cannot be moved or resized until it has been unlocked. Attributes such as stroke,

fill, shadow, etc... can still be manipulated on a locked figure. A minimum of one figure must be selected in

order for this option to be enabled. To lock a figure(s), complete the following steps:

Step 1:Select the figure(s) to be locked.

Step 2: Press on the Arrange Menu.

Step 3: Tap on the Lock option. The unlock option will only appear in the Arrange Menu if a set of already

locked figures has been selected.
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Step 4: The locked figures will appear as shown below.

Tip: Use the Function Key Feature to select multiple figures for locking.

A group of figures will appear as shown below when they are unlocked.

The group will appear as shown below once they have been locked. The handles appear gray after a figure(s) or

group of figures are locked. This handle attribute change serves as a visual indicator of the selected figure(s)

being locked.
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5.2.5.4. Unlocking Figures

A figure(s) or group of figures can be unlocked to allow for moving and resizing. To unlock an individual or

set of locked figures, complete the following steps:

Step 1:Select the figures to be unlocked.

Step 2: Press on the Arrange Menu.

Step 3: Tap on the Unlock option. The lock option will only appear in the Arrange Menu if the selected figures

are currently unlocked.
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Step 4: The unlocked figures will appear as shown below.

Note: This Arrange Menu option will only be enabled when a locked figure or group of figures has been

selected within the Drawing Canvas.
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5.2.6. Aligning Figures

TouchDraw 2 provides methods for aligning a set of figures to an attribute of the first selected figure in the set.

Relative Alignment

The first type of alignment that can be done is relative alignment, where figures are aligned in relation to one

another. The list below outlines the relative alignment options available.

• Top

• Vertical Center

• Bottom

• Left

• Horizontal Center

• Right

Grid Alignment

In addition to relative alignment, a figure (or set of figures) can also be aligned to the grid of the Drawing

Canvas in the case that they were drawn or modified while the snap to grid option was disabled.
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5.2.6.1. Align to Grid

The Align to Grid option is available to align figures with the grid. A minimum of one figure must be selected

to use this option. The Snap to Grid option must be turned on if figures are drawn with the grid turned off and

need to be aligned with the grid.

To align a figure or set of figures to the grid, complete the following steps:

Step 1:Select the objects to be aligned.

Step 2: Press on the Arrange Menu.

Step 3: Tap on the Align to Grid option.
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The option will first align the upper left hand corner of the selected figures to the grid and then resize it to

make all four corners align with the grid.

The following screenshots show a before and after of a shape that has been aligned to the grid.
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Note: The Snap To Grid option must be disabled to place a figure anywhere within the grid lines on the

Drawing Canvas. This option must be enabled for the Align to Grid option to provide the results shown above.
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5.2.6.2. Align Top

The Align Top option moves all currently selected figures to match the top (Y position) of the first selected

figure. At least two figures must be selected for this application feature to be enabled. In the example below,

the upper right square was selected first.

To align selected figures with the top position of the first selected figure, complete the following steps:

Step 1:Select the figures to be aligned.

Step 2: Press on the Arrange Menu.
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Step 3: Tap on the Align Top option.

Step 4: The second selected figure is aligned with the top (Y position) of the first selected figure, as shown

below.

Note: Use the Function Key Feature to select multiple figures. Tap anywhere on the Drawing Canvas to close

the Arrange Menu.
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5.2.6.3. Align Vertical Center

The Align Vertical Center option moves all currently selected figures to match the vertical center (Y position

+ 1/2 of the height of all figures) of the first selected figure. At least two figures must be selected for this

application option to be enabled.

In the example below, the upper left square is selected first. To align the vertical center of a set of figures,

complete the following steps:

Step 1:Select the figures to be aligned.

Step 2: Press on the Arrange Menu.
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Step 3: Tap on the Align Vertical Center option.

Step 4: The second figure is aligned to match the vertical center (Y position + 1/2 of the height of all figures)

of the first selected figure, as shown below.

Note: Use the Function Key Feature to select multiple figures. Tap anywhere on the Drawing Canvas to close

the Arrange Menu.
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5.2.6.4. Align Bottom

The Align Bottom option moves all currently selected figures to match the the bottom (Y position + Height) of

the first selected figure. At least two figures must be selected for this application feature to be enabled. In the

example below, the lower right square is selected first.

To align figures with the bottom position of the first selected figure, complete the following steps:

Step 1:Select each figure to be aligned.
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Step 2: Press on the Arrange Menu.

Step 3: Tap on the Align Bottom option.

Step 4: The second figure is aligned to match the the bottom (Y position + Height) of the first selected figure.
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Note: Use the Function Key Feature to select multiple figures. Tap anywhere on the Drawing Canvas to close

the Arrange Menu.
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5.2.6.5. Align Left

The Align Left option moves all currently selected figures to match the left (X position) of the first selected

figure. At least two figures must be selected for this application feature to be enabled. In the example below,

the lower right square is selected first.

To align figures with the left position of the first selected figure, complete the following steps:

Step 1:Select the figures to be aligned.
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Step 2: Press on the Arrange Menu.

Step 3: Tap on the Align Left option. When in landscape mode, scroll through the menu view by touching and

dragging upward on the Arrange Menu to see this option.

Step 4: Additionally selected figures are adjusted to match the the bottom (X Position) of the first selected

figure.

Note: Use the Function Key Feature to select multiple figures. Tap anywhere on the Drawing Canvas to close

the Arrange Menu.
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The following figures show an example of using the Align Left action.
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5.2.6.6. Align Horizontal Center

The Align Horizontal Center option moves all currently selected figures to match the horizontal center (X

position + 1/2 of the width) of the first selected figure. At least two figures must be selected for this application

feature to be enabled.

In the example below, the lower right square is selected first. To align figures with the horizontal center of the

first selected figure, complete the following steps:

Step 1:Select the figures to be aligned.
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Step 2: Press on the Arrange Menu.

Step 3: Tap on the Align Horizontal Center option. When in landscape mode, scroll through the menu view

by touching and dragging upward on the Arrange Menu to see this option.

Step 4: Additionally selected figures are adjusted to match the the bottom (X position + 1/2 of the width) of the

first selected figure.

Note: Use the Function Key Feature to select multiple figures. Tap anywhere on the Drawing Canvas to close
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the Arrange Menu .
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5.2.6.7. Align Right

The Align Right option moves all currently selected figures to match the right (X position + Width) of the first

selected figure. At least two figures must be selected for this application feature to be enabled.

In the example below, the lower right square is selected first. To align figures with the right position of the first

selected figure, complete the following steps:

Step 1:Select the figures to be aligned.
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Step 2: Press on the Arrange Menu.

Step 3: Tap on the Align Right option. When in landscape mode, scroll through the menu view by touching

and dragging upward on the Arrange Menu to see this option.

Step 4: Additionally selected figures are adjusted to match the the bottom (X position + 1/2 of the width) of the

first selected figure.

Note: Use the Function Key Feature to select multiple figures. Tap anywhere on the Drawing Canvas to close

the Arrange Menu.
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5.2.7. Snapping Figures

TouchDraw 2 supplies options for snapping figures to specific points on the grid, positions on the Drawing

Canvas or positions relative to other shapes. Figures can be snapped to these locations:

• Grid

• Lines

• Shapes

• Points or Pixels
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5.2.7.1. Snap to Grid

The Snap to Grid option toggles whether or not figures (and their handles) should be aligned to the grid as

they are created and modified. To enable/disable this option, complete the following steps:

Step 1: Press on the View Menu.

Step 2: Press on the Snapping Submenu.

Step 3: Tap on the Snap to Grid on/off slider to enable or disable the option. The slider will appear with a blue

background when this option is enabled and a gray background when disabled.
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5.2.7.2. Snap to Lines

The Snap to Lines option allows dragged handles to be snapped to the endpoints or the midpoints of lines in

the drawing canvas. To enable/disable this option, complete the following steps:

Step 1: Press on the View Menu.

Step 2: Press on the Snapping Submenu.

Step 3: Tap on the Snap to Lines on/off slider to enable or disable the option. The slider will appear with a

blue background when this option is enabled and a gray background when disabled.
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5.2.7.3. Snap to Points/Pixels

The Snap to Points option aligns objects to points on the grid for simplified modification and increased

accuracy. This option remains disabled until the unit of measure for the drawing is changed to points.

To change the grid unit of measurement, complete the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Press on the Units and Rulers Tab.

Step 3: Press on the Drawing Units option and then tap on Points to change the grid to points.
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Step 4: The grid will appear as shown below.

To enable/disable the Snap to Points option, complete the following steps:

Step 1: Press on the View Menu.
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Step 2: Press on the Snapping Submenu.

Step 3: Tap on the Snap to Points on/off slider to enable or disable the option. The slider will appear with a

blue background when this option is enabled and a gray background when disabled.
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5.2.7.4. Snap to Shapes

The Snap to Shapes option snaps a figure to a selected shape vertex or center point. This option is enabled by

default in TouchDraw. To enable/disable this option, complete the following steps:

Step 1: Press on the View Menu.

Step 2: Press on the Snapping Submenu.

Step 3: Tap on the Snap to Shapes on/off slider to enable or disable the option. The slider will appear with a

blue background when this option is enabled and a gray background when disabled.
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Step 5: To see this option in action, disable the Snap to Grid option, make certain Snap to Shapes is enabled,

and then draw a Star, or Rectangle. Once the shape is completed, select the Line Tool and try to draw a line

from one of the vertexes of the shape or its center point. The drawn line will snap to one of these locations.

In the example below, the line snaps to the center point of the rectangle.
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5.2.8. Ordering Figures

TouchDraw 2 supplies application functions for altering the order of a figure or multiple figures within a

specific layer on the Drawing Canvas.

Figures can be moved to the front of a layer or moved forward by one level from their previous position. They

may also be moved to the back of a layer or moved backward by one level within a layer.
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5.2.8.1. Bring to Front

The Bring to Front option moves a currently selected figure(s) to the front of all figures residing in the same

layer.

At least one figure within a layer must be selected for this option to be enabled. To bring a figure(s) to the front

of a layer, complete the following steps:

Step 1:Select the figure(s) to be moved to the front of the current layer. In this example, the rectangle has been

selected.

Step 2: Press on the Arrange Menu.
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Step 3: Tap on the Bring to Front option to bring the selected figure(s) to the front of the layer.

Step 4: The following image displays the position of the selected rectangle after using the Bring to Front

option.
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5.2.8.2. Bring Forward

The Bring Forward option moves a currently selected figure(s) one step closer to the top of the stack within

the layer they reside in.

At least one figure within a desired layer must be selected for this option to be enabled. To bring a figure(s)

forward within a layer, complete the following steps:

Step 1:Select the figure(s) to be moved one step closer within the layer. In this example, the circle has been

selected.

Step 2: Press on the Arrange Menu.
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Step 3: Tap on the Bring Forward option.

Step 4: The following image displays the position of the selected rectangle in this example after using the

Bring Forward option.

Note: The Bring Forward option can be chosen multiple times to continue moving a selected figure(s) to the

front of a layer.
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5.2.8.3. Send Backward

The Send Backward option moves a currently selected figure(s) one step closer to the bottom of a stack within

their residing layer. At least one figure within a layer must be selected for this option to be enabled.

To send a figure(s) back one step within a layer, complete the following steps:

Step 1:Select the figure(s) to be moved one step back in the current layer. In this example, the pentagon has

been selected.

Step 2: Press on the Arrange Menu.
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Step 3: Tap on the Send Backward option.

Step 4: The following image displays the position of the selected pentagon in this example after using the Send

Backward option. It has been moved to the back of the circle, but remains in front of the rectangle.

Note: The Send Backward option can be chosen multiple times to continue moving a selected figure(s) to the

back of a layer.
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5.2.8.4. Send to Back

The Send to Back option moves a currently selected figure(s) behind all other figures residing within the same

layer. At least one figure within a layer must be selected for this option to be enabled.

To send a figure(s) to the back of a layer, complete the following steps:

Step 1:Select the figure(s) to be moved to the back of the current layer. In this example, the pentagon has been

selected.

Step 2: Press on the Arrange Menu.



Page 611

TouchDraw 2 for iOS

Step 3: Tap on the Send to Back option.

Step 4: The following image displays the position of the selected pentagon in this example after using the Send

to Back option. It has been moved to the back of all other figures.
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5.2.9. Distributing Figures

TouchDraw 2 offers options for apportioning figures evenly in relation to each other. A set of figures can be

laid out to have equal spacing between each figure measured either horizontally or vertically.

A group of selected figures may also be packed into the smallest rectangular space possible using the Pack

Horizontally or Pack Vertically command options.
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5.2.9.1. Distribute Horizontally

The Distribute Horizontally option adjusts the positioning of selected figures to create an even amount of

horizontal space between each figure. This option is enabled when three or more unlocked figures are selected

in the Drawing Canvas.

To distribute a set of figures horizontally, complete the following steps:

Step 1:Select the figure(s) to be distributed horizontally.

Step 2: Press on the Arrange Menu.

Step 3: Tap on the Distribute Horizontally option. When in landscape mode, scroll through the menu view by

touching and dragging in an upward direction on the Arrange Menu to view this option.
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The following images display the positions of a selected set of figures prior to and after using the Distribute

Horizontally option.

In the above example, the first and middle figures were originally 2.5 inches apart. The spacing between the

middle and last figure totaled 0.5 inches. After this option has been applied, the horizontal space between each

figure is adjusted to 1 inch to provide three evenly spaced figures.
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5.2.9.2. Distribute Vertically

The Distribute Vertically option adjusts the positioning of selected figures to create an even amount of

vertical space between each figure. This option is enabled when three or more unlocked figures are selected in

the Drawing Canvas.

To distribute a set of figures vertically, complete the following steps:

Step 1:Select the figures to be distributed vertically

.
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Step 2: Press on the Arrange Menu.

Step 3: Tap on the Distribute Vertically option. When in landscape mode, scroll through the menu view by

touching and dragging in an upward direction on the Arrange Menu to view this option.
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The following images display the positions of a set of figures prior to and after using the Distribute Vertically

option

.
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In the above example, the spacing between the top and middle squares totals 1.5 inches. The middle and bottom

figures have a vertical spacing of 0.5 inches. After this option has been applied, the vertical space between each

figure is adjusted to 1 inch to provide three evenly spaced figures.
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5.2.9.3. Pack Horizontally

The Pack Horizontally menu item takes a set of selected shapes and "packs" them into the smallest space

possible horizontally.

This option is enabled when three or more unlocked figures are selected in the Drawing Canvas. Complete the

following steps to pack a set of figures horizontally:

Step 1:Select the figures or shapes to be packed horizontally.
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Step 2: Then press on the Arrange Menu. When in Landscape Mode, perform a Touch/Drag combination

upward or downward on the menu to view all available options. Tap on the Pack Horizontally option**.**



Page 622

TouchDraw 2 for iOS

Step 3: The following image displays the positions of a selected set of figures before and after using the Pack

Horizontally option.
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5.2.9.4. Pack Vertically

The Pack Vertically menu item takes a set of selected shapes and "packs" them into the smallest space

possible vertically.

This option is enabled when three or more unlocked figures are selected in the drawing canvas. Complete the

following steps to pack a set of figures vertically:

Step 1:Select the figures or shapes to be packed vertically.

Step 2: Then press on the Arrange Menu. When in Landscape Mode, perform a Touch/Drag combination

upward or downward on the menu to view all available options. Tap on the Pack Vertically option**.**

Step 3: The following image displays the positions of a selected set of figures before and after using the Pack

Vertically option.
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5.2.10. Combining Shapes

TouchDraw 2 offers multiple options for combining two shapes within the Drawing Canvas. Options for

selected shapes include:

• Add

• Subtract

• Intersect

• Exclude
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5.2.10.1. Add

The Add option combines two shapes into one figure and remains disabled until two figures have been

selected. To Add two or more selected shapes, complete the following steps:

Step 1: The properties of the first selected shape will be applied to the combined shape. Select the figures to be

combined. In this example, the oval is selected first.
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Step 2: Press on the Modify Menu.

Step 3: To view the Add Shapes option in the Modify Menu when in Landscape Mode, scroll through the

menu view by touching and dragging in an upward direction. Tap on the Add Shapes option.

Step 4: The following images display two selected shapes prior to and after using the Add Shapes option.
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Note: The selection of two non-intersecting shapes has no effect on their appearance, but does cause the figures

to be treated as one shape.
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5.2.10.2. Subtract

The Subtract option removes the intersecting portions of the second selected shape from the first figure

selected in the Drawing Canvas. This option remains disabled until two figures have been selected.

To Subtract two or more selected shapes, complete the following steps:

Step 1:Select the shapes to be combined. The properties of the first selected shape will be applied to the

combined shape. In this example, the oval is selected first.
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Step 2: Press on the Modify Menu.

Step 3: To view the Subtract Shapes option in the Modify Menu when in landscape mode, scroll through the

menu view by touching and dragging in an upward direction. Tap on the Subtract Shapes option.

Step 4: The following images display two selected shapes prior to and after using the Subtract Shapes option.



Page 633

TouchDraw 2 for iOS

Note: The selection of two non-intersecting shapes causes the second shape to be removed entirely.
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5.2.10.3. Intersect

The Intersect option removes all non-intersecting portions of selected figures from the Drawing Canvas. This

option remains disabled until two figures have been selected.

To Intersect two or more selected shapes, complete the following steps:

Step 1:Select the shapes to be combined. The properties of the first selected shape will be applied to the

combined shape. In this example, the oval is selected first.
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Step 2: Press on the Modify Menu.

Step 3: To view the Intersect Shapes option in the Modify Menu when in Landscape Mode, scroll through the

menu view by touching and dragging in an upward direction. Tap on the Intersect Shapes option.

Step 4: The following images display two selected shapes prior to and after using the Intersect Shapes option.
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Note: The selection of two non-intersecting shapes causes the second shape to be removed entirely.



Page 637

TouchDraw 2 for iOS

5.2.10.4. Exclude

The Exclude option removes the intersecting portions of selected figures from the Drawing Canvas. This

option remains disabled until two figures have been selected.

To Exclude selected shapes, complete the following steps:

Step 1:Select the shapes to be combined. The properties of the first selected shape will be applied to the

combined shape. In this example, the oval is selected first.
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Step 2: Press on the Modify Menu.

Step 3: To view the Exclude Shapes option in the Modify Menu when in Landscape Mode, scroll through the

menu view by touching and dragging in an upward direction. Tap on the Exclude Shapes option.

Step 4: The following images display two selected shapes prior to and after using the Exclude Shapes option.
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Note: The selection of two non-intersecting shapes has no effect on appearance, but does cause the figures to

be treated as one shape.
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5.2.11. Handling Colors

TouchDraw 2 provides multiple ways to select and change the color attributes of figures or text within the

Drawing Canvas. Color attributes can be changed for these items:

• Shapes

• Shadows

• Strokes

• Text

• Canvas Background

Additional attributes are available for changing the shadow and fill style of a selected figure(s). All color

attributes are accessible through the Drawing Toolbar and are managed through the standard Color Picker.
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5.2.11.1. Color Picker

The Color Picker is used to set the fill, stroke, text, and shadow color for currently selected figures or new

additions to an active drawing.

As shown in the image below, the Color Picker is made up of different components, which allow for varying

interactions with the Color Picker.

Click or tap on the corresponding Color Picker item name in the table below to learn more about what the

control does.

Color Loupe The Color Loupe Activator activates the loupe feature allowing colors        to be
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Control Name Description

Activator picked from a figure, drawing or other object visible within the        Drawing Canvas .

It provides a quick and easy way to set a figure color          to a previously used color

within the drawing.

Add to Favorites The Add to Favorites button can be used to add the current color        selection to a

favorites list for easier access during future changes.

HEX Editor The HEX Editor control shows the hex value of a selected color and        can be used

to change the color by editing this value.

Color Selection

Method The Color Selection Method controls offer seven methods for selecting          a

color:

- Color Square

- Color Wheel

- RGB

- HSV

- Gray Scale

- Named Colors

- Favorite Colors

- Colors In Use

5.2.11.1.1. Color Square

The Color Square provides a quick way to select a color from the standard operating system colors. It is the

default view when the Color Picker is opened to set the fill color, stroke color, etc.

To make a selection, just tap on any color in the square and it will be set automatically. The selected color will

be shown in the square located in the top left corner of the color square and the Hex value will also appear in

the top right corner.
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Note: The Hex Editor may be used to change the color by performing a tap and entering a different value.

5.2.11.1.2. Color Wheel

The Color Wheel is the most common way to select a color within TouchDraw 2. This color selection method

consists of a Color Wheel for selecting an exact color hue and a Saturation Box for altering the lightness or

darkness of a hue.

To access this color selection method, press on the Color Selection Menu and then choose Color Wheel.
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Tap on the desired hue in the Color Wheel and then tap on the desired lightness or darkness value in the

Saturation Box.

Note: The Opacity Slider (Alpha) may be used to the opaqueness of a selected color. Tap on the Hex Editor

to type in a specific value and alter the color.

5.2.11.1.3. RGB

The RGB Editor control can be used to alter the amount of red, green, and blue of the color being selected. To

access these options, press on the Color Selection Menu and then tap on RGB.
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To change the values, press on a slider and then move your finger to the right or left to set the desired color

value. You may also tap on the number to type in a different value.
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Tap on the Hex Editor to alter the color by changing the value or use the Favorites Button to save it to the list

of favorite colors.

5.2.11.1.4. HSV

The HSV Editor control can be used to alter the hue, saturation, and value of a color being selected. To access

this color selection option, press on the Color Selection Menu and then tap on HSV.
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To change the values, press on a slider and then move your finger to the right or left to set the desired color

value. You may also tap on the number to type in a different value.

Tap on the Hex Editor to alter the color by changing the value or use the Favorites Button to save it to the list

of favorite colors.
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5.2.11.1.5. Gray Scale

The Gray Scale color selection option can be used to alter the brightness and opaqueness (opposite of

transparency) of a color. To access this option, press on the Color Selection Menu and then tap on Gray Scale.

To change the values, press on a slider and then move your finger to the right or left to set the desired color

value. You may also tap on the number to type in a different value.
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Tap on the Hex Editor to alter the color by changing the value or use the Favorites Button to save it to the list

of favorite colors.

5.2.11.1.6. Named Colors

The Named Colors option is an alternative method for selecting a color within TouchDraw 2. The list consists

of pre-configured color options which are chosen by pressing on the desired color name in the list. To access

this option, press on the Color Selection Menu and then tap on Named Colors.
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Touch and drag upward or downward to scroll through the list of named colors. Tap on a color to select it. In

the example below, Black was originally chosen and is being changed to Dark Sea Green. The currently

selected color will be highlighted in blue.
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5.2.11.1.7. Favorite Colors

In TouchDraw 2, a color can be saved as a favorite to make it easier to find and use the color in a drawing(s).

This can be done by tapping on the Favorites Button (Star) after configuring the exact hue you want to save.

A few pre-defined colors are also present in the favorites list and can be used for drawings.

To access saved colors, press on the Color Selection Menu and then tap on Favorite Colors. Then just tap on

a color in the list to make a selection.
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5.2.11.1.8. Colors in Use

The Colors in Use option will display every color currently applied in your drawing and the displayed hues

come from the fill, stroke, shadow, and text colors that have been used within the drawing.

To access this option, press on the Color Selection Menu and the tap on Colors in Use.

You can tap on a color to apply it to the selected attribute (stroke, fill, etc.) for all figures or only selected

figures within the drawing. This is an easy way to switch between common colors in your drawing and to

maintain the same hues without having to perform additional steps to use the same colors.



Page 655

TouchDraw 2 for iOS



Page 656

TouchDraw 2 for iOS

5.2.11.2. Stroke Color

The Stroke Color of a selected figure can be changed to meet a desired preference. It can be altered for a

selected figure(s) or in instances where no figures have been selected.

If a figure has not been selected, the color change applies to any figure added after the change. This attribute

can be altered in the following ways:

Method 1: Press on the Info Button in the Toolbar.

Then press on the Stroke Tab and tap on the Stroke Color attribute.
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Method 2: Press on the Stroke Color Button in the Format Bar.

To alter the Stroke Color, complete the following steps:

Step 1: Tap on the On/Off toggle slider in upper right hand corner of the Stroke Tab to turn on this option.

The slider will appear with a blue background when this option is enabled.

Step 2: Tap on the Stroke Color attribute on the Stroke Tab.
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Step 3: To select a predefined color in the Color Square, simply press on the desired color.
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Step 4: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors,  Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.
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Step 5: If using the Color Wheel, first tap on the desired color range within the outside of the wheel view.

Then choose the desired lightness or darkness of the selected color in the center (saturation) square.

Note: For more information about using the different color selection options, please see the Color Picker

section.

Step 6: Alter the Stroke Style options (arrowhead, dashed, solid, etc.) by pressing on an option and then

tapping on the desired selection in the Stroke Window. Press on additional options (opacity, line join, etc.) to

make further attribute changes.
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Step 7: Tap anywhere within the Drawing Canvas to close the window.
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Note: A color change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the color change will apply to all subsequently created stroke figures.
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5.2.11.3. Fill Color

The Fill Color of a selected figure can be changed to meet a desired preference. It can be altered for a selected

figure(s) or in instances where no figures have been selected.

If a figure has not been selected, the color change applies to any figure added after the change. This attribute

can be altered in one of the following ways:

Method 1: Press on the Info Button in the Top Toolbar.

Then tap on the Fill Tab to open the popover window shown below.

Method 2: Press on the Fill Color Button in the Format Bar.

To alter the Fill Color, complete the following steps:

Step 1: Tap on the On/Off toggle slider in the upper right hand corner of the Fill Tab to turn on the Fill

option. The slider will appear with a blue background when this option is enabled.
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Step 2: To select a pre-defined color in the Color Square, simply press on the desired color.

Step 3: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Favorite Colors, or Colors in Use. To do so, press on the menu and then tap on an

option.
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Step 4: If using the Color Wheel, first tap on the desired color range within the outside of the wheel view.

Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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Step 5: Perform a Touch/Drag gesture combination or Press on additional options such as the opacity slider

within the Fill Window to make further attribute changes.

Step 6: Tap anywhere within the Drawing Canvas to close the window. The following screenshots show a
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figure that has been changed to a light blue fill.

Note: A color change will be seen instantaneously when a stroke figure is selected If no figures have been

selected, the color change will apply to all subsequently created stroke figures.

5.2.11.3.1. Fill Visibility

The Fill Visibility toggle may be used to show or hide the fill for one or more figures within a drawing. If a

figure(s) is selected, then the fill color will be enabled/disabled for that figure only.

Otherwise if no figures have been selected in the Drawing Canvas, the fill visibility will be enabled/disabled
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for every figure within the drawing.

To access this option and enable/disable it, complete the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Then press on the Fill Tab.

Step 3: To enable/disable the Fill Visibility toggle, tap on the slider in the top right corner of the Fill Tab. It

will have a blue background when enabled and a gray background when disabled.
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When Fill Visibility is disabled, you will see the Drawing Canvas within each figure or only the ones that were

selected, as shown below:

5.2.11.3.2. Solid



Page 670

TouchDraw 2 for iOS

The Solid fill style attribute sets the fill of a selected or any created figure(s) to a solid color. It can be accessed

and altered by performing the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Press on the Fill Tab.

Step 3: Tap on the Solid fill style option (if not already selected). Please note that the Fill Visibility option

must be enabled for a style change to be applied to any currently selected or new figures.

Step 4: Next, tap on the Color Attribute located below the style options.
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Step 5: To select a pre-defined color in the Color Square, simply press on the desired color.

Step 6: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.
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Step 7: The color change will be shown in the Solid Color Attribute within the Fill Tab.

A style change will be seen instantaneously when a figure is selected. If figures have not been selected, the

style change will apply to all subsequently created figures.

The following example shows a square with the Fill Style set to solid and Color set to blue:
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5.2.11.3.3. Linear Gradient

The Linear Gradient fill style option is located in the Fill Tab. This attribute transitions the fill from a specific

start color to the specified end color at a designated angle within a selected or created figure(s).

The Linear Gradient fill style can be accessed and configured by performing the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Press on the Fill Tab.
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Step 3: Tap on the Gradient style option. Please note that the Fill Visibility option must be enabled for a style

change to be applied to any currently selected or new figures.

Step 4: The Fill Tab will expand, as shown below.
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Step 5: Double Tap on either Gradient Handle to open the Color Picker and choose a hue.

Step 6: In the Color Square, tap on a hue to make a selection. The selected hue will appear in the gradient

handle within the settings.
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Step 7: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.
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Step 8: The following example shows a rectangle with the Fill Style set to linear gradient and color set to blue:

Note: A style change will be seen instantaneously when a figure is selected. If figures have not been selected,

the style change will apply to all subsequently created figures.

Working with Linear Gradients

Gradient Handles can be added by tapping on any location underneath the transition bar. A Touch/Drag

gesture combination can be used to move either Gradient Handle to alter the color transition of the fill.
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Once a new handle has been added, Tap on the handle to open the Color Picker and add an additional color.

More than one color can be added by setting each individual gradient handle to one of the desired colors. In the

example below, three gradient handles are used with these colors: white, blue, and green.
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Angle

Perform a Touch/Drag gesture combination on the Angle Slider or Press on the Plus + and Minus -Buttons

to change the angle value of a linear fill.
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In the example below, the Angle has been set to 75 degrees.
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Reset Button

The Reset Button can also be used to reset the gradient handles on a figure(s) after they have been moved to

another location. It may also be used to reset the angle back to zero and the gradient handles on the figure back

to their original position.

This button will not be available as an option until the Gradient Locations option has been enabled (see

below) and a change has been made to either the gradient handle positions and/or the gradient angle.
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In order for this to be seen, you must have the Gradient Locations option enabled. To enable this option, press

on the View Menu and then press on the Handles Submenu.
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Then tap on the Gradient Locations option to enable it. When enabled, it will appear blue.



Page 688

TouchDraw 2 for iOS

Once this option is enabled, you will see two additional handles on each selected figure. These may be used to

adjust the angle and progression of colors for the linear gradient. Below you will see what a figure looks like

when this option has not been enabled and then after it is enabled.



Page 689

TouchDraw 2 for iOS



Page 690

TouchDraw 2 for iOS

The two handles may be moved to any location within or outside of a figure to change the angle or fill pattern.

To do so, press and hold on the handle. Then drag the handle in any desired direction without lifting your

finger.

In the example below, one gradient handle has been moved up and to the right. The center gradient handle has

been moved to the left and down.
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After one or both gradient handles has been moved, click on the Reset Button to set the linear gradient handles

back to their original location.
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Swap Button

The Swap Button may be used to reverse the current angle and color slider settings. Click on this button again

to revert back to the original color order.
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5.2.11.3.4. Radial Gradient

The Radial Gradient fill style option is located in the Fill Tab. This attribute transitions the fill from the

specified start color to the specified end color by starting from the center of a selected or created figure(s) and

then moving outward in a circular manner.
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To access and configure the Radial Gradient fill style, you will need to perform the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Press on the Fill Tab.

Step 3: Then tap on the Gradient fill option. Please note that the Fill Visibility option must be enabled for a

style change to be applied to any currently selected or new figures.

Step 4: Next, press on the Gradient Type Menu and choose Radial Gradient.
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Step 5: Double Tap on either of the Gradient Handles to open the Color Picker and chooser a hue.
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Step 6: In the Color Square, tap on a hue to make a selection. The selected hue will appear in the gradient

handle within the settings.

Step 7: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.
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Step 8: The following example shows a rectangle with the Fill Style set to linear gradient and Color set to blue:
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Note: A style change will be seen instantaneously when a figure is selected. If figures have not been selected,

the style change will apply to all subsequently created figures.

Working with Radial Gradients

Gradient Handles are used to change the color transition of the radial fill style. By default, there are two

handles; however, these handles may be moved around on the slider bar or removed. You may also add more

handles and colors to the transition bar.

A Touch/Drag gesture combination can be used to move either of the default Gradient Handles to alter the

color transition of the fill, as shown below:
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Gradient Handles can be added by tapping on any location underneath the transition bar. Once a new handle

has been added, Tap on the handle to open the Color Picker and add an additional color.

More than one color can be added by setting each individual gradient handle to one of the desired colors. In the

example below, three gradient handles are used with these colors: white, blue, and green.
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Reset Button
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The Reset Button can be used to reset the center point of the radial gradient after it has been moved. This

button will not be visible until the Gradient Handles option has been enabled (see below) and at least one

handle position has been changed.
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In order for this to be seen, you must have the Gradient Locations option enabled. To enable this option, press

on the View Menu and then press on the Handles Submenu.
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Then tap on the Gradient Locations option to enable it. When enabled, it will appear blue.
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Once this option is enabled, you will see two additional handles on each selected figure. These may be used to

adjust the angle and progression of colors for the radial gradient. Below you will see what a figure looks like

when this option has not been enabled and then after it is enabled.
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The two handles may be moved to any location within or outside of a figure to change the angle or fill pattern.



Page 707

TouchDraw 2 for iOS

To do so, press and hold on the handle. Then drag the handle in any desired direction without lifting your

finger. Once this option is enabled, you will be able to move the center point to another location within a figure

as well (see below).



Page 708

TouchDraw 2 for iOS

After one or both gradient handles has been moved, the reset option will be visible and may be used. Click on

the Reset Button to set the radial gradient handles back to their original location.
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Swap Button

The Swap Button may be used to reverse the current color slider settings. Once reversed, you may click on the

button again to revert back to the original color order.



Page 711

TouchDraw 2 for iOS



Page 712

TouchDraw 2 for iOS



Page 713

TouchDraw 2 for iOS

5.2.11.4. Shadow Color

The Shadow Color of a selected figure can be changed to meet a desired preference. It can be altered for a

selected figure(s) or in instances where no figures have been selected. If a figure has not been selected, the

color change applies to any figure added after the change.

To alter the shadow color, complete the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Tap on the Shadow and Opacity Tab to open the following popover window.

Note: The Shadow Visibility option must be enabled for a color change to appear within the Drawing Canvas.
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Step 3: Changes made to this attribute are only reflected on current or new figures within the Drawing Canvas

when the Shadow Visibility option has been enabled.

To enable/disable this option, perform a Touch/Drag gesture combination or simply Tap on the On/Off

toggle slider. It will appear blue when enabled.

Step 4: Then Press on the Shadow Color attribute in the Shadow and Opacity Tab.
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Step 5: To select a pre-defined color in the Color Square, simply press on the desired color.
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Step 6: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors,  Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.

Step 7: If using the Color Wheel, first tap on the desired color range within the outside of the wheel view.

Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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Step 8: Perform a Touch/Drag gesture combination on the Opacity Slider to change the degree to which the

shadow can be seen through. Then tap anywhere within the Drawing Canvas to close the window.
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A color change will be seen instantaneously when a figure is selected. If no figures have been selected, the

color change will apply to all subsequently created figures.

The following examples show a square prior to adding a shadow and after the color has been altered.

X and Y Offset Attributes

The X Offset and Y Offset attributes set the offset of the shadow in the X axis and Y axis. Type a value in the

text field or use the "+" or "-" buttons to alter the shadow offset for a figure(s). In the example below, the X and

Y Offset has been changed to 10 points.
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Blur Attribute

The Blur attribute sets the amount of blur applied to the shadow. Type in a number in the text field or use the

"+" or "-" buttons to alter the Blur value for the shadow. In the example below, the Blur value has been

changed to 20 points.



Page 721

TouchDraw 2 for iOS

Opacity Attribute

Use the Opacity slider, text field, or "+" and "-" buttons to alter the opaqueness (opposite of transparency) of a

selected color. In the example below, the Opacity has been changed to 50.
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Blending Mode

The Blending Mode drop-down menu can be used to set the style of blend applied to a figure(s). In the

example below, the Difference blending mode has been chosen.
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5.2.11.5. Text Color

The Text Color of a selected figure can be changed to meet a desired preference. It can be altered for a selected

 figure(s) or in instances where no figures have been selected. If a figure has not been selected, the color

change applies to any figure added after the change.

This attribute can be altered in one of the following ways:

Method 1: Press on the Info Button in the Top Toolbar.

Then tap on the Text Tab to view the text attributes.



Page 725

TouchDraw 2 for iOS

Method 2: Press on the Text Color Button in the Format Bar.

To alter the Text Color, complete the following steps:

Step 1: Press on the Text Color attribute in the Text Tab.

Step 2: To select a pre-defined color in the Color Square, simply press on the desired color.
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Step 3: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.

Step 4: If using the Color Wheel, first tap on the desired color range within the outside of the wheel view.

Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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Step 5: Scroll through the Font Family and Font Style options by touching and dragging in an upward or

downward direction on the wheel to make a selection or Press on additional options (opacity slider, fill type,

etc.) within the popover window to make further attribute changes.
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Step 6: Tap anywhere within the Drawing Canvas to close the window.
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Note: A color change will be seen instantaneously when text is selected. If text has not been selected, the color

change will apply to all subsequent text entries.
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5.2.11.6. Canvas Background Color

The Canvas Background Color can be changed to meet a desired preference. To alter this attribute, complete

the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Tap on the Background Color attribute in the Page Setup Tab.
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Step 3: To select a pre-defined color in the Color Square, simply press on the desired color.
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Step 4: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.

Step 5: If using the Color Wheel, first tap on the desired color range within the outside of the wheel view.
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Then choose the desired lightness or darkness of the selected color in the center (saturation) square.

Step 6: Tap anywhere within the Drawing Canvas to close the window.
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The Canvas Background Color change will appear instantaneously, as shown below:
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Note: Move the Opacity Slider to zero to make the Canvas Background Color transparent within the

Drawing Canvas.
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5.2.11.7. Color Loupe

The Color Loupe (which in some applications is called an eye-dropper tool), is activated by pressing the

Loupe Button in the Color Picker. It allows colors to be picked from a figure, drawing or other object visible

within the currently visible Drawing Canvas. It provides a quick and easy way to set a figure color to a

previously used color within the drawing.

After the Color Loupe has been activated, the Standard Color Picker will disappear and a message will

appear at the top of the drawing view as a visual indicator of this feature being activated.

To select a color, perform a Touch/Drag gesture combination in an area of the Drawing Canvas. A

Magnifying Glass will appear to allow for fine control over selecting an exact pixel color within the drawing.

Once a desired pixel color has been selected, lift the finger to complete color selection and to apply it. A single

tap can also be performed to copy a specific color used for an existing object within the Drawing Canvas.



Page 737

TouchDraw 2 for iOS

The selected pixel color will appear as the current selection in the appropriate Color Button within the Format

Bar and the Info Menu. In the example above, the fill color is set for a figure and the color selection appears in

the Fill Color Button, as shown below.

The following screenshot demonstrates what would be seen during color selection. In the screenshot below, the

font color is being selected from an image for setting the color of title text.

The magnifying glass will appear right above where the Touch/Drag gesture combination is occurring. When

viewing the screenshot above, imagine that the gesture is taking place right below the magnifying glass, and it

is magnifying what is underneath the utilized finger.
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5.2.12. Handling Strokes

TouchDraw 2 provides multiple options for altering the attributes of a stroke (line) for existing or new

figures(s) within the Drawing Canvas. The Stroke Tab, accessible through the Info Menu, can be used to

change:

• Stroke Size

• Start or End Scale

• Start or End Shear

• Line or Endpoint Styles

• Line Caps

• Line Joins

• Line Location

• Miter Limit

• Line Colors
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5.2.12.1. Stroke Visibility

The Stroke Visibility option is an On/Off toggle slider used to set the visibility of strokes/lines of a figure(s).

If the visibility option is turned off, the border/line of a selected or added figure(s) is not drawn at all.

The Stroke Visibility toggle can be accessed by completing the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Then a tap on the Stroke Tab.

Step 3: To enable Stroke Visibility, tap on the On/Off toggle slider in the upper right hand corner of the
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Stroke Tab . The slider will appear with a blue background when this option is enabled. Tap anywhere within

the Drawing Canvas  to close this window after changes have been made.

If Stroke Visibility is on, an outline around the figure will be present and if it is off and Fill Visibility is on, the

figure will appear with no border, as shown below:

Note: Stroke attribute changes will not be reflected in a selected or added figure(s) until this option has been

turned on.
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5.2.12.2. Stroke Style

The Stroke Style or line dash pattern and end decorations of a figure can be altered in one of the following

ways:

Method 1: Press on the Info Button in the Top Toolbar.

Tap on the Stroke Tab.

Method 2: The Stroke Style may also be changed by using the Format Bar.
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Note: You may also use the Style As Dimension Line option to add arrowheads and a length value to a selected

line.

To alter the Stroke Style, complete the following steps:

Step 1: Tap on the On/Off toggle slider in the upper right hand corner of the Stroke Tab to turn on the option.

The slider will appear with a blue background when this option is enabled.

Step 2: Scroll through available style options (arrowhead, dashed, solid, etc.) by touching and dragging in an

upward or downward direction on the desired section (Start, Middle (Dash Pattern), or End) of the Line Style

Selection options.

The current selection will have a blue checkmark. Tap on an option to make a selection for the line, start, or

end style.
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Step 3: Tap anywhere within the Drawing Canvas to close this window after changes have been made. In the

example below, a line figure has been created and the start/end styles have been changed to a solid arrow.

Note: A Line Style change will be seen instantaneously when a stroke figure is selected. If no figures have

been selected, the Line Style change will apply to all subsequently created stroke figures.
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5.2.12.3. Stroke Size

The Stroke Size of a figure (width of a stroke in pixels) can be altered in one of the following ways:

Method 1: Press on the Info Button in the Top Toolbar.

Tap on the Stroke Tab.

Method 2: The Stroke Size may also be altered by using the Format Bar.
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To alter the Stroke Size, complete the following steps:

Step 1: Tap on the On/Off toggle slider in upper right hand corner of the Stroke Tab to turn on the option.

The slider will appear with a blue background when this option is enabled.

Step 2: Press on the Plus/Minus Buttons to increase or decrease the size by increments of one or perform a

Single Tap on the text entry field to open the keyboard and type in a value.
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Step 3: In the example below the Stroke Size for a Line has been changed to 5. Tap anywhere within the

Drawing Canvas to close this window after changes have been made.

Note: A size change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the size change will apply to all subsequently created stroke figures.
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5.2.12.4. Start/End Scale

The Start or End Scale for the Stroke Style of a figure can be altered by performing the following steps:

Step 1: Press on the Info Button in the Toolbar.

Step 2: Tap on the Stroke Tab.

Note: The Stroke Visibility option must be enabled for a Start/End Scale change to appear in the Drawing

Canvas.

Step 3: Tap on the figure to make a selection and alter the start/end scale for a single figure or simply change
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the value within Stroke Tab  to change it for all new figures within the drawing.

Step 4: The Start Scale can be used to change the size of the Start Line for a figure. Tap on the text field to

type in a value or tap on the Plus/Minus Buttons to change the value by 1. In this example, the value has been

changed to 5.

Step 5: The figure will appear as shown below when the Start Scale has been altered.
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Step 4: The End Scale can be used to change the size of the End Line for a figure. Tap on the text field to type

in a value or use the Plus/Minus Buttons to change the value by 1. In this example, the value has been

changed to 5.

Step 5: The figure will appear as shown below after both the StartScale value has been set to 6 and End Scale

value has been set to 4.
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5.2.12.5. Start/End Shear

The Start Shear and End Shear stroke style attributes can be used to shear (or skew) arrowheads on lines

within a drawing. Values default to degrees and negative values may be entered.

The Start or End Shear for the Stroke Style of a figure can be altered by pressing on the Info Button in the

Top Toolbar.

Note: The Stroke Visibility option must be enabled for a Start/End Shear change to appear in the Drawing
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Canvas .

To alter the Start/End Shear of a currently selected figure(s) or new figure(s):

Step 1: Tap on the figure to make a selection and alter the start/end shear for a single figure or simply change

the value within Stroke Tab to change it for all new figures within the drawing.

Step 2: The Start Shear can be used to shear the arrowhead of the Start Line for a line figure. Tap on the text

field to type in a value or use the "Up" or "Down" buttons to change the value by 1. In this example, the value

has been changed to 25 degrees.
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Step 3: The figure will appear as shown below when the Start Shear has been altered.
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Step 4: The End Shear can be used to change the shear the arrowhead of the End Line for a line figure. Tap

on the text field to type in a value or use the "Up" or "Down" buttons to change the value by 1. In this example,

the value has been changed to 25 degrees.
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The figure will appear as shown below after both the Start and End Shear values have been changed.

Below is an example of how the Start and End Shear options can be used within a drawing:
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5.2.12.6. Line Join

The Line Join (Mitered, Rounded, or Beveled) of a figure can be altered by accessing the Stroke Tab.

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Tap on the Stroke Tab.

To alter the Line Cap Type, complete the following steps:

Step 1: Tap on the On/Off toggle slider in the upper right hand corner of the Stroke Tab to turn on the option.

The slider will appear with a blue background when this option is enabled.
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Step 2: Press on the desired Line Join Type Button.

Step 3: Tap anywhere within the Drawing Canvas to close this window after changes have been made. The
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image below shows what a Square  would look like with a Mitered , Rounded , and Beveled Line Join .

Note: A Line Join change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the Line Join change will apply to all subsequently created stroke figures.
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5.2.12.7. Line Location

The Line Location of a figure can be altered by performing the following steps:

Step 1: Press on the Info Button in the Toolbar.

Step 2: Tap on the Stroke Tab.

Note: The Stroke Visibility option must be enabled for a Line Location change to appear in the Drawing

Canvas.

Step 3: Tap on the On/Off toggle slider in the upper right hand corner of the Stroke Tab to turn on the option.
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The slider will appear with a blue background when this option is enabled.

Step 4: To alter the Line Location, press on one of the choices under the line location heading. The selection

will appear in dark blue as a visual indicator of the currently active line location setting.
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Step 5: The example below shows what a Rectangle looks like when each Line Location choice is selected:

Center, Outside, and Inside.
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Note: A Line Location change will be seen instantaneously when a stroke figure is selected. If no figures have

been selected, the Line Location change will apply to all subsequently created stroke figures.
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5.2.12.8. Line Cap

The Line Cap (Butt, Rounded, or Square) of a figure can be altered by accessing the Stroke Tab. This

attribute window can be opened by performing the following steps:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Tap on the Stroke Tab.

To alter the Line Cap Type, complete the following steps:

Step 1: Tap on the On/Off toggle slider in the upper right hand corner of the Stroke Tab to turn on the option.
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The slider will appear with a blue background when this option is enabled.

Step 2: Press on the desired Line Cap Type Button.
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Step 3: Tap anywhere within the Drawing Canvas to close this window after changes have been made. For

example, the image below shows what a Line would look like with a Butt, Rounded, and Square Line Cap.

Note: A Line Cap change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the Line Cap change will apply to all subsequently created stroke figures.
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5.2.12.9. Miter Limit

The Miter Limit attribute can be used to set the angle of connected line segments where they join. The join

will be more jagged or sharp depending on the entered or selected value.

Miter limits are relative to stroke size and become increasingly noticeable for line segments with increased

thickness. The Miter Limit of a stroke (or line) can be altered by performing the following steps:

Step 1: Press on the Info Button in the Toolbar.

Step 2: Tap on the Stroke Tab.
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Note: The Stroke Visibility option must be enabled for a Miter Limit change to appear in the Drawing Canvas.

Step 3: Tap on the On/Off toggle slider in the upper right hand corner of the Stroke Window to turn on the

option. The slider will appear with a blue background when this option is enabled.

Step 4: To alter the Miter Limit, tap on the Plus/Minus Buttons next to the text entry field to increase or

decrease the miter limit by increments of one or tap on the text entry field to open the text editor and type in a

value.
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Note: A miter limit change will be seen instantaneously when a stroke figure is selected. If no figures have

been selected, the line cap change will apply to all subsequently created stroke figures.
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5.2.12.10. Line Color

The Line (Stroke) Color of a selected figure can be changed to meet a desired preference. The Line Color can

be altered for a selected figure(s) or in instances where no figures have been selected. If a figure has not been

selected, the color change applies to any figure added after the change.

This attribute can be altered in one of the following ways:

Method 1: Pressing on the Info Button in the Top Toolbar.

Then tapping on the Stroke Tab and the Stroke Color attribute.
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Method 2: Pressing on the Stroke Color attribute in the Format Bar.

To alter the Line (Stroke) Color, complete the following steps:

Step 1: Tap on the On/Off toggle slider in the upper right hand corner of the Stroke Tab turn on the option.

The slider will appear with a blue background when this option is enabled.
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Step 2: Next, press on the Stroke Color attribute in the Stroke Tab.
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Step 3: To select a predefined color in the Color Square, simply press on the desired color.
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Step 4: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.
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Step 5: If using the Color Wheel, first tap on the desired color range within the outside of the wheel view.

Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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Note: For more information about using the different color selection options, please see the Color Picker

section.

Step 6: Perform a Touch/Drag gesture combination or Press on additional options (opacity, line join, etc.)

within the Stroke Tab to make further attribute changes.

Step 7: Tap anywhere within the Drawing Canvas to close the window. The following example shows a figure
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with a white fill, a stroke size of 2, and a line color that has been changed from black to blue.

Note: A color change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the color change will apply to all subsequently created stroke figures.
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5.2.13. Handling Text

TouchDraw 2 provides multiple options for changing the text attributes of figures that are capable of displaying

text. The Text Tool can be used to add a text box anywhere on the Drawing Canvas. Text may also be added as

part of these shapes:

• Rectangles

• Rounded Rectangles

• Ovals

• Circles

• Polygons

• Closed Paths (Custom Shapes)

The attributes for entered text can be changed to meet specific preferences and include:

• Font Family

• Font Size

• Font Style

• Font Color

• Text Alignment

• Text Margin

Additionally, the location and orientation for text attached to lines and paths can be altered:

• Text Location

• Text Orientation

Variables may also be used to input a certain pre-formatted value as part of the displayed text within a figure.
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5.2.13.1. Editing Text

The Text Editor popover window must be opened to edit the text content of a selected figure. To open the text

editor, perform a Double Tap on the desired figure for editing. After double tapping, the Text Editor will

appear as shown below.

Entered text will be reflected within the drawing view in real time to provide instant feedback regarding how it

will appear, wrap, etc.. within the figure. Tap in any location outside of the supplied popover or Press on the

Done Button to dismiss the editor.
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If you prefer the first value to automatically appear in uppercase, be certain to turn on the Auto Capitalization

feature. This feature can be accessed by pressing on the Settings Button and then pressing on the User Interface

Submenu.
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5.2.13.2. Font Family

A figure must be selected to alter the Font Family of entered text. Use one of the following methods to change

the Font Family for a selected figure(s):

Method 1: Press on the Info Button in the Top Toolbar.

Press on the Text Tab to access the Font Family option.

Method 2: Tap on the Font option in the Format Bar.

Perform a Touch/Drag in an upward or downward motion to scroll through the available Font Family options

on the left side of the popover window. Then tap on the desired option.
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To alter the Font Family, complete the following steps:

Step 1: First, Tap on the Font Family option to view available choices.
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Step 2: Then perform a Touch and Drag in an upward or downward direction on the Font Selection List to

scroll through available options.
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Step 3: Press on the desired Font Family to make a selection. The current selection will have a blue

checkmark in the list and will appear in the Font Family attribute on the Text Tab. Tap anywhere within the

Drawing Canvas to close this window. In the example below, Courier has been chosen:
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5.2.13.3. Font Size

A figure must be selected to alter the Font Size of entered text. Use one of the following methods to change the

font size for a selected figure(s):

Method 1: Press on the Info Button in the Top Toolbar.

Press on the Text Tab to access the Font Size option.

Tap on the Plus/Minus Buttons in the Text Window to increase/decrease the size by increments of 1 or press

on the number field to enter a new size with the keyboard. Tap anywhere in the Drawing Canvas to close the

window.
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Method 2: Tap on the Font Size option in the Format Bar.
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5.2.13.4. Font Style

A figure must be selected to alter the Font Style of entered text. Use one of the following methods to change

the font style for a selected figure(s):

Method 1: Press on the Info Button in the Top Toolbar.

Press on the Text Tab to access the Font Styles option.

Method 2: Tap on the Font option in the Format Bar.

Then tap on the desired style on the right side of the popover window.
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To alter the Font Style, complete the following steps:

Step 1: Tap on the Font Style option in the Text Tab.
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Step 2: To scroll through available style options, touch and drag in an upward or downward direction on this

portion of the Font Selection List. Then tap on the desired selection in the list. In this example, the style is

currently set to Regular as indicated by the blue checkmark.
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Step 3: In the example below, the Font Style has been changed to Bold. Tap anywhere in the Drawing Canvas

to close this window.
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Note: All changes occur in real time when a figure(s) is selected. If a figure(s) is not selected, all changes are

applied to newly created figures.
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5.2.13.5. Font Color

The Font Color of a selected figure can be changed to meet a desired preference. It can be altered for a selected

 figure(s) or in instances where no figures have been selected. If a figure has not been selected, the color

change applies to any figure added after the change.

This attribute can be altered in one of the following ways:

Method 1: Press on the Info Button in the Top Toolbar.

Then press on the Text Tab to access the Text Color option.

Method 2: Tap on the Text Color option in the Format Bar.
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To alter the Font Color, complete the following steps:

Step 1: Press on the Text Color attribute in the Text Tab.

Step 2: To select a predefined color in the Color Square, simply press on the desired color.
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Step 3: You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, press on the menu and

then tap on an option.

Step 4: If using the Color Wheel, first tap on the desired color range within the outside of the wheel view.

Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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Step 5: Perform a Touch/Drag gesture combination or Press on additional options (opacity slider, fill type,

etc.) within the Text Window to make further attribute changes.
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Step 6: The example below shows a figure with text that has been changed from black to blue.
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Note: A color change will be seen instantaneously when text is selected. If text has not been selected, the color

change will apply to all subsequent text entries.
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5.2.13.6. Text Alignment

The Text Alignment option alters the vertical and horizontal positioning of text within it's bounding box. A

figure must be selected to alter the alignment position of entered text.

Use one of the following methods to change the text alignment for a selected figure(s):

Method 1: Press on the Info Button in the Top Toolbar.

Press on the Text Tab to access the Text Alignment options.

Press on one of the horizontal or vertical alignment buttons to make a selection. The currently selected

alignment setting will have a dark grey background. Tap anywhere within the Drawing Canvas to close the

window.
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Method 2: Tapping on a Text Alignment option in the Format Bar.

The following example shows the alteration of text within a figure from a left horizontal alignment to a right

horizontal alignment.
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The currently selected horizontal and vertical alignment choices will appear with a light gray background, as

shown below.
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5.2.13.7. Text Margin

A figure must be selected to alter the Text Margin of entered text. The text margin for a selected figure(s) can

be changed by performing the following:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Press on the Text Tab to access the Text Margin option.

Step 3: Tap on the Plus/Minus Buttons in the Text Tab to increase/decrease the margin by increments of 1 or

press on the number field to enter a new margin value with the keyboard. Tap anywhere in the Drawing Canvas

to close the window.
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5.2.13.8. Text Location

The Text Location slider and percentage field can be used to change the location of text that is attached to a

line or path.

Complete the following steps to change the location of text attached to a line or path:

Step 1: Create a line or path and add text to the figure. In this example, a Path figure has been created within

the drawing.
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Step 2: Press on the Info Button in the Top Toolbar.

Step 3: Press on the Text Tab to access the Text Location option.
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Step 3: Tap on the Attached option to enable it.

Step 4: Use the Slider or Plus (+) and Minus (-) buttons to change the text location.
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In the example below, the text location has been changed to 85%.



Page 812

TouchDraw 2 for iOS

5.2.13.9. Text Orientation

The Text Orientation menu can be used to change the orientation of  text that is attached to a line or path.

Text Orientation can be Absolute or Relative. Absolute is selected by default.

Note: Text Orientation can be changed for all lines and paths in a drawing or for one or more selected lines and

paths.

How to Change the Text Orientation

Complete the following steps to change the orientation of text attached to a line or path:

Step 1: Press on the Info Button in the Top Toolbar.

Step 2: Press on the Text Tab to access the Text Location option.
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Step 3: If not already enabled, tap on the Attached option to enable it.

Step 4: Use the Text Orientation drop-down menu to select an option.
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Path Figure with Absolute Text Orientation

Path Figure with Relative Text Orientation
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5.2.13.10. Adding Variables to Text

A Variable can be added to text within a figure through the Text Editor popover window by hand keying the

desired variable as part of the text.

On a subsequent page, there is a list of available variables.

In the following example, the Area variable is included as part of the selected rectangle's text.

Step 1: Double Tap on a desired figure to open the Text Editor.

Step 2: Enter the appropriate text with the keypad.

Step 3: Expand the Variable Insertion Menu within the Text Editor to select a variable.
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Step 4: For this example, an Area variable will be added to the text within the figure. Press on the Area

Submenu.

Step 5:Tap on the {Area}` option to add an area variable.
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Step 6:Press on Variables to return to the previous menu or Tap within the Text Editor to close the menu.

Step 7: The selected variable shows as the actual value within the selected figure as it is entered. Press on the

Done Button located in the upper right corner of the Text Editor to close it.

Step 8: The final text within the selected figure appears as shown below.
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Text Location and Orientation

Text can be added and attached to a Line and Path Figures. The location and orientation of attached text can be

altered for Line and Path Figures within the Text Tab.
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5.2.13.10.1. Available Variables

TouchDraw 2 supports inserting Variables into a text area. Entered variables are replaced with the actual value

when the drawing is rendered. The table below provides a list of currently supported Text Variables:

Variable Name Variable Type Description

{MinX} Pre-formatted The minimum X-axis position of the figure bounds + the units

abbreviation.

{MaxX} Pre-formatted The maximum X-axis position of the figure bounds + the units

abbreviation.

{MinY} Pre-formatted The minimum Y-axis position of the figure bounds + the units

abbreviation.

{MaxY} Pre-formatted The maximum Y-axis position of the figure bounds + the units

abbreviation.

{Length} Pre-formatted The length of the line (if the text is added to a line or line

connection) + the units abbreviation.

{Width} Pre-formatted The width of the figure bounds + the units abbreviation.

{Height} Pre-formatted The height of the figure bounds + the units abbreviation.

{Area} Pre-formatted The area of the figure + the units abbreviation.

{Dxxxx} Decimal The decimal representation (to 4 decimal points) of one of the 7

variables above where xxxx is the name of the variable.  For

example, {DLength} would return the decimal value of a line

length.

{Fxxxx} Fractional The fractional representation of one of the 7 variables above

where xxxx is the name of the variable.  For example,

{FLength} would return the fractional value of a line length.

{DrawingName} Pre-formatted The name of the current drawing.

{Units} Pre-formatted The abbreviation of the unit of measure specified for the

drawing.
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Variable Name Variable Type Description

{UnitsName} Pre-formatted The full name of the unit of measure specified for the drawing.

{Layer} Pre-formatted The name of the layer that the figure is currently in.

{Date} Date The current date.

5.2.13.10.2. Formatting Date Variables

By default, the {Date} variable will expand into a date formatted in the mm/dd/yyyy (or dd/mm/yyyy for

non-US locales) format as shown in the screenshot below:

The first letter of the entered variable must be capitalized for the value to appear in the selected figure.

TouchDraw 2 allows the exact formatting style to be specified in scenarios where the date must be formatted

differently than the default setting. Use one of the following {Date:format} options to insert a desired

format. Refer to the sample table below:

Variable Description Examples

{Date:d} Default - Short

Date Formatting

6/15/2020 (US)   15/06/2020 (France)   2020/06/15 (Japan)
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Variable Description Examples

{Date:D} Long Date

Formatting

Monday, June 15, 2020 (US)   15      2020  . (Russia)   Montag,

15. Juni 2020 (Germany)

{Date:f} Full Date/Time

(short time)

Formatting

Monday, June 15, 2020 1:45 PM (US)   den 15 juni 2020 13:45

(Sweden)          , 15         2020 1:45    (Greece)

{Date:F} Full Date/Time

(long time)

Formatting

Monday, June 15, 2020 1:45:30 PM (US)   den 15 juni 2020

13:45:30 (Sweden)          , 15         2020 1:45:30    (Greece)

{Date:g} General

Date/Time (short

time) Formatting

6/15/2020 1:45 PM (US)   15/06/2020 13:45 (Spain)

2020/6/15 13:45 (China)

{Date:G} General

Date/Time (long

time) Formatting

6/15/2020 1:45:30 PM (US)   15/06/2020 13:45:30 (Spain)

2020/6/15 13:45:30 (China)

{Date:m} General

Month/Day

Formatting

June 15 (US)   juni 15 (Denmark)   Juni 15 (Indonesia)

{Date:M} General

Month/Day

Formatting

June 15 (US)   juni 15 (Denmark)   Juni 15 (Indonesia)

{Date:o} Round-Trip

Date/Time

Formatting

06-15T13:45:30.0900000

{Date:O} Round-Trip

Date/Time

Formatting

06-15T13:45:30.0900000

{Date:r} RFC1123

Formatting

15 Jun 2020 20:45:30 GMT

{Date:R} RFC1123

Formatting

15 Jun 2020 20:45:30 GMT
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Variable Description Examples

{Date:s} Sortable

Date/Time

Formatting

2020-06-15T13:45:30

{Date:t} Short Time

Formatting

1:45 PM (US)   13:45 (Croatia - Hrvatska)   01:45 (Egypt)

{Date:T} Long Time

Formatting

01:45:30 PM (US)   13:45:30 (Croatia - Hrvatska)   01:45:30

(Egypt)

{Date:u} Universal Sortable

Date/Time

Formatting

2020-06-15 20:45:30Z

{Date:U} Universal Full

Date/Time

Formatting

Monday, June 15, 2020 8:45:30 PM (US)   den 15 juni 2020

20:45:30 (Sweden)          , 15         2020 8:45:30    (Greece)

{Date:y} Year Month

Formatting

June, 2020 (US)   juni 2020 (Denmark)   Juni 2020 (Indonesia)

{Date:Y} Year Month

Formatting

June, 2020 (US)   juni 2020 (Denmark)   Juni 2020 (Indonesia)

In addition to the formatting variables above, you can also use the variable below to create your own custom

date formats. For example, we could do something like the following

{Date:MM/dd/yy H:mm:ss}

which would create something like:

06/10/12 15:24:16

Variable Description Examples

{Date:d} The day of the month, from

1 through 31.

6/1/2020 1:45:30 PM -> 1   6/15/2020 1:45:30 PM ->

15
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Variable Description Examples

{Date:dd} The day of the month, from

01 through 31.

6/1/2020 1:45:30 PM -> 01   6/15/2020 1:45:30 PM

-> 15

{Date:ddd} The abbreviated name of the

day of the week.

6/15/2020 1:45:30 PM -> Mon (US)   6/15/2020

1:45:30 PM ->    (Russia)   6/15/2020 1:45:30 PM ->

lun. (France)

{Date:dddd} The full name of the day of

the week.

6/15/2020 1:45:30 PM -> Monday (US)   6/15/2020

1:45:30 PM ->             (Russia)   6/15/2020 1:45:30

PM -> lundi (France)

{Date:f} The tenths of a second in a

date and time value.

6/15/2020 13:45:30.617 -> 6   6/15/2020

13:45:30.050 -> 0

{Date:ff} The hundredths of a second

in a date and time value.

6/15/2020 13:45:30.617 -> 61   6/15/2020

13:45:30.005 -> 00

{Date:fff} The milliseconds in a date

and time value.

6/15/2020 13:45:30.617 -> 617   6/15/2020

13:45:30.0005 -> 000

{Date:ffff} The ten thousandths of a

second in a date and time

value.

6/15/2020 13:45:30.6175 -> 6175   6/15/2020

13:45:30.00005 -> 0000

{Date:fffff} The hundred thousandths of

a second in a date and time

value.

6/15/2020 13:45:30.61754 -> 61754   6/15/2020

13:45:30.000005 -> 00000

{Date:ffffff} The millionths of a second

in a date and time value.

6/15/2020 13:45:30.617542 -> 617542   6/15/2020

13:45:30.0000005 -> 000000

{Date:fffffff} The ten millionths of a

second in a date and time

value.

6/15/2020 13:45:30.6175425 -> 6175425   6/15/2020

13:45:30.0001150 -> 0001150

{Date:F} If non-zero, the tenths of a

second in a date and time

value.

6/15/2020 13:45:30.617 -> 6   6/15/2020

13:45:30.050 -> (no output)

{Date:FF} If non-zero, the hundredths

of a second in a date and

6/15/2020 13:45:30.617 -> 61   6/15/2020

13:45:30.005 -> (no output)
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Variable Description Examples

time value.

{Date:FFF} If non-zero, the milliseconds

in a date and time value.

6/15/2020 13:45:30.617 -> 617   6/15/2020

13:45:30.0005 -> (no output)

{Date:FFFF} If non-zero, the ten

thousandths of a second in a

date and time value.

6/1/2020 13:45:30.5275 -> 5275   6/15/2020

13:45:30.00005 -> (no output)

{Date:FFFFF} If non-zero, the hundred

thousandths of a second in a

date and time value.

6/15/2020 13:45:30.61754 -> 61754   6/15/2020

13:45:30.000005 -> (no output)

{Date:FFFFFF} If non-zero, the millionths

of a second in a date and

time value.

6/15/2020 13:45:30.617542 -> 617542   6/15/2020

13:45:30.0000005 -> (no output)

{Date:FFFFFFF} If non-zero, the ten

millionths of a second in a

date and time value.

6/15/2020 13:45:30.6175425 -> 6175425   6/15/2020

13:45:30.0001150 -> 000115

{Date:g},

{Date:gg}

The period or era. 6/15/2020 1:45:30 PM -> A.D.

{Date:h} The hour, using a 12-hour

clock from 1 to 12.

6/15/2020 1:45:30 AM -> 1   6/15/2020 1:45:30 PM

-> 1

{Date:hh} The hour, using a 12-hour

clock from 01 to 12.

6/15/2020 1:45:30 AM -> 01   6/15/2020 1:45:30 PM

-> 01

{Date:H} The hour, using a 24-hour

clock from 0 to 23.

6/15/2020 1:45:30 AM -> 1   6/15/2020 1:45:30 PM

-> 13

{Date:HH} The hour, using a 24-hour

clock from 00 to 23.

6/15/2020 1:45:30 AM -> 01   6/15/2020 1:45:30 PM

-> 13

{Date:m} The minute, from 0 through

59.

6/15/2020 1:09:30 AM -> 9   6/15/2020 1:09:30 PM

-> 9

{Date:mm} The minute, from 00

through 59.

6/15/2020 1:09:30 AM -> 09   6/15/2020 1:09:30 PM

-> 09
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Variable Description Examples

{Date:M} The month, from 1 through

12.

6/15/2020 1:45:30 PM -> 6

{Date:MM} The month, from 01 through

12.

6/15/2020 1:45:30 PM -> 06

{Date:MMM} The abbreviated name of the

month.

6/15/2020 1:45:30 PM -> Jun (US)   6/15/2020

1:45:30 PM -> juin (France)   6/15/2020 1:45:30 PM

-> Jun (South Africa)

{Date:MMMM} The full name of the month. 6/15/2020 1:45:30 PM -> June (US)   6/15/2020

1:45:30 PM -> juni (Denmark)   6/15/2020 1:45:30

PM -> uJuni (South Africa)

{Date:s} The second, from 0 through

59.

6/15/2020 1:45:09 PM -> 9

{Date:ss} The second, from 00

through 59.

6/15/2020 1:45:09 PM -> 09

{Date:t} The first character of the

AM/PM designator.

6/15/2020 1:45:30 PM -> P (US)   6/15/2020 1:45:30

PM ->   (Japan)   6/15/2020 1:45:30 PM -> (France)

{Date:tt} The AM/PM designator. 6/15/2020 1:45:30 PM -> PM (US)   6/15/2020

1:45:30 PM ->    (Japan)   6/15/2020 1:45:30 PM ->

(France)

{Date:y} The year, from 0 to 99. 1/1/0001 12:00:00 AM -> 1   1/1/0900 12:00:00 AM

-> 0   1/1/1900 12:00:00 AM -> 0   6/15/2009 1:45:30

PM -> 9

{Date:yy} The year, from 00 to 99. 1/1/0001 12:00:00 AM -> 01   1/1/0900 12:00:00 AM

-> 00   1/1/1900 12:00:00 AM -> 00   6/15/2009

1:45:30 PM -> 09

{Date:yyy} The year, with a minimum

of three digits.

1/1/0001 12:00:00 AM -> 001   1/1/0900 12:00:00

AM -> 900   1/1/1900 12:00:00 AM -> 1900

6/15/2009 1:45:30 PM -> 2009

{Date:yyyy} The year as a four-digit

number.

1/1/0001 12:00:00 AM -> 0001   1/1/0900 12:00:00

AM -> 0900   1/1/1900 12:00:00 AM -> 1900
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Variable Description Examples

6/15/2009 1:45:30 PM -> 2009

{Date:yyyyy} The year as a five-digit

number.

1/1/0001 12:00:00 AM -> 00001   6/15/2009 1:45:30

PM -> 02009

{Date:z} Hours offset from UTC,

with no leading zeros.

6/15/2020 1:45:30 PM -07:00 -> -7

{Date:zz} Hours offset from UTC,

with a leading zero for a

single-digit value.

6/15/2020 1:45:30 PM -07:00 -> -07

{Date:zzz} Hours and minutes offset

from UTC.

6/15/2020 1:45:30 PM -07:00 -> -07:00

{Date::} The time separator. 6/15/2020 1:45:30 PM -> : (US)   6/15/2020 1:45:30

PM -> . (Italy) 6/15/2020 1:45:30 PM -> : (Japan)

{Date:/} The date separator. 6/15/2020 1:45:30 PM -> / (US)   6/15/2020 1:45:30

PM -> - (Algeria)

5.2.13.10.3. Formatting Decimal Values

The Decimal Variable can be inserted as part of entered text to show the value of another variable in decimal

form within the text of a figure. Refer to the Text Variable Table for a list of all supported variables.

Any of the listed pre-formatted numerical variables can have a "D" placed in front of it (as long as they

correspond with the type of selected figure) to insert the value as a decimal. The following screenshot shows an

example of this:
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Both the D and first letter of the entered variable must be capitalized for the value to appear in the selected

figure.

By default, the decimal value will be presented with at most 4 digits after the decimal point. An alternative

formatting style can be specified by using the {Dxxxx:format} pattern. The table below outlines the

options for formatting the decimal value.

Format Specifier Name Description Examples

0 Zero Placeholder Replaces the zero with the corresponding

digit if one is present, otherwise zero

appears in the result.

Width =

1234.5678

Variable =

{DWidth:00000}

   Result =

01234      Width =

0.45678   Variable

=

{DWidth:0.00}

   Result = 0.46

# Digit Placeholder Replaces the pound sign with the

corresponding digit if one is present;

Width =

1234.5678
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Format Specifier Name Description Examples

otherwise, no digit appears in the result

string.

Variable =

{DWidth:\#\#\#\#\#}

   Result = 1234

Width = 0.45678

Variable =

{DWidth:\#.\#\#}

   Result = .46

. Decimal Point Determines the location of the decimal

separator in the result string.

Width = 0.45678

Variable =

{DWidth:0.00}

   Result (US) =

0.46  Width =

0.45678   Variable

=

{DWidth:0.00}

   Result

(Germany) = 0,46

, Group Separator Inserts a group separator character

between each group.

2147483647 ("#

#,#") =

2,147,483,647

(US) 2147483647

("# #,#") =

2.147.483.647

(Estonia)

, Number Scaling Divides a number by 1000 for specified

commas.

2147483647

("#,#,,") = 2,147

(US) 2147483647

("#,#,,") =  2.147

(Estonia)

% Percent

Placeholder

Multiplies a number by 100 and inserts a

localized percentage symbol in the result

string.

0.03697

("%,#0.00") =

%36.97 (US)

0.03697
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Format Specifier Name Description Examples

("%,#0.00") =

%36,97 (Greece)

0.03697 ("#

#.0%") = 37.0%

(US) 0.03697 ("#

#.0%") = 37,0%

(Greece)

‰ Per Mille

Placeholder

Multiplies a number by 1000 and inserts

a localized per mille symbol in the result

string.

0.03697 ("#

0.00‰") =

36.97‰ (US)

0.03697 ("#

0.00‰") =

36,97‰ (Russia)

EO, E+0, E-0, e0,

e+0, e-0

Exponential

Notation

Zero - Formats in exponential notation.

E/e - Indicates case of the exponent

symbol in the resulting string. Plus Sign -

Indicates that the sign character precedes

the exponent. Minus Sign - Indicates that

a sign character precedes only negative

exponents. The number of zeros

following the E/e symbol determines the

minimum number of digits in the

exponent (Must have at least one zero).

987654 ("#

0.0e0") = 98.8e4

1503.92311 ("0.0

# # e +00") =

1.504e+03

18901385E-16

("0.0e +00") =

1.9e-16

\ Escape Character Next character interpreted as a literal

rather than custom format specifier.

987654 ("\# # #

00\#") = #987654#

'string', "string" Literal String

Delimiter

Indicates that the enclosed characters

should be copied to the result string

without changes.

68 ("# ' degrees'")

= 68 degrees 68

("# ' degrees'") =

68 degrees

; Section Separator Defines sections using separate format

strings for positive, negative, and zero

numbers.

12.345 ("# 0.0#;

(#0.0#); -\0-") =

12.35 0 ("# 0.0#;
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Format Specifier Name Description Examples

(#0.0#); -\0-") =

-0- -12.345 ("#

0.0#; (#0.0#);

-\0-") = (12.35)

12.345 ("# 0.0#;

(#0.0#)") = 12.35

0 ("# 0.0#;

(#0.0#)") = 0.0

-12.345 ("# 0.0#;

(#0.0#)") = (12.35)

Other All Other

Characters

The character is copied to the result

string unchanged.

68 (" # °") = 68 °

5.2.13.10.4. Formatting Fractional Values

The Fractional Variable can be inserted as part of entered text to show the value of another variable in

fractional form within the text of a figure. Refer to the Text Variable Table for a list of all supported variables.

Any of the listed pre-formatted numerical variables can have an "F" placed in front of it (as long as they

correspond with the type of selected figure) to insert the value as a fraction. The following screenshot shows an

example of this:
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Additional format specifiers may be added at the end of the variable to alter the number of shown placeholders

of a fractional value or to round the supplied value.

Rounding is accomplished by placing a semi-colon (:) after the variable followed by either #.### or #.000. The

screenshots below are two examples of ways to round a fractional value in the Text Editor.
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Both the F and first letter of the entered variable must be capitalized for the value to appear in the selected

figure.

By default, the numerator and denominator making up the fractional value will be presented with at most three

digits. An alternative formatting style can be specified by using the {Fxxxx:format} pattern. The table

below outlines the options for formatting the fractional value.

Format Specifier Name Description Examples

0 Zero Placeholder Replaces the zero with the

corresponding digit if one is

present, otherwise zero

appears in the result.

Length = 4 148/249   Variable

=    Result = 5      Length = 4

148/249   Variable =    Result =

4 63/100

# Digit Placeholder Replaces the pound sign

with the corresponding digit

if one is present; otherwise,

no digit appears in the

result string.

Length = 4 148/249   Variable =

{FLength:#####}   Result =

5      Length = 4 148/249

Variable = {FLength:#.##}

Result = 4 63/100

. Decimal Point Determines the location of Length = 4 148/249   Variable
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Format Specifier Name Description Examples

the fractional separator in

the result string.

=    Result (US) = 4 63/100

Other All Other

Characters

The character is copied to

the result string unchanged.

68 (" # °") = 68 °
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5.2.14. Handling Paths

TouchDraw 2 supplies multiple actions for altering handles or segments within a created path. A handle may be

inserted or deleted at any point within the path and a figure can be split at a selected handle.

Segments may be removed from a figure or converted to a line, quadratic curve, or cubic curve segment by

adding or deleting corresponding control points. These additional actions are available for altering an existing

figure:

• Opening a Path

• Closing a Path

• Joining Lines and Paths

• Trimming Lines and Paths

• Reversing Lines and Paths

• Splitting Segments

• Creating and Separating Compound Paths

• Conversion of Shape or Text Figure(s) to Paths

A control point is displayed in gray when it has not been used and is referred to as a "phantom" control point.

This characteristic provides a hint to the TouchDraw 2 application that it should function as a control point in

scenarios where the next drawn segment is a curve.

A few basic actions can be used to alter the "phantom" control point position as a path is edited. Refer to the

sections below to learn more about each available action.

Touch/Drag

A Touch/Drag gesture combination on any position in the Drawing Canvas creates the end handle of a curve

segment in relevance to the current "phantom" control point position. The "phantom" control point is

re-positioned in accordance to the newly created end handle while this action occurs.
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Option/Tap

Double Tap and Hold on the empty portion of the Drawing Toolbar to activate the option gesture

combination. The Drawing Toolbar will turn blue if this combination has been performed correctly, as shown

below.
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An Option/Tap combination allows the "phantom" control point position to be set to a desired location on the

Drawing Canvas after a curve segment has been created.

Option/Touch/Drag

An Option/Touch/Drag combination allows the "phantom" control point to be dragged to any point on the

Drawing Canvas and changes a corner point back to a smooth curve after a curve segment has been created.

Text Location and Orientation

Text can be added and attached to a Path Figure. The location and orientation of attached text can be altered for

Path Figures within the Text Tab.
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5.2.14.1. Opening a Path

TouchDraw 2 supplies options for opening and closing an existing path. A path can be opened to make

individual alterations such as segment additions. Follow the steps below to open a currently closed path:

Step 1:Select the path to be opened.

Step 2: Press on the Modify Menu.

Step 3: Then tap on Open Path in the Paths Section of the Modify Menu.
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Step 4: The end/start handle of the closed path is separated into two individual handles. Once a path has been

opened, the connecting segments are treated as individual path segments.

They can be moved or expanded to any point on the Drawing Canvas, have handles added, be converted to a

quadratic or curve segment, and be combined with additional paths.
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5.2.14.2. Closing a Path

The Close Path option draws a straight line segment from the last segment end handle to the path start handle

to close an open path. Follow the steps below to close a currently open path:

Step 1:Select the path to be closed.

Step 2: Press on the Modify Menu.

Step 3: To access the Close Path option in the Modify Menu when in Landscape Mode, scroll through the

menu view by touching and dragging in an upward direction.

Tap on the Close Path option in the Paths Section of the menu to select it and then tap anywhere within the

Drawing Canvas to close the menu.
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Step 4: A straight line segment will be drawn from the last segment end point to the start handle of the chosen

path.
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Note: A straight line segment can be converted to a quadratic or cubic curve segment by using the Contextual

Menu.
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5.2.14.3. Joining Lines and Paths

The Join Paths option allows the intersecting end points of two or more selected lines or paths to be joined to

form a single path. A minimum of two intersecting lines or paths must be selected for a join to occur. Follow

the steps below to join two line end points:

Step 1: Create two lines on the Drawing Canvas using the Line Tool and then select both line figures by using

the Function Key Feature.
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Step 2: Press on the Modify Menu.

Step 3: To access the Join Paths option in the Modify Menu when in Landscape Mode, scroll through the

menu view by touching and dragging in an upward direction.

Tap on the Join Paths option in the Paths Section of the menu to select it and then tap anywhere within the

Drawing Canvas to close the menu.

Step 4: The line end points are joined to create two path segments with corresponding end points (orange), a

start handle (orange circle with white center), and a rotation handle (red).
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Note: To learn more about the types of handles used within TouchDraw 2, refer to the Handles Reference

Table.

Additional lines can be included as part of the join by adding another line object and repeating the above steps.

Two or more path end points may also be combined with the Join Paths menu option. Follow the steps below

to join two path end points:

Step 1: Create two paths with at least one shared segment end point on the Drawing Canvas using the Path Tool

 and then select both paths by using the Function Key Feature.
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Step 2: Press on the Modify Menu.

Step 3: Perform a Touch/Drag gesture combination in a downward manner to access the Join Paths option in

the Modify Menu.

Tap on the Join Paths option to select it and then tap anywhere within the Drawing Canvas to close the menu.
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Step 4: As shown below, the intersecting end points are joined to form a single segment end point (orange) and

a new start point handle (orange with white dot) is added to the beginning of the first selected path to visually

indicate the formation of a single path. To learn more about the types of handles used within TouchDraw 2,

refer to the Handles Reference Table.
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Note: Intersecting path and line end points can be joined in the same manner as shown above.
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5.2.14.4. Trimming Lines and Paths

The Trim Lines/Paths option trims a line or path when it intersects near it's end with another shape or line.

TouchDraw 2 considers "near" to be when an intersection is within the first or last eighth (1/8th) of the line. If

the intersection is within the middle 6/8ths, then the line is not trimmed.

Follow the steps below to trim the ends of intersecting lines or paths:

Step 1:Select the items to be trimmed.

Step 2: Press on the Modify Menu.
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Step 3: To access the Trim Lines/Paths option in the Modify Menu when in landscape mode, scroll through

the menu view by touching and dragging in an upward direction. Tap on the Trim Lines/Paths option to select

it and then tap anywhere within the Drawing Canvas to close the menu.

Step 4: All lines or paths intersecting within the last 1/8th are trimmed. In this example, the additional portions

of both lines are trimmed to make a perfect right angle.
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5.2.14.5. Reversing Lines and Paths

The Reverse Lines/Paths menu item flips or reverses the direction of the decorations (arrowhead, diamond,

square, etc.) within selected lines and/or paths.

Follow the steps below to reverse the ends of lines and/or paths:

Step 1:Select the lines and/or paths to be reversed.
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Step 2: Press on the Modify Menu.

Step 3: To access the Reverse Lines/Paths option in the Modify Menu, when in landscape mode, scroll

through the menu view by touching and dragging in an upward direction.Tap on the Reverse Lines/Paths

option to select it and then tap anywhere within the Drawing Canvas to close the menu.
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Step 4: All decorations for the selected lines and/or paths will be reversed.
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5.2.14.6. Splitting Segments

The segments of a path can be split into individual segments. Follow the steps below to Split All Segments

within a selected path(s):

Step 1:Select the path to be split.

Step 2: Press on the Modify Menu.

Step 3: To access the Split All Segments option in the Modify Menu when in landscape mode, scroll through

the menu view by touching and dragging in an upward direction. Tap on the Split All Segments option to

select it and then tap anywhere within the Drawing Canvas to close the menu.
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Step 4: As shown below, specific visual indicators are changed to show that all segments have been separated

within a path and are able to be moved or altered as individual objects. Segment end point handles (orange) are

changed to a bounds handle (blue).

The start handle (orange with white center) remains at one end of each split segment since they are still

considered by the application to be a path and the control points (green) are left untouched to allow for

alterations to existing quadratic or cubic curve segments. To learn more about handles, refer to the Handles

Reference Table.
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Step 5: Touch and Drag on a bounds handle (blue) to move or resize a segment. Attribute alterations are made

just as with any other created figure on the Drawing Canvas.
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Note: The Join Paths option can be used to connect segments after changes have been made.
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5.2.14.7. Creating a Compound Path

The Make Compound Path option can be used to combine two or more paths into one figure (compound path)

that shares the same attributes and is treated as one object. At least two paths must be selected for this option to

be available. Follow the steps below to create a compound path:

Step 1: Select the paths to be combined.
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Step 2: Press on the Modify Menu.

Step 3: To access the Make Compound Path option in the Modify Menu when in Landscape Mode, scroll

through the menu view by touching and dragging in an upward direction.

Tap on the Make Compound Path option to select it and then tap anywhere within the Drawing Canvas to

close the menu.

Step 4: The two paths are combined to form a Compound Path with shared bounds handles (blue) and a shared

rotation handle (red). Attribute changes now affect both paths as if they were a single path.
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For example, if the Fill Color is changed to red, all paths included in the Compound Path are altered to have

this attribute. Refer to the images below:

If the top handle of the triangle is dragged into the other compound figure, the intersecting portion of these two

paths will appear in white.
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An attribute change of Stroke Color to blue with a Stroke Size increase alters the attribute for every segment in

the Compound Path.

The addition of a Shadow with a Rotation Angle of twenty degrees would result in the image below.
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5.2.14.8. Separating a Compound Path

The Separate Compound Path option separates a compound path into it's individual paths. Follow the steps

below to separate a compound path:

Step 1:Select the compound path.

Step 2: Press on the Modify Menu.

Step 3: To access the Separate Paths option in the Modify Menu when in Landscape Mode, scroll through the

menu view by touching and dragging in an upward direction.

Tap on the Separate Paths option to select it and then tap anywhere within the Drawing Canvas to close the

menu.
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Step 4: The previously combined paths are now two individual paths, which can be altered separately.
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Attribute changes will be applied to the selected path only rather than both paths. For example, if the Fill Color

of the bottom path is changed to black, the upper path remains red. Refer to the image below:
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5.2.14.9. Converting Shapes to Paths

The Convert to Path option allows a selected shape(s) on the Drawing Canvas to be converted into a path

figure. Follow the steps below to convert a shape to a path:

Step 1:Select the shape to be converted.

Step 2: Press on the Modify Menu.

Step 3: To access the Convert To Path option in the Modify Menu when in Landscape Mode, scroll through

the menu view by touching and dragging in an upward direction.

Tap on the Convert To Path option in the Conversion Section of the menu to select it and then tap anywhere

within the Drawing Canvas to close the menu.
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Step 4: Each individual segment used to create the shape will be converted into a path segment with

corresponding segment end point handles (orange). A start handle (orange with white dot) shows the initial

starting point of the path. New bounds handles (blue) are assigned in relation to the created path and control

point handles (green) are added to each curved segment.
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Any attribute changes available for a path can be performed on the converted object. For example, the upper

right curve of the rounded rectangle can be dragged to another location to alter its size or shape. In the image

below, both upper right control points have been moved down and to the center of the figure.
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Perform a Touch/Drag gesture combination on one of the bounds handles (blue) to alter the size of the path. In

the example below, the upper right bounds corner has been drug upward and to the right to create a larger

figure.
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Perform a Touch/Drag gesture combination on a segment end point handle (orange) to alter the size of

individual path segments. In the image below the circled segment end point handle has been dragged

downward and to the left within the path object to create the shown change.
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Note: Refer to the Handles Reference Table to learn more about individual handles used within TouchDraw 2.

Note: Additional information about altering paths can be found in the Handling Paths section of this

documentation.
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5.2.14.10. Converting Text to a Path

The Convert Text to Path option converts a selected text figure(s) to a path. Size, color, rotation, scaling, and

moving alterations are performed as a path rather than by using the traditional text figure selection methods.

Follow the steps below to convert a text figure to a path:

Step 1:Select the text figure to be converted.

Step 2: Press on the Modify Menu.

Step 3: To access the Convert Text To Paths option in the Modify Menu when in Landscape Mode, scroll

through the menu view by touching and dragging in an upward direction.

Tap on the Convert Text To Path option in the Conversion Section of the menu to select it and then tap

anywhere within the Drawing Canvas to close the menu.
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Step 4: The selected text figure is converted to a path figure.

Step 5: Perform a Touch/Drag gesture combination on a bounds handle (blue) to alter path size. In the images

below, the bottom right bounds handle is dragged downward and to the right to increase the overall size of the

path.

Step 6: Attribute changes are performed in the same manner as figures created with the Path Tool. For

example, a Fill Color change to blue would result in the following image.
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Step 7: The added rotation handle (red) can be dragged clockwise or counterclockwise with a Touch/Drag

gesture combination to change the angle of the newly created path.

Step 8: A converted path can be moved to any location on the Drawing Canvas or Scaled to a specific size. In

this example, Factor X is changed from two to three.
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Step 9:Stroke and Shadow attributes may also be altered to change the look of the path. In the example below,

a shadow has been added and the color has been set to light red.
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5.2.14.11. Delete Handle

TouchDraw 2 supports the insertion and deletion of handles or segments from an existing path. A different

behavior is received depending on the type of handle chosen for deletion:

• Cubic Curve Control Point Handle - Segment is converted to a quadratic curve segment upon deletion.

• Quadratic Curve Control Point Handle - Segment is converted to a line segment upon deletion.

• Segment End Point - The entire segment is removed including the control points (cubic or quadratic
curves).

Depending on the desired operation, Touch and Hold on a path handle or a path segment to bring up the

Contextual Menu, as shown below:

Note: Available contextual menu options change depending on the type of selected segment or handle.

Follow the steps below to delete a Path Handle:

Step 1: Touch and Hold on the desired handle to select it and open the Contextual Menu. In this example, the

Quadratic Curve Control Point Handle (indicated by the color green) is being removed from the path.
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Step 2: Tap on the Delete Handle option.

Step 3: The selected Quadratic Curve Control Point Handle is removed and the segment is converted into a
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Line Segment .

Follow the steps below to delete a Path Segment Handle:

Step 1: Touch and Hold on the desired Segment End Point to open the Contextual Menu. In this example,

the bottom left Segment End Point is chosen for deletion.
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Step 2: Tap on the Delete Handle option.
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Step 3: The selected handle and segment are removed, as shown below.
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Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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5.2.14.12. Split at Handle

The Split at Handle action divides a path into two separate sections at the chosen handle and allows each

section to be altered as an individual figure.

In the following example, the End Point Handle located at the bottom right of the path is chosen.

Step 1: Touch and Hold on the desired End Point Handle to select it and open the Contextual Menu.

Step 2: Tap on the Split at Handle option.
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Step 3: The path is now separated at the chosen End Point Handle, as shown below.

Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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5.2.14.13. Insert Handle

TouchDraw 2 supports the insertion and deletion of handles or segments from an existing path. A different

behavior is received depending on the type of segment chosen for handle insertion:

• Line Segment - The inserted handle splits the line segment into two connected lines.

• Quadratic Curve Segment - The inserted handle splits the quadratic curve into two quadratic curves and
the shape of the original curve is maintained.

• Cubic Curve Segment - The inserted handle splits the cubic curve into two cubic curves and the shape of
the original curve is maintained.

Depending on the desired operation, Touch and Hold on a path handle or a path segment to bring up the

Contextual Menu, as shown below:

Available contextual menu options change depending on the type of selected segment or handle.
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A new handle can be inserted into a segment or at the same location as an existing handle. In the provided

example, the bottom line segment is chosen for a handle addition.

Follow the steps below to insert a handle or segment into a path:

Step 1: Touch and Hold on the desired handle or segment to select it and open the Contextual Menu.

Step 2: Tap on the Insert Handle option.



Page 894

TouchDraw 2 for iOS

Step 3: A new Segment End Point Handle appears in the center of the selected line segment and can be used

to alter the path.
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Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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5.2.14.14. Delete Segment

The Delete Segment action removes a selected segment from an existing path. A different behavior is received

depending on the type of segment chosen for handle insertion:

• Line Segment- The entire segment is removed.

• Quadratic Curve Segment - The entire segment and corresponding quadratic control point are removed.

• Cubic Curve Segment - The entire segment and all cubic curve control points are removed.

In the provided example, the bottom Line Segment of the figure is chosen. Follow the steps below to delete a

segment:

Step 1: Touch and Hold on the desired segment to select it and open the Contextual Menu.

Step 2: Tap on the Delete Segment option.
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Step 3: The Line Segment and corresponding end point (orange) are removed. The remaining segment end

points are joined.

The following screenshots show the resulting control point and segment changes when a Cubic Curve Segment

is deleted from a figure. In this example, the top cubic curve is chosen for deletion. The selected segment and

both control points are removed.
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Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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5.2.14.15. Segment to Line

The Segment To Line action will convert either a quadratic or a cubic curve segment into a straight line

segment. Essentially, it discards the control points of the curve.

In the provided example, a Quadratic Curve Segment is changed to a Line Segment. Follow the steps below:

Step 1: Touch and Hold on the desired segment to select it and open the Contextual Menu.

Step 2: Tap on the Segment to Line option.
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Step 3: The control point (green) of the Quadratic Curve Segment is removed and the segment is changed to a

Line Segment to create a rectangle, as shown below.

The following screenshots show the resulting line when the Segment to Line action is performed on a Cubic

Curve Segment.
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Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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5.2.14.16. Segment to Quad

The Segment to Quad action will convert either a Line Segment or Cubic Curve to a Quadratic Curve

Segment. A different behavior is received when the handle is inserted depending on the chosen segment type:

• Line Segment - A curve control point will be inserted at the center point of the line and can be used to
create the exact desired quadratic.

• Cubic Curve Segment - The two control points of the cubic curve segment will be averaged to create a
new control point for the quadratic curve, which is replacing the cubic curve.

In the provided example, the Line Segment located on the right side of the figure is converted into a

Quadratic Curve Segment. Follow the steps below:

Step 1: Touch and Hold on the desired segment to select it and open the Contextual Menu.

Note: The Segment to Quad option will only appear in the Contextual Menu if a Line Segment or Cubic

Curve Segment has been selected.

Step 2: Tap on the Segment to Quad option.
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Step 3: A Quadratic Curve Control Point (green) is added to the center of the selected segment.

Step 4: Perform a Touch/Drag gesture combination on the Quadratic Curve Control Point to create the

desired curve segment. In this example, the control point is dragged to the bottom.
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The following screenshots show the resulting control point and line changes when a Cubic Curve Segment is

converted to a Quadratic Curve Segment.

In this example, the top cubic curve is chosen for conversion. The two existing Cubic Curve Control Points

(green) are averaged to generate a single Quadratic Curve Control Point.
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The provided Quadratic Curve Control Point can be moved in any direction by performing a Touch/Drag

gesture combination. In this example, the new control point is dragged upward.

Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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5.2.14.17. Segment to Cubic

The Segment to Cubic action will convert either a line or quadratic curve into a cubic curve segment. A

different behavior is received depending on the type of segment chosen for handle insertion:

• Line Segment- Two curve control points will be inserted at the 40% and 60% locations along the line and
can be used to create the exact desired cubic curve.

• Quadratic Curve Segment - The shape of the quadratic curve will be approximated with a new cubic curve
segment.

In the provided example, the Line Segment located on the bottom of the figure is converted into a Cubic

Curve Segment. Follow the steps below:

Step 1: Touch and Hold on the desired segment to select it and open the Contextual Menu.

Note: The Segment to Cubic option will only appear in the Contextual Menu if a Line Segment or Quadratic

Curve Segment has been selected.

Step 2: Tap on the Segment to Cubic option.
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Step 3: Two Cubic Curve Control Points (green) are inserted at the 40% and 60% locations on the chosen

Line Segment.

Step 4: Perform a Touch/Drag gesture combination to move either Cubic Curve Control Point in any

direction. In this example, the left control point is dragged upward and the right control point is dragged

downward. Refer to the images below:
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The following screenshots show the resulting control point and line changes when a Quadratic Curve

Segment is converted to a Cubic Curve Segment. In this example, the top cubic curve is chosen for

conversion. The Quadratic Curve Control Point (green) is approximated to create two Cubic Curve Control

Points and the associated segment.
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The provided Cubic Curve Control Points can be moved in any direction by performing a Touch/Drag

gesture combination. In this example, the left control point is dragged downward and to the right. The right

control point is dragged upward and to the left to create the desired Cubic Curve.

Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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5.2.14.18. Grouping a Path

Once a complex path has been created and all control points are in their appropriate place, it is recommended to

group the path using the Group function available under the Arrange Menu.

This will allow the path or path figure to be stretched, resized and moved without having to worry about

changing the points. The following screenshots show a before and after for the Fleur de Lis example drawing

included with TouchDraw 2.

The path figure is the only figure that is allowed to be grouped by itself. Normally, one or more figures must be

selected before a Group can be created.



Page 911

TouchDraw 2 for iOS

5.2.15. Handling Layers

Layers provide the capability to incorporate more than one level of objects into a drawing. Each added layer

builds on top of the previous created layer to create a multi-dimensional drawing.

They are managed and controlled through the Layers Button located in the Top Toolbar of the Drawing

Editor, as shown below.

The Layers Menu will appear as shown below after the Layers Button has been pressed.

Layers can be added, renamed, merged, duplicated, deleted, sorted, locked, and hidden within the TouchDraw

2 application.
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5.2.15.1. Adding a Layer

A Layer can be added in one of two ways:

Method 1: Press on the Layers Settings Menu menu and then Tap on the Add Layer option.

Method 2: Tap on the Add Button located at the top right of the Layers List.
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The new layer will be added to the top of the list and appear as shown below:
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5.2.15.2. Duplicating a Layer

A Layer can be duplicated to create another layer with the same objects and properties. Follow the steps below

to duplicate a selected layer:

Step 1: Tap on the layer to select it within the Layers List. The currently chosen layer will be highlighted with

a gray background.

Step 2: Press on the Layers Settings Menu and then Tap on Duplicate Layer.
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Step 3: The duplicated layer will appear above the original and can be renamed, re-ordered, merged, or deleted.
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5.2.15.3. Re-ordering Layers

A selected layer may be moved up or down in the Layers List using the Layers Settings Menu.

Tap on a layer in the Layers List to select it and then Press on the Layers Settings Menu to choose from

available re-ordering functions.

A Layer can be moved up or down and this action will alter the layering positions in the Drawing Canvas.

Layers can be re-ordered by using a Press/Drag combination to another location or by using one of the

methods shown below.

Use the Move Layer Up menu option to move the selected layer up by one in the Layers List.
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Use the Move Layer Down option to move the selected layer down by one in the Layers List.
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Note: The Move Layer Up option will only be enabled when a layer resides above the selected one in the

Layers List. The Move Layer Down menu option will only be enabled when a layer resides below the selected

one in the list.
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5.2.15.4. Merging Layers

Tap on a layer in the Layers List to select it and then Press on the Layers Settings Menu menu to choose from

available merging functions.

A Layer can be merged up or down in Layers List and this action will combine the Drawing Canvas contents

and properties of the selected layer with the one above or below it depending on the made selection. An

additional option is available for merging all layers in a drawing.

Use the Merge Layer Up menu option to merge the selected layer with the one residing above it in the Layers

List. In this example, Layer 2 has been selected and will be merged up with Layer 3.
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Use the Merge Layer Down option to merge the selected layer with the one residing below it in the Layers

List. In this example, Layer 3 has been selected and will be merged down with Layer 2.
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The Merge All Layers function combines every layer of a drawing showing in the Layers list.
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Note: The Merge Layer Up and Merge Layer Down menu choices are only enabled when a layer resides

above or below the selected one. More than one layer must be present in the Layer list for the Merge All

Layers menu choice to be enabled.
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5.2.15.5. Renaming a Layer

A layer can be named or renamed in one of two ways:

Method 1: Tap on the layer in the Layers List to select it and then Press on the Layers Settings Menu to

access available options. Then Tap on the Rename Layers option.
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Method 2: Perform a Double Tap on the layer in the Layers List.

Then complete the following steps to rename the layer:

Step 1: Enter the desired name and then Tap on Rename Layer.

Step 2: The layer will appear as shown below:
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5.2.15.6. Deleting a Layer

A Layer can be deleted in two ways:

Method 1: Tap on a layer in the list to select it and then press on the Layers Settings Menu menu to choose the

Delete Layer option.

Method 2: Tap on a layer in the list to select it and then Press on the Delete Button (Minus) located at the top

right of the Layers List.
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The layer will be removed, as shown below:
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5.2.15.7. Sorting Layers

Layers within a drawing can be sorted in ascending or descending order alphabetically by name.

Sort Layers in Ascending Order Alphabetically by Name

Step 1: Press on the Layers Settings Menu.

Step 2:Tap on Sort Layers (Ascending) within the menu.

The layers within the drawing are now sorted in ascending order alphabetically by name.
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Sort Layers in Descending Order Alphabetically by Name

Step 1: Press on the Layers Settings Menu.

Step 2:Tap on Sort Layers (Descending) within the menu.

The layers within the drawing are now sorted in descending order alphabetically by name.
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5.2.15.8. Layer Visibility

The Visibility option is an "On/Off" toggle button for setting the visibility of each created layer. It appears to

the right of each layer name in the list as an "eye" icon and indicates the visibility of the layer.

To hide (or show) a layer, simply Tap on the eye icon of the layer to be toggled. An eye icon with a line

through it indicates that a particular layer is not visible, whereas an eye with no line indicates a layer is visible.

The Layers Settings Menu provides additional options for changing the visibility of all layers residing within a

drawing.

To access these options, press on the Layer Settings Menu in the Layers Menu and then tap on Show All

Layers or Hide All Layers from the provided drop-down menu.
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All layers will be made visible or hidden within the currently open drawing depending on the chosen option.

The "eye" icon serves as a visual indicator and will appear differently after a selection has been made as shown

in the screenshots below.



Page 932

TouchDraw 2 for iOS



Page 933

TouchDraw 2 for iOS

5.2.15.9. Locking Layers

The Lock option is an "On/Off" toggle button for locking or unlocking a layer. It is located to the right of the

visibility icon and indicates whether or not a layer is locked.

To lock (or unlock) a layer, simply Tap on the lock icon of the layer to be toggled. A closed lock icon indicates

that the layer is locked and an open lock icon indicates a layer is unlocked.

The Layers Settings Menu provides additional options for locking or unlocking all layers residing within a

drawing.

To access these options, click on the Layer Settings Menu in the Layers Menu and then choose Lock All
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Layers  or Unlock All Layers  from the provided drop-down menu.

All layers will be locked or unlocked within the currently open drawing depending on the chosen option. The

"lock" icon serves as a visual indicator and will appear differently after a selection has been made as shown in

the screenshots below.
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5.2.15.10. Moving Figures to Layers

TouchDraw 2 provides a simple method for moving a selected figure(s) from one layer to another. The Move

To Layer option in the Contextual Menu may be used to complete this action.

Follow the steps below to move a figure to a different layer within a drawing:

Step 1:Select the figure(s) to be moved. In the shown example, all three figures are currently part of the first

layer (Layer 1). The circle is being moved to Layer 2.

Step 2: Press and hold on the Drawing Canvas for ~1 second to bring up the Contextual Menu. Then tap on
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the Move To Layer Submenu .

Step 3: Tap on the Layer where the selected figure(s) should be moved.

Step 4: The circle is now part of Layer 2.
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5.2.16. Handling Stencil Libraries

Libraries are used to add and manage stencils stored within the application and for adding these objects to a

drawing.

They are managed and controlled through the Stencil Menu, which is accessed by performing a press on the

StencilLibraries Button located in the Top Toolbar of the Drawing Editor.

The Stencils Menu appears as shown below.

For more information, please use the links provided below:

• Adding a Stencil Library

• Renaming a Stencil Library
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• Deleting a Stencil Library

• Importing a Stencil Library

• Exporting a Stencil Library

• Adding a Stencil

• Renaming a Stencil

• Deleting a Stencil

• Inserting a Stencil into a Drawing

• Re-installing Default Libraries
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5.2.16.1. Adding a Stencil Library

A Stencil Library is added by pressing on the Stencil Libraries Settings Menu located at the top right of the

Stencils Menu.

Then press on the New Library option within the drop-down menu:

An Untitled Library is added to the bottom of the Library Selection Menu and will be selected automatically
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within the menu.

To view the new library in the menu, you will need to scroll through the menu view by touching and dragging

in an upward direction.
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Note: Refer to the Renaming a Library section of the documentation to learn how to change the name of an

Untitled Library.
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5.2.16.2. Renaming a Stencil Library

To Rename a Stencil Library, you will first need to make certain the library has been selected within the

Stencils Menu. Then complete the following steps:

Step 1: Press on the StencilLibraries Settings Menu located at the top right of the Stencils Menu.

Step 2: Tap on the Rename Library option to rename the selected library.
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Step 3: A keyboard appears on the screen of the device and a cursor is inserted into the name of the library as

indicators of entering text editing mode.
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Note: A Library Name can have parenthesis in it.

Step 4: Use the keyboard to enter any desired name. Press on the Rename Button in the keyboard to complete

the name change.

Note: If the entered name is already taken, TouchDraw 2 will provide visual feedback by changing the text to

red indicating that the entered text is an invalid library name.

Step 5: The Stencils Menu will appear as shown below once the name change has been completed.
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5.2.16.3. Deleting a Stencil Library

To Delete a Stencil Library, complete the following steps:

Step 1: Select the library with the Library Selection Menu.

Step 2: Press on the Libraries Settings Menu located at the top right of the Stencils Menu.

Step 3: Tap on the Delete Library option.
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Step 4: Press on Delete to confirm the deletion.

The library is removed from the Library Selection Menu, as shown below.
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5.2.16.4. Importing a Stencil Library

Libraries are stored in "*.t2l" files in the Documents Directory of TouchDraw 2. A Library File (.t2l) may

be imported to TouchDraw 2 from an Email and applications such as Dropbox or Box.

Please refer to the links below to learn more about these import options.

• Importing Stencil Libraries by Email

• Importing Stencil Libraries from Applications

5.2.16.4.1. Importing Stencil Libraries via Email

A Library File (.t2l) can be imported into TouchDraw 2 by email. Follow the steps below to import a library

file from an email:

Step 1: Open the email containing the .t2l file.

Step 2: Tap on the file attachment to view additional options.

Note: Imported libraries must be have a ".t2l" file extension to be valid. An error message will appear if the

selected file does not match the required format in TouchDraw.

Step 3: Select Open (Send) to TouchDraw from the supplied options.
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Step 4: Touch and drag to the left to access additional options in the pop-up window. Tap on the More

Options (...) Button.
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Step 5: Select the Copy to TouchDraw 2 option.

Step 5: Tap on the Import Button in the confirmation message to continue with the import.
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Note: If a library with the same name already exists, the following message will appear. Tap on the New Name

Button to enter a new name for the library file or the Overwrite Button to overwrite the existing file.

Step 6: You will receive the confirmation message shown below if the import was a success. Tap on the

Dismiss Button to close the confirmation window.

Step 7: To view the imported library, press on the Library Button and locate its name in the list of

TouchDraw 2 libraries.

Scroll through the window view by touching and dragging in an upward (or downward) direction to locate the

desired library when it is not currently visible in the Libraries Menu. In this example, My Library was

imported into TouchDraw 2.
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5.2.16.4.2. Importing Stencil Libraries from Applications

To import a stencil library, complete the following steps:

Step 1: Press on the StencilLibraries Settings Menu located at the top right of the Stencils Menu.

Step 2: Tap on the Import Library menu option.
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Step 3:  A pop-up window will appear for browsing to the library file location and selecting it for import. Press

on Locations to select a configured storage storage location (Dropbox, Box, Gmail, etc.).

Step 4: Tap on a Storage Location to view its folders and files.
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Step 5: Tap on a folder to select it and view stored files.

Step 6:  Then tap on the library file to import it into TouchDraw 2.

Note: If a library with the same name already exists, the following message will appear. Tap New Name to

enter a new name for the library file or Overwrite to overwrite the existing file.
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Step 7: If the library was imported successfully, the following message will be provided. Tap Dismiss to close

the message.
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5.2.16.5. Exporting a Stencil Library

Libraries are stored in "*.t2l" files in the Documents Directory of TouchDraw 2. A Library File (.t2l) may

be exported from TouchDraw 2 via an Email or to applications such as Dropbox or Box. To export a library,

complete the following steps:

Step 1: Select the library within the Library Selection Menu.

Step 2: Press on the Stencil Libraries Settings Menu located at the top right of the Stencils Menu.
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Step 3: Tap on the Export Library menu option.

Step 4: Tap on an export option (Dropbox, Box, Airdrop, Gmail, Mail, Google Drive, etc.) to select it. Please

note that the steps will vary depending on the selected option.
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5.2.16.6. Adding a Stencil to a Library

When adding stencils to a library, they may be added individually or as a group. A stencil must be added to a

library in order to be saved in TouchDraw 2 and available for future use within drawings.

Adding an Individual Stencil

To Add an Individual Figure into a library as a stencil, complete the following steps:

Step 1: Draw the figure within the Drawing Canvas and select it, as shown below.

Step 2: Next, press on the Stencil Libraries Button in the Top Toolbar.

Step 3: Press on the Library Selection Menu to select the library the stencil will be added to. Perform a

Touch/Drag gesture combination in an upward or downward direction within the menu. Press on the library

name within the menu to select it.
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Step 4: Press on the Stencil Libraries Settings Menu to access the options for adding stencils to a library in

TouchDraw 2.
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Step 5: Next, press on the Add Selection To Library Individually option within the menu.

Step 6: The figure will appear as a stencil within the selected library in the Stencils Menu.
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Adding a Group as a Stencil

To Add a Group of Figures into a library as a stencil, complete the following steps:

Step 1: The group of figures must first be drawn within the Drawing Canvas and selected, as shown below.

Step 2: Next, press on the StencilLibraries Button in the Top Toolbar.
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Step 3: Press on the Library Selection Menu to select the library the stencil will be added to. Perform a

Touch/Drag gesture combination in an upward or downward direction within the menu. Press on the library

name within the menu to select it.

Step 4: Press on the Stencil Libraries Settings Menu to access the options for adding stencils to a library in
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TouchDraw 2.

Step 6: Next, press on the Add Selection To Library As Group option within the menu.

Step 7: The group of selected figures will appear as a single stencil within the selected library in the Stencils

Menu.
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Note: To learn how to change the name of an added stencil, refer to the Renaming a Stencil section of the

documentation.
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5.2.16.7. Renaming a Stencil

To Rename a Stencil, complete the following steps:

Step 1: Press on the StencilLibraries Button in the Top Toolbar.

Step 2: Press on the Library Selection Menu to select the library the stencil belongs to. Perform a Touch/Drag

gesture combination in an upward or downward direction within the menu. Press on the library name within

the menu to select it.
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Step 4: Tap on the desired stencil to select it.

Step 5: Press on the Stencil Libraries Settings Menu to access the options for adding stencils to a library in

TouchDraw 2.
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Step 6: Tap the Rename Stencil option within the drop-down menu.

Step 7: Type in a name for the selected stencil and then press on the RenameButton. Any desired name can be

entered for a stencil.
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Step 8: The renamed stencil will appear as shown below.
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5.2.16.8. Deleting a Stencil from a Library

To Delete a Stencil, complete the following steps:

Step 1: Use the Library Selection Menu to select the library where the stencil is saved.

Step 2: Tap on the stencil to select it within the library.
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Step 3: Press on the StencilLibraries Settings Menu located at the top right of the Stencils Menu.

Step 4: Tap on the Delete Stencil option within the menu.

Step 5: A confirmation prompt will appear. Press on the Delete Button to delete the stencil or press on the
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Cancel Button  to exit the prompt without completing this action.

Step 6: The library will appear as shown below once the stencil has been removed.
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5.2.16.9. Inserting a Stencil into a Drawing

To insert a stencil into a drawing:

Step 1: Select the appropriate library in the Library Selection Menu.

Step 2: A stencil may be inserted using one of three gesture combinations:

Press and Hold on the stencil and then Drag it to any desired location in the Drawing Canvas.
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Double Tap on the stencil and then perform a Touch/Drag gesture combination on the Drawing Canvas.

Triple tapping on a stencil to close the stencil popover and insert multiple stencils until another Drawing Tool

is selected to exit stencil insertion mode.

Note: If a stencil is inserted with the function key pressed, the stencil will be inserted at 0,0.

Step 3: The stencil will appear within the Drawing Canvas once the desired gesture combination has been

completed, as shown below:
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5.2.16.10. Re-installing Default Libraries

The Reinstall Default Libraries menu option re-installs the default/bundled stencil libraries. To re-install

default libraries, complete the following steps:

Step 1: Press on the Stencil Libraries Button in the Top Toolbar.

Step 2: Expand the Libraries Settings Menu.

Step 3: Press the Reinstall Default Libraries menu option.
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Step 4: Press Confirm.
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Step 5: Press Dismiss to close.
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5.2.16.11. Exporting All Stencil Libraries

A backup file containing all Stencil Libraries in TouchDraw 2 can be created by using the Export All

Libraries... option within StencilLibraries Settings Menu.  Library files are saved as .t2l files and can be

used within another application or to be imported for a later drawing.

Follow the steps below to Export All Libraries:

Step 1: Press on the StencilLibraries Button located in the Top Toolbar of the Drawing Editor.

Step 2: Press on the Stencil Library Settings Menu.

Step 3: Select the Export All Libraries... option.
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Step 4: Wait patiently for the backup file to be created.
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Step 5: Use the pop-up window to choose where the backup file will be saved. The backup file of all your

TouchDraw 2 Stencil Libraries can be:

• Exported to iCloud or 3rd party applications (Dropbox, Box, Drive, etc.)

• Saved to files on the iOS device

• Sent via email through Gmail or another service

Swipe left or right on the icons to view and access more options. You can also tap on an option below the icons

to finish the export.
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How to Export all Libraries to iCloud Drive

To export all your TouchDraw 2 for iOS libraries to iCloud, complete the steps outlined below:

Step 1: Press on Save to Files within the menu options.

Step 2: Next, tap on iCloud Drive to select it within the window. You may also select a specific folder on your

iCloud Drive for saving.
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In the example below, a folder titled "Libraries" has been selected within iCloud Drive.

Step 3: After selecting the save location for your library export, tap Save in the upper right corner.
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5.2.17. Calculations

TouchDraw 2 provides an easy method for calculating the Area and Dimensions of a selected figure(s) by

entering variables within the Text Editor popover window.

Note: Refer to the Available Variables table to find out more about what can be obtained as part of the text of a

figure.
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5.2.17.1. Calculating Area

TouchDraw 2 supplies the ability to enter variables into the Text Editor for a figure(s). The calculated area of a

figure can be obtained and included within the figure's text by completing the following steps:

Step 1: Double Tap on a figure to open the Text Editor.

Step 2: Enter {Area} as part of the text within the Text Editor. The value will appear within the selected

figure in real time, as shown below:

Step 3: The figure will appear as shown below after the Text Editor has been closed.
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Note: The first letter of an entered variable must be capitalized for the value to appear in the selected figure.
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5.2.17.2. Dimensioning

TouchDraw 2 provides variables for determining the dimensions of a selected figure(s) The MinX, MaxX,

MinY, MaxY, Length, Width, and Height can be entered as part of the displayed text within a figure.

Refer to the available variables table to learn more about what variables can be inserted. These values can be

applied to show the dimensions of a drawn object, as shown below:

Follow the steps below to create the images shown above:

Step 1: Select the Rectangle Tool and draw a rectangle.

Step 2: Select the Rectangle Tool again and draw a square on top of the right half of the rectangle. Use the

Function Key Feature to select both figures.
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Step 3: Press on the Modify Menu in the Top Toolbar.

Step 4: Tap on the Add Shapes option in the Modify Menu to combine the two shapes. When in Landscape

Mode, scroll through the menu view by touching and dragging in an upward direction to view this menu option.

Step 5: The previously blue boundary handles will turn orange to indicate that the two shapes have been

combined, as shown below.
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Step 6: Select the Line Tool and create a line with two black arrow end points along the bottom of the

rectangle.

Step 7: Double Tap on the Line figure to open the Text Editor. (replace)
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Step 8: Enter the variable {DLength} into the Text Editor and the value will be updated on the line in real

time.

Note: The D and first letter of the entered variable must be capitalized for the value to appear in the selected

figure.

Step 9: Follow steps 6 through 8 to create a dimension line for each side of the drawing. The figure below

shows the completed dimensions for the drawn shape.



Page 992

TouchDraw 2 for iOS

Note: Please note that the shown {DLength} dimension addition and a similar style may also be

accomplished by using the Style As Dimension Line option in the Contextual Menu.
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6. Tips and Techniques
This section provides information on how to perform specific actions within TouchDraw 2 and can be used to

master the basic features of the application. Listed below are links to several quick tips designed to help you

become more familiar with TouchDraw 2.
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6.1. Resizing a Figure Proportionally
with Handles
TouchDraw 2 provides several features for resizing shapes when you are working with figures in a drawing. If

a bounds handle is dragged to a location within the Drawing Canvas without using application features for

constraining proportions, the shape is resized to that specific location.

The Function Key Feature allows you to constrain proportions as you drag to ensure the original shape is

maintained. For example, a simple drag of the bounds handle without this feature enabled can result in a perfect

square becoming a rectangle or a circle becoming an oval, but by using this feature, the shape will remain as a

square or circle and only change in size, not proportions.

The example below shows what the puzzle piece from the Stencil Library would look like if the bottom right

bounds handle is moved upward without enabling the Function Key Feature.



Page 995

TouchDraw 2 for iOS

This tutorial will show you how to use the Function Key Feature to select a figure and alter its size while

constraining proportions to maintain its original shape. We will be using the Puzzle Piece (as in the above

example) from the Stencil Library to demonstrate how this feature can be used to easily constrain proportions

when resizing shapes in a drawing.

To locate this stencil, press on the Stencil Libraries Button to open the Stencils Menu. Use the Library

Selection Menu to select the Shapes stencil library. You will see the puzzle piece as an available selection. It

will appear as shown below once it has been inserted into a drawing.
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Proportions are not constrained for a resized shape when the Function Key Feature is disabled. When this

feature is enabled, TouchDraw 2 makes certain that the proportions are constrained during shape resizing to

maintain the original shape.

For example, the puzzle piece will remain as a puzzle piece as a bounds handle is dragged and only change in

size. This feature can be used for any of a shapes bounds handles. Follow the steps below to learn how to use

the Function Key Feature to constrain proportions while resizing a shape.

Step 1: Select the shape in your drawing by tapping on the figure. Bounds handles will appear around the

chosen figure once it has been selected.
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Step 2: Next, you will need to enable the Function Key Feature to constrain proportions during shape resizing.

To enable this functionality, hold and press on the lower half of the Drawing Toolbar where no tools are

present.

After approximately 1 second, the toolbar will turn red as an indication of the Function Key Feature being

enabled. It will remain enabled as long as the utilized finger/thumb remains held on the toolbar.
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Note: The Function Button feature can also be enabled and used to lock the Function Key Feature during a

resize operation.

Step 3: Touch and Drag on a bounds handle to begin resizing the shape. In this example, the bottom right

bounds handle is selected and drug inward toward the shape.

Step 4: The puzzle piece becomes smaller in size, but retains its shape as its proportions are constrained.
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Step 5: Remove your finger from the empty portion of the Drawing Toolbar once resizing is completed to

disable the Function Key Feature.
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6.2. Creating Proportional Shapes
TouchDraw 2 offers a great amount of flexibility when creating shapes or figures in a drawing. A touch and

drag action in combination with a selected drawing tool results in the addition of rectangles, squares, circles,

ovals, and additional shapes of any size and/or proportion to a drawing.

The Function Key Feature can be used when adding a shape such as a circle or square to your drawing to make

certain it retains its proportions and only changes in size. This prevents the shape from becoming a rectangle or

oval.

For example, if you select the Rectangle Tool and insert the shape into your drawing, it can either be a square

or rectangle depending on where you touch and drag on the Drawing Canvas. Dragging toward the bottom right

results in a rectangle with non-proportional Width and Height measurements, as shown below.
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By enabling the Function Key Feature, you can create a proportional shape. In the example above, a perfect

square would be created when this feature is enabled and the same touch/drag action is performed.

As shown in the Geometry Tab, the Width and Height of the square are proportionally the same.

TouchDraw 2 constrains the Width and Height to generate a proportional shape when the Function Key

Feature is enabled. This tutorial will show you how this feature can be used to create a proportional shape.

We will be using the Rectangle Tool for this demonstration. Follow the steps below to learn how to use the

Function Key Feature to create a proportional shape in your drawing.

Step 1: Select the Rectangle Tool in the Drawing Toolbar.
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Step 2: Next, you will need to enable the Function Key Feature. To enable this functionality, hold and press on

the lower half of the Drawing Toolbar where no tools are present. After approximately 1 second, the toolbar

will turn red as an indication of the Function Key Feature being enabled. It will remain enabled as long as the

utilized finger/thumb remains held on the toolbar.
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Step 3: Touch in a desired location on the Drawing Canvas and then Drag downward or in another direction

without lifting the utilized finger.

Step 4: Release your finger once the shape is completed to disable this feature. You will have a perfectly

shaped square when finished.
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Step 5: To view the Width and Height of your shape, press on the Info Button in the Top Toolbar to open the

Geometry Tab.
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6.3. Using the Selection Rectangle
The Selection Rectangle provides an easy method for selecting multiple figures within a drawing. Touch and

drag from left to right or right to left on any point in the Drawing Canvas and then lift your finger once the

Selection Rectangle resides over the desired area. Figure selection will vary depending on the direction used

for dragging your finger.

If you drag the Selection Rectangle from left to right, it will select all figures within its bounds as well as any

figures it intersects.

While this approach is a great choice for making a quick selection in a defined area, it does not offer the

amount of control that is sometimes needed during figure selection. You can drag the Selection Rectangle

from right to left to select figures residing in its bounds without selecting intersecting figures. This provides

finer control for using the Selection Rectangle to select multiple figures in a specified area of the Drawing

Canvas.
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Note: For more information about selecting figures within a drawing, please refer to the Selecting a Figure

page of the documentation.
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6.4. How to Resize an Image to Scale
The linear, horizontal distance, and vertical distance dimension tools can be used to add a dimension line to a

floor plan or other image and scale that image based on an entered value. Once scaled, the opacity can be

changed to perform tracing on the floor plan image.

The step-by-step example is shown below:

Step 1: Insert the Floor Plan Image into the Drawing

To insert the floor plan image into your drawing, press on the File Menu. Then press to select one of the

provided Insert options.

The floor plan image has been inserted into the drawing and is shown below:
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Note: For step-by-step instructions, please see: Inserting Images into Drawings

Step 2: Draw a Dimension Line

Next, draw a dimension line within the drawing. For this example, the Linear Dimension Tool will be used.

Tap within the Drawing Toolbar to select the Linear Dimension Tool
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Next, draw a dimension line below the floor plan image.
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Step 3: Disable the "Snap to Grid" Option

This option will need to be disbled so that the connection points for the dimension line can be dragged to a

desired location within the floor plan image.

To disable, press on the View Menu and then press on the Snapping Submenu.
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Next tap on the Snap to Grid toggle slider to disable the option.

Step 4: Drag the Connection Points to a Specific Location within the Floor Plan
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After the Snap to Grid option has been disabled, you will be able to drag each connection point on the

dimension line to a desired location within the floor plan.

For the first connection point, enable the Function Key Feature and perform a touch and drag action to move

it to a desired location on the floor plan.

For the second connnection point, enable the Function Key Feature and perform a touch and drag action to

move it to a desired location on the floor plan.
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Tip: You can zoom in on a specific location within the floor plan to be more precise when changing the

dimension line connection point locations.
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Step 5: Use the Scale Attached Option

The Scale Attached option can be used to scale the drawing based on an entered scale value (e.g., 10 ft).

Press on the Modify Menu and then press on the Scale Attached... option.
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Next, enter a new Length value. For this example, "16 ft" will be entered.

The image will scale based on the entered length value.
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Step 6: Change the Dimension Line Font Size

Select the Dimension Line and then touch and drag on the bounds handle to drag the handle downward.
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Increase the font size so that the dimension information is viewable for the location the dimension line

represents.
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After the font size has been changed, the dimension information will be more visible, as shown below:

Step 7: Change the Opacity for Tracing

Select the image and then press on Info Button within the Top Toolbar.

Next, press on the Shadow and Opacity Tab.
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Touch and drag on the opacity slider or use the + and - buttons to make changes to the opacity value.

The image will appear as shown below:
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Completed Example

The floor plan can optionally be lined up to specific points on the gridline, as shwown in the image below:

Once finished, zoom out to see the entire floor plan and perform any needed tracing activities.
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7. Miscellaneous
TouchDraw 2 supports specific file formats for importing or exporting. The following documentation sections

supply information regarding:
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7.1. File Format Support
Images or drawings from outside applications can be imported for editing within TouchDraw 2. A created

drawing in TouchDraw 2 can also be exported into an alternative file format.

See the Importers and Exporters tables for additional information about supported file formats. Known issues

during exporting or importing of specific formats are noted in the the following documentation pages.
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7.1.1. Importers

Importer Type Supported Import Methods

Image Importer TouchDraw 2 supports inserting or pasting bitmap images into a drawing.

SVG (Scalable Vector

Graphics)

TouchDraw 2 supports converting SVG files into a drawing.

VSD, VSDX, VDX (Visio

Drawings)

TouchDraw 2 supports converting Visio files into a drawing.

EMF (Enhanced Metafile) TouchDraw 2 supports converting EMF files into a drawing.

WMF (Windows Metafile) TouchDraw 2 supports converting WMF files into a drawing.

iDraw (Graphic Drawings) TouchDraw 2 supports converting iDraw files into a drawing.
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7.1.1.1. Image Importer Notes

TouchDraw 2 for iPad supports importing the following bitmap image formats.

• PNG

• JPEG

• GIF

• BMP

• TIFF

• HEIF

Limitations

• None Known

Known Issues

• None Known
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7.1.1.2. SVG Importer Notes

TouchDraw 2 supports importing Scalable Vector Graphics (SVG) files. This page documents the known

issues and limitations of the importer.

Limitations

Not every SVG feature is supported by the importer. When an SVG feature has no equal within TouchDraw 2,

the original SVG command is ignored. As SVG is large and complex specification, the following is a

non-exhaustive list of limitations we are aware of:

• Elliptical gradients cannot be imported.

• Clipping regions are not imported.

Known Issues

• None Known
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7.1.1.3. VDX Importer Notes

TouchDraw 2 supports converting Microsoft Visio in the VSD, VSDX and VDX formats. This page documents

the known issues and limitations of the importer. Limitations 

Not every Visio feature is supported by the importer as TouchDraw 2 does not have every feature that Visio

does, nor does Visio have every feature TouchDraw 2 does. When a feature has no equal within TouchDraw 2,

the original command and/or data is ignored. As the Visio file format is very extensive, the following is a

non-exhaustive list of limitations we are aware of: 

• Only visual information (the look/layout of the drawing) is imported. Any semantic information
(associated metadata) stored in the Visio file will be lost.

Known Issues 

• None Known
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7.1.1.4. EMF Importer Notes

TouchDraw 2 supports converting Enhanced Metafile (EMF) files mainly for the purpose of importing

embedded stencil file in Visio documents. This page documents the known issues and limitations of the

importer. 

Limitations 

• None known 

Known Issues 

• None Known
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7.1.1.5. WMF Importer Notes

TouchDraw 2 supports importing Windows Metafile (WMF) files mainly for the purpose of importing

embedded stencil file in Visio documents. This page documents the known issues and limitations of the

importer. 

Limitations 

• None known

Known Issues 

• None Known
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7.1.1.6. iDraw Importer Notes

TouchDraw 2 supports converting drawings created with Graphic (iDraw) files. 

Limitations  

• None known 

Known Issues 

• None Known
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7.1.2. Exporters

File Formats Options

Image Exporter TouchDraw 2 supports the exporting of a drawing in the form of a bitmap image

(PNG/JPEG). Refer to the Image Exporter Notes section of the documentation to learn

more about this exporting option.

Scalable Vector

Graphics (SVG)

TouchDraw 2 supports the exporting of a drawing as a Scalable Vector Graphics

(SVG). No additional options are associated with this choice. Refer to the SVG

Exporter Notes section of the documentation to learn more about this exporting option.

Portable

Document Format

(PDF)

TouchDraw 2 supports the exporting of a drawing as a Portable Document Format

(PDF). Refer to the PDF Exporter Notes section of the documentation to learn more

about this exporting option.

Microsoft Visio

(VSDX, VDX)

TouchDraw 2 supports exporting a drawing as a Microsoft Visio (VSDX, VDX) file.

No additional options are associated with this choice. Refer to the Visio Exporter

Notes section of the documentation to learn more about this exporting option.

Note Refer to the Exporting Submenu section of the documentation to learn more about exporting a drawing

from TouchDraw 2.
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7.1.2.1. Image Exporter Notes

TouchDraw 2 supports exporting drawings in the following bitmap image formats: 

• PNG

• JPEG

• GIF

• BMP

• TIFF

Limitations 

• None Known

Known Issues 

• None Known
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7.1.2.2. SVG Exporter Notes

TouchDraw 2 supports exporting drawing files to the Scalable Vector Graphics (SVG) file format. The

following page outlines the known issues and limitations of the exporter. 

Limitations 

• Only the visual information will be exported as SVG does not support some TouchDraw 2 features such
as connections.

Known Issues 

• None known

Notes 

• Many SVG viewers and/or editors do not support all of the features of SVG that TouchDraw 2 may
possibly use to export your drawing. Specifically, many SVG views do not correctly render shadows. The
Elevenworks team recommends using the Google Chrome web browser to view and validate that your
drawing was exported as expected. In our testing, Chrome has been found to have the most full feature
(freely available) SVG rendering support.
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7.1.2.3. PDF Exporter Notes

TouchDraw 2 supports exporting drawing files to the Portable Document Format (PDF) file format. The

following page outlines the known issues and limitations of the exporter. 

Limitations 

• None known

Known Issues 

• None known
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7.1.2.4. VDX Exporter Notes

TouchDraw 2 supports exporting drawing files to Microsoft Visio VSDX and VDX file formats. The following

page outlines the known issues and limitations of the exporter. 

Limitations 

• Font, font color and font size are the only font (text) attributes currently exported.

• Exporting of the drawing background color is not supported.

Known Issues 

• None
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7.2. Handles Reference
TouchDraw 2 uses the color and decoration to differentiate the different functions of the handles so that you

can quickly identify what they do. The following is a table of the different handles and their function.

Image Handle Description

Bounds Handle The Bounds Handle is used to change the width and height of

a shape.

Group Bounds

Handle

The Group Bounds Handle is used to change the width and

height of a group. The center dot in the handle is provided to let

you know you have selected a group of figures, as opposed to a

single figure.

Path Start Handle The Path Start Handle indicates which point or a path is the

starting point.

Path End Point

Handle

The Path End Point Handle indicates which point is an end

(or start, depending on how you look at it) point of a line or

curve segment within a path.

Path Control Point

Handle

The Path Control Point Handle indicates which points of a

path are control points.

Phantom Path

Control Handle

The Phantom Path Control Handle is a control handle

displayed in gray to indicate that it has not been used. This

characteristic provides a hint to the TouchDraw 2 application

that the handle should function as a control handle in scenarios

where the next drawn segment is a curve.

Rotation Handle The Rotation Handle is displayed on shapes (or groups) which

can be rotated around their center point. You can use the

"function key feature" in conjunction with the rotation handle

to rotate figures in increments of 15 degrees.

Center of Rotation

Handle

The Center of Rotation Handle indicates where the current

center of rotation point lies in a selected shape(s) or group of

shapes.
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Image Handle Description

Lock Handle The Lock Handle indications that the selected figure (or group)

is currently locked, which means it cannot be resized or moved.

Connection Handle The Connection Handle indications that the selected line can

be used to connect to figures.

Gradient Location

Handle

The Gradient Location Handle indicates the current center

location of a gradient fill within a figure(s) or group of figures.
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7.3. Zooming
TouchDraw 2 uses the standard iOS gestures to zoom a drawing. Refer to the following table to learn more

about available zoom gestures:

Icon Action Description

Zoom In To zoom in on an area (make it larger), first make sure the

Selection Tool is active. Place two fingers on the drawing

canvas and slowly spread them apart. The drawing will zoom in

on the area between the two fingers as they are spread.

Zoom Out To zoom out of a drawing (make it smaller), place two fingers

on the drawing canvas (as above); however, in this case the two

fingers are pinched by slowly bringing them together. The

drawing will zoom out based on how far the two fingers come

together as the pinching action occurs.

Zoom To Fit If the Selection Tool is active and a triple tap is performed

anywhere in the drawing canvas, the drawing will be zoomed to

fit into the drawing view.

Zoom To Fit

Contents

If the Selection Tool is active and a quadruple tap is performed

anywhere in the drawing canvas, the zoom level will zoom in

and fit the drawing figures so that they are shown within the

drawing window.

Zoom To Origin If the Selection Tool is active and five taps are performed

anywhere in the drawing canvas, the zoom level will be reset to

100% and the origin of the drawing will be re-positioned so that

0,0 is in the upper left hand corner.

Panning If the Selection Tool is active, place two fingers on the drawing

canvas and them drag them around to pan around a drawing.

Note: The panning and zooming gestures can be combined into one fluid gesture to quickly zoom and move to

the target portion of a drawing.
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